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Preface
FreeStyle Shaper is a powerful modeling tool used to dynamically design all types of surface elements, from the stylist's 
drawing to the final surface, ready for the manufacturing processes. 

Using this product you can generate free form 3D curves and surfaces from scratch, and dynamically deform and analyze all 
produced elements.

Using the FreeStyle Optimizer you can create and modify curve and surface shapes based on other elements such as digitized 
data.

Using FreeStyle Profiler, you can directly create complex surfaces based on profiles and sets of curves in one step, without 
having to deform them in a second step.

The FreeStyle Shaper, Optimizer & Profiler User's Guide has been designed as an aid to using the FreeStyle Shaper, FreeStyle 
Optimizer, and FreeStyle Profiler by themselves, but also in conjunction with other CATIA Version 5 workbenches.

Using This Guide
More Information
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Using This Guide
This User's Guide is intended for the user who need to become quickly efficient with the FreeStyle Shaper, 
FreeStyle Optimizer, and FreeStyle Profiler. 
Before reading it, you should be familiar with the basic CATIA Version 5 concepts, such as the document 
windows, standard toolbars and menus.

To make the most out of this book, we suggest that a beginning user reads the Getting Started chapter first of 
all and the Workbench Description to find his way around the FreeStyle Shaper workbench. 

User's familiar with the product should browse the Table of Contents rapidly, then move on directly to specific 
sections of interest to them: curve and surface creation, edition, and analysis. More advanced users, and those 
using the FreeStyle Optimizer will find an Advanced Tasks and Customizing chapters that should answer their 
needs. 
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Where to Find More Information
Prior to reading this book, we recommend that you read the Infrastructure User's Guide that describes generic 
capabilities common to all products. It also describes the general layout, and interoperability between 
workbenches.

Also read the CATIA V4 Integration User's Guide that presents interfaces with standard exchange formats and 
most of all with CATIA V4 data.

See also the Conventions.
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What's New?

New Functionalities

Managing Ordered Geometrical Sets
Optimal CATIA PLM Usability for FreeStyle

Enhanced Functionalities

Creating and Managing Curves

Creating Associative 3D Curves
New Automatic order option when creating a Near Points 3D curve
New smoothing options when creating a Near Points 3D curve
You can now impose a curvature constraint when creating a Near Points 3D curve

Creating Blend Curves
Tensions are now homogenized between blend surfaces and blend curves

Extending Curves
Multi-selection of curves is now possible
New options are available from the contextual menu: Slave and Free

Trimming Curves
The Tools Palette is now available to help you select elements in the 3D geometry
New Break type: curves by points
Curves by curves Break type: the Break Report panel enables you to manage the information on the 
cutting elements
Curves by curves Break type: you can now cut the cutting elements in the curves by curves Break type
Curves by curves Break type: new contextual menu to choose which parts of the curves to keep or not

Creating and Managing Surfaces

Creating Blend Surfaces
Tensions are now homogenized between blend surfaces and blend curves

Redefining Surfaces Limits
The Tools Palette is now available to help you select elements in the 3D geometry
The Break Report panel enables you to manage the information on the cutting elements
New contextual menu to choose which parts of the curves to keep or not

Analyzing Curves and Surfaces

Analyzing Distances Between Two Sets of Elements
New Texture option to allow a check by color distribution

Checking Connections Between Surfaces
New Light option to detect discontinuities 

Generic Tools
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Setting FreeStyle Visualization Options
A new contextual option is available to keep all patches limits
The Insert in a new geometrical set is available from the FreeStyle Dashboard

Advanced Tasks

Globally Deforming Surfaces
The Keep option is now available from the FreeStyle Dashboard

What's New?

New Functionalities

Managing Ordered Geometrical Sets
Optimal CATIA PLM Usability for FreeStyle

Enhanced Functionalities

Creating and Managing Curves

Creating Associative 3D Curves
New Automatic order option when creating a Near Points 3D curve
New smoothing options when creating a Near Points 3D curve
You can now impose a curvature constraint when creating a Near Points 3D curve

Creating Blend Curves
Tensions are now homogenized between blend surfaces and blend curves

Extending Curves
Multi-selection of curves is now possible
New options are available from the contextual menu: Slave and Free

Trimming Curves
The Tools Palette is now available to help you select elements in the 3D geometry
New Break type: curves by points
Curves by curves Break type: the Break Report panel enables you to manage the information on the 
cutting elements
Curves by curves Break type: you can now cut the cutting elements in the curves by curves Break type
Curves by curves Break type: new contextual menu to choose which parts of the curves to keep or not

Creating and Managing Surfaces

Creating Blend Surfaces
Tensions are now homogenized between blend surfaces and blend curves

Redefining Surfaces Limits
The Tools Palette is now available to help you select elements in the 3D geometry
The Break Report panel enables you to manage the information on the cutting elements
New contextual menu to choose which parts of the curves to keep or not

Analyzing Curves and Surfaces

Analyzing Distances Between Two Sets of Elements
New Texture option to allow a check by color distribution

Generic Tools

8Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Getting Started
The following tutorial aims at giving you a feel of what you can do with FreeStyle Shaper & Optimizer. It 
provides a step-by-step scenario showing you how to use key capabilities.

The main tasks proposed in the chapter are:

Starting the FreeStyle Workbench
Creating a First Surface

Editing the Surface
Creating a Second Surface

Creating a Blend Between Surfaces
Applying a Global Deformation

 
All together, this scenario should take about 15 minutes to complete. 

The final surface element will look like this:
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Starting the FreeStyle Workbench
The first task will show you how to enter the FreeStyle Shaper workbench.
The only pre-requisite for this task is to have a current CATIA V5 session running.

1.  Choose FreeStyle from the Start -> Shape menu, or click the FreeStyle icon from the 

Welcome to CATIA V5 dialog box. The FreeStyle Shaper workbench is displayed and ready to use.

The workbench looks like this:
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If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the 
View -> Specifications Visible menu item or pressing F3.
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Creating a First Surface

The first task will show you how to create a single-patch planar surface in the current plane.

1.  Select the Planar patch icon  

2.  Right-click in the document and choose the Edit Orders item from the 

contextual menu.

You can now define the degree of the mono-patch surface along U and V 
from the Orders dialog box.
Set it to 5 for along U.

3.  Click Close when finished defining these parameters.

4.  Click anywhere in the workbench, and drag the mouse.

A surface outline appears as you drag the pointer, one of its corner located where you clicked in the 
document.
Two values are displayed on the outline, indicating the length and width of the patch.

Use the Ctrl-click capability if you want the middle of the patch to be centered on the axis origin, that is 
centered around the point you clicked.
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5.  When you have reached the adequate size, click again.

The corresponding surface has been created.
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Editing the Surface

This task will show you how to modify the surface you just created.

1.  Select the surface.

2.  Click the Control Points icon  

As soon as you clicked the icon, 
control points and mesh lines are 
displayed. They are used to manually 
pull on the surface so as to deform it.

Deformation can also be done using 
the Tuner dialog box displayed using 
the Edit contextual command on 
control points or mesh lines.

Depending on the settings, texts may be 
displayed on the surface, allowing to modify the 
U, V orders, or to set continuity constraints on 
the surface edges. 
For further details, refer to FreeStyle Settings.

The Control Points dialog box is also 
displayed:

Use it to define the type of operation 
to be performed on the control 
points. 

●     Support: defines the type of 
translation to be applied.

●     Law: defines the type of 
deformation that is to be applied 
when several control points have 
been selected.
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In P1 one mode you cannot choose the support (Translation in the plane is selected by default) and 
only two laws are available: 

a.  Move selected points identically
b.  Stretch selected points

3.  Right-click the compass and choose the 

Make YZ the Privileged plane.

The compass is oriented likewise: 

4.  Move the pointer onto one of the control 

points or mesh lines. 

Arrows automatically appear. They 

represent the directions in which you 

can perform a deformation.

5.  Move onto the center mesh line and pull 

the bottom arrow down.

The selected control points are moved 
according to the translation type and law 
defined in the Control Points dialog box.
By default all control points and mesh lines are selected. Click  a specific point to deform the surface at 
this point only, or select a set of points using the Ctrl-key or Shift- key while clicking (multi-selection 
capabilities). The same applies to mesh lines.

6.  Click OK in the Control Points dialog box 

to accept the modified shape of the 

surface.
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Creating a Second Surface

In this task you learn to blend two surfaces, that is create one surface connecting both initial surfaces, 
while specifying the continuity type.

1.  Click the 4 Points Patch icon  

 in the Surface Creation 

menu to create another 

surface.

2.  Successively click the four 

corner points of the first 

surface.

The second surface is created.

3.  Select the new surface, right-click to display the contextual menu, and choose the Properties 

menu item to display the Properties dialog box.

4.  From the Graphic tab, change this surface's color using the arrow in the Color chooser.
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5.  Click OK in this dialog box. 

The newly created surface is 

clearly identifiable.

6.  Move to the compass. When the pointer changes to a cross, press and hold while dragging the 

compass onto the new surface.

7.  Move the pointer over the 

horizontal axis till it becomes 

red, and glide the surface 

away from the first one.

Repeat this operation with 

gliding the surface down along 

the vertical axis, then grab the 

compass center and bring the 

compass over the 3-axis 

system at the bottom right-

corner of the document.

The compass is set back to its 

default position.
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Creating a Blend Between Surfaces

In this task you learn to blend two surfaces, that is create one surface connecting both initial surfaces, 
while specifying the continuity type.

1.  Click  the Freeform Blend 

Surface icon . 

The Blend Surface dialog box 

is displayed.

2.  Select the edge of the initial 

surface closest to the second 

surface. 

The boundary is highlighted.

3.  Select the edge of the 

second surface closest to the 

initial surface. 

A blend surface is 
automatically computed. 
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4.  Click OK in the Blend Surface 

dialog box to validate the 

blend surface.

End of the Getting Started in P1 mode.
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Applying a Global Deformation

This command is only available when using FreeStyle Optimizer.

Now that both surfaces are linked, you want to modify all three surfaces according to a modification 
pattern you define in space, keeping all defined curvature continuities.

1.  Press and hold the Ctrl-key, then successively select all three surfaces.

2.  Click the Global Deformation icon .

The 3D compass is displayed along with the Global 
Deformation dialog box into which you can specify 
deformation options: using an intermediate patch 
or an axis use.
In this case, use the default option: Intermediate 
surface use.

3.  Click Run in the Global Deformation dialog 

box to accept the deformation parameter 

definition. The Control Points dialog box 

displays.

A patch with control points and mesh lines is 
displayed. It represents the planar patch, defined in 
the plane indicated by the compass, equivalent to 
the same bounding box as the selected surfaces.
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4.  Use the control points and the mesh lines of 

the planar patch to deform it. The space 

transformation is defined between the initial 

patch and the deformed patch.

All surfaces are automatically and 
dynamically deformed according to this 
intermediate patch deformation.

5.  Do not change the options and click OK in 

the dialog box.

 

The final deformed surface looks like this.
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Basic Tasks
Opening a New CATPart Document

Importing and Exporting Files
Creating and Managing Curves

Creating and Managing Surfaces
Analyzing Curves and Surfaces

Generic Tools
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Opening a New CATPart Document
This task shows how to open a new CATPart document and activate the FreeStyle Shaper workbench.

1.  Select the File -> New commands (or click the New  icon).

The New dialog box is displayed, allowing you to choose the type of the document you need.

 

2.  Select Part in the List of Types field and click OK.

3.  Choose Shape -> FreeStyle from the Start menu.

The FreeStyle Shaper workbench is loaded and a CATPart document is opened.
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The FreeStyle Shaper workbench document is made of: 

●     the specification tree and the geometry area in the main window

●     specific toolbars (geometry creation and modification toolbars, analysis toolbar)

●     a number of contextual commands available in the specification tree and in the geometry. Remember that these commands 
can also be accessed from the menu bar.

The specification tree is a unique specification-driven and generative tool, which captures and reuses process specifications, 
ultimately accelerating the design process. It lets you concentrate the design effort on establishing the proper design 
specifications, while leaving it to the system to compute or update the resulting geometry when required. This specification tree 
can be customized using the Tools -> Options menu item, Tree tab.

●     If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the View -> 
Specifications menu item or pressing F3.

●     You could also directly choose FreeStyle from the Start menu. It would automatically open a new CATPart document.
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Importing and Exporting Files
CATIA Version 5 includes unique two-way interoperability with CATIA Version 4 data, thus allowing CATIA 
Version 5 to benefit from the breadth of the CATIA Solutions Version 4 portfolio.

CATIA Version 5 data can be loaded and processed in a CATIA Version 4 session. Similarly, CATIA Version 4 
data can be read in a CATIA Version 5 session and converted to a CATIA Version 5 format for further edition.

Refer to the CATIA V4 Integration User's Guide for further details on how CATIA Version 4 and Version 5 
interoperate.

3D data exchange and more specifically surfaces exchange between CATIA Version 5 and other CAD systems 
can be done through Initial Graphics Exchange Specification (IGES) format. 

These exchanges are documented in the Interfaces User's Guide (Importing and Exporting External Files), as 
they are not specific to the FreeStyle Shaper workbench, but rather to the .CATPart document type. 

Therefore, refer to this chapter for a description of the specific surface elements that can be imported from or 
exported to the IGES Standard.
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Creating and Managing Curves
This chapter deals with curve creation and management using the FreeStyle Shaper workbench.

 See also the FreeStyle Dashboard tools as they affect the curve creation and modification.

Create associative 3D curves: specify the curve creation mode (passing through specific points, specifying 
the curve degree and smoothing the curve through points, or defining the curve control points), and click 
in space to indicate the curve definition points.

Creating Associative 3D Curves on a Scan of Cloud: select one or several scans on clouds, specify the curve 
creation mode and click in space to indicate the curve definition points.

Create free form curves on surfaces: select a surface, specify the curve creation mode (interpolation or 
smoothing in relation to the selected points), click definition points on the surface, double-click to end the 
curve. 
Project curves: select a curve, the surface on which it is to be projected and specify projection 
parameters 
Create blend curves: select two curves, activate their options display and use the contextual menu on the 
displayed text to modify the continuities and tension, manipulate the control points to define the blending 
point.

Create a styling corner: select two curves, set the radius value.

Match curves: select two curves, activate their options display and use the contextual menu on the 
displayed text to modify the continuities and tension, manipulate the control points to define the matching 
point.

Edit curves using control points: select a curve, set the deformation options, pull on the control points in 
specific directions

Smooth curves: select a curve or points on a curve, set the smoothing weight and click Run.

Extrapolate curves: select a curve, specify the extrapolation mode, and enter the extension value.

Extend curves: select a curve, specify the extension mode, and enter the extension value.

Trim curves: select a curve, or point on a curve, and specify the breaking options

Concatenate curves: select a multi-cell curve and set the tolerance value

 Fragment curves: break a multi-arc curve into several mono-arc curves

Approximate/segment procedural curves: select a curve, specify the approximation tolerance, and 
resulting curve maximum orders and/or segments.
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Creating Associative 3D Curves 
This task explains how to create a 3D curve that is associative meaning you can add or delete points (whether control points 
or passing points) both at creation time or when editing.
These curves can be created in space or lie on a geometrical element, or both. When the curve lie on a geometrical element 
and the later is modified, the curve is updated automatically, provided you choose the Automatic update option in Tools -> 
Options -> Mechanical Design -> Assembly Design -> General tab.

  
 

●     Selecting 3D points

●     Editing

●     Keeping a point

●     Imposing a Tangency Constraint

●     Imposing a Curvature Constraint

●     Setting as Arc Limit

●     Removing a Point

●     Constraining a Point

  

Open a new .CATPart document.

1.  Click the 3D Curve icon .

The 3D curve dialog box is displayed.

2.  Choose the curve creation type.

Whatever the chosen type, the curve is previewed in 
dotted line as you move the pointer.

●     Through points: the resulting curve is a multi-arc curve 
passing through each selected point.
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●     Control points: the points you click are the control points 

of the resulting curve

●     Near points: the resulting curve is a single-arc, with a set 
degree and smoothed through the selected points.

 

You can edit the order by right-clicking the 
displayed text (displayed using the U, V Orders icon 

 from the FreeStyle Dashboard or the Order 

option from Tools -> Options menu, Shape -> 
FreeStyle -> General tab), and choosing a new 
order value.

The Automatic order option enables you to automatically 
compute an order that will respect at best all the curve 
constraints.
The computed value is displayed near the Auto tag.

   

●     The Deviation option enables the user to set the 
maximum deviation between the curve and the 
construction points.

The result is a set degree through the selected 
points.
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●     The Segmentation option enables the user to set the maximum number of arc limits. These arcs are construction points 
and are inserted into the curve automatically.
The minimum value is set to 1.

●     Smoothing options are now available to parameterize the 
curve:  

●     Chord Length (default parameterization)
Smoothing parameter = 0

●     Uniform
Smoothing parameter = 0

 
●     Smoothing parameter: enable a better control 

points distribution of the smoothed curve.  

 

 Smoothing parameter = 50 Smoothing parameter = 130

Deviation, Segmentation, and Smoothing options are only available for the Near Points creation type.

  

3.  Move the pointer over a point.

A manipulator is displayed allowing you to modify point location as you create the curve.
By default, this manipulator is on the last created point.

A contextual menu proposes several options to construct the 3D curve.
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Right-click on the manipulator to display the contextual menu. From then on you can choose the Edit item to display the 
Tuner dialog box and enter space coordinates for the selected point, or choose the Impose Tangency item to set a tangency 
constraint on the curve at this point. 

 
4.  Click the Insert a point icon  within the dialog 

box.

The curve freezes.

5.  Click the segment, between two existing points where 

you wish to add a new point and click the point 

location.

 

Once the point has been created, you are back to 
the edition capabilities on the curve.

6.  Click the Remove a point icon  within the dialog 

box, and select one of the existing points.

The curve is recomputed immediately without the 

selected point.

7.  Click the Free or constrain a point icon  within the dialog box, then select the point.

●     If the point is a point in space (free), move the pointer 

close to the point or a wire to which it should be linked. 

You can then move the pointer over a geometric element 

and: 

❍     move the point to the indicated point by clicking

❍     press and hold the Control  key (Ctrl) to project this 

point onto this element according to the shortest 

distance from the point initial location.
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●     If the point was lying on another point or a wire (curve, 

line, spline, and so forth), it is freed from its constraint 

onto this element, and can be moved to any new location 

in space.

You can snap a point onto a surface using the Free or constrain a point icon. The point will be lying onto the surface, but 
not constrained. It can be moved using the manipulators. 

8.  Click OK to create the curve.

A 3DCurve.xxx appears in the specification tree.

●     Use the F5 key to move the manipulators into a different plane of the compass. See Managing the Compass.

●     You cannot add a point past the end points. To do this, you need to add a point before the end point, move the new point 
where the end point lies, then move the end point to a new location.

●     The creation plane for each free point is defined according to the current plane/compass orientation on the previous point. 
Therefore you can change creation planes within the same curve, by setting a new current plane/compass orientation on 
several points.

●     Check the Disable geometry detection button, when you need to create a point close to a geometric element yet 
without constraining it onto the existing geometry.

●     Check the Hide previsualisation curve to hide the previsualisation curve you are creating.

   

Selecting 3D points

It is possible to select a scan of cloud either in the 
specification tree or directly in the geometry. 

The Select all points contextual menu is available within the 
3D curve action only, i.e. it is not available when you select 
the scan before entering the action but appears when the 3D 
Curve dialog box is open.

●     In the specification tree: 
❍     select the geometrical set just by clicking it, or

❍     right-click the geometrical set and choose Select all 
points in the geometrical set from the contextual 
menu, or

❍     select a point in the geometrical set, right-click it and 
choose Select all points in the geometrical set from the 
contextual menu.

●     In the geometry: select a point, right-click it and choose 
Select all points in the geometrical set from the contextual 
menu.
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Double-click your curve, right-click on the manipulator to 

display the contextual menu.

 

According to the creation type, the following options are available:

 Through Points Control Points Near points

Edit X X X

Keep this point X X X

Impose Tangency X  X 

Impose Curvature X  X

Set as Arc Limit   X

Remove this point X X X

Constrain this point X X X

Editing

1.  Right-click any of the manipulators, and choose the 

Edit contextual menu to display the Tuner dialog box. 

This option allows you to redefine the tangency 

position, and its vector's step.

 

      
 

The Relative check box enables you to redefine the tangency 
relative position, and its vector's step.
The Reset Origin button allows you to reset the origin of the 
relative position.

   
 

Contextual Options
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Keeping a point

1.  Right-click an existing point and choose the Keep this 

point menu item to create a point at this location. 

A Point.xxx appears in the specification tree.

You can create a Point.xxx either on each control point 

or on the selected control points. 

Imposing a Tangency Constraint
Automatic Constraint

●     When a curve is created in Through points or Near 
points mode, and its first point is constrained on any point 
of another curve, the new curve automatically is tangent to 
the curve on which its first point is constrained. As soon as 
the curve's second point is created, the imposed tangent is 
displayed on the new curve.
To deactivate the default option, uncheck the Impose 
Tangency contextual menu on the tangent vector. 

Tangency Constraint on Points

When creating a 3D curve, you may want to impose tangency constraints on specific points of the curve. Then if you move the 
point at which a tangency constraint has been set, the curve will be recomputed to retain this tangency constraint at the 
point's new location.
Depending on the creation mode, you can impose this constraints on a limited number of points: 

●     In Through points mode: tangency can be imposed on any point

●     In  Near points mode: tangency can be imposed independently on each end points only

●     In Control points mode: no tangency constraint can be imposed (end points can be constrained on other elements as 
described in step 7 above. See also Constraining a Control Points Curve.

 Here is how to do it:

Open the 3DCurve1.CATPart document.

1.  Move the pointer over an existing point, double-click it (the 3D curve dialog box appears), then right-click and choose 

the Impose Tangency menu item.
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Two sets of manipulators are displayed: 
●     two arrows representing the normed directions (vectors) of 

the tangency

●     circles representing manipulators for this vector

You can also modify the tangency constraint by: 
●     pulling the arrow

●     gliding the circles

●     double-clicking the arrow to invert the tangency direction

You can set the tangency length by clicking on the arrow then 
dragging the mouse.

Right-clicking on any of the manipulators, you can also choose 
to define the constraint according to an external element: 

●     Use current plane orientation (P1)/Use compass 
normal (P2): the tangency constraint is defined in relation 
to the normal to the current plane, possibly defined by the 
normal to the compass main plane
When several points are constrained on the compass, all 
are modified if the compass settings are changed.
When this option is checked, the direction cannot be 
modified directly using the vector manipulator, but only 
using the compass.

●     Constrain on element: available only when a point is 
already constrained on a curve. The curve being 
created/modified becomes constraint in tangency or 
curvature to the constraining curve at this point.

❍     Tangency constraint: in this case you can only modify 
the vector's norm using the Edit contextual menu, and 
no longer the vector's direction, the latter being 
defined by the constraining curve.
Click the arrow to invert the tangency direction if 
needed.

❍     Curvature constraint: in this case you neither modify 
the vector's norm using the Edit contextual menu, nor 
the vector's direction, the latter being defined by the 
constraining curve.
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By default, when the tangency vector is constrained onto another curve, its initial direction is retained.

●     Snap on elements: the vector's direction is defined by an 
external element. Grabbing a manipulators, you drag the 
pointer over a curve, and the curve becomes tangent to 
the curve detected by the pointer. 

If the pointer is over a point the direction is 
computed as the line going from the constrained 
point and the detected point.
If the pointer is over a plane, the tangency is 
defined by the normal to this plane.  

●     When snapping on an element, use the Control (Ctrl) key to obtain an exact snap, taking into account both the detected 
element and the vector's norm.

●     Use the Shift key as a shortcut to activate/de-activate the Snap on elements option when passing the pointer over 
geometric elements.

Once you are satisfied with the tangency constraint you imposed, simply release the manipulator and move the pointer around 
to recover the curve preview indicating that you are ready to create a new point.
Control Points Curve Constraint

Even though you cannot impose a tangency constraint on a curve created in Control points mode, you can constrain its end 
points on another curve, as described in step 7 above. 

When setting a constraint on an end point, a text is displayed 
indicating the type of continuity between the two curves.
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Right-click the text to display the contextual menu from which 

you can choose another continuity type: tangency, or 

curvature.

 

Note that: 
●     in Point continuity, only the selected point is constrained

●     in Tangent continuity, the selected point and the next one are constrained

●     in Curvature continuity, the selected point and the next two points are constrained

This means that these second and third points will be modified if you move the constrained point along the constraining 
element, using the manipulators. However, you cannot constrain these points, because they are considered as already 
constrained. If you try to do so, a warning message is displayed. Nevertheless, you can add/remove points directly after the 
constrained end point, and the system resets the points as second and third points to be affected by the constraint, where 
applicable.

A Continuity warning is displayed when trying to move the manipulators in a direction that is not compatible with the set 
constraint.

Imposing a Curvature Constraint

Right-click an existing point and choose the Impose 

Curvature menu item. An arrow representing the curvature 

direction (vector) is displayed. Modifying the vector direction 

modifies the curvature direction.

The direction of the curvature is constrained in the plane 

defined as normal to the tangent vector.

 
●     To impose a curvature continuity, you must ensure that a 

tangency continuity already exists.

●     This option is only available for the Through points and 
Near Points creation type.

 

Setting as Arc Limit
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Right-click an existing point and choose the Set As Arc Limit 

menu item to start/stop an arc limit on this point. The curve 

will pass through this point.

This option is only available for the Near points creation type.

  

You can use standard shortcuts (Ctrl and Shift keys) to select, multi-select, and de-select any combination of control points on 
these curves.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, temporary 
analysis, auto detection (except for Snap on Control Point option), attenuation, and furtive display.
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Creating Associative 3D Curves on a Scan of 
Cloud

This task explains how to create a 3D curve on a scan of cloud:

●     either before entering the 3D curve action. In that case, you can select only one scan, 

●     or after entering the 3D curve action. In that case, you can select one or several scans.

●     either graphically. In that case, use the contextual menu Select all points to create a 3D curve on all the 
points of the scan,

●     or from the specification tree. In that case all points of the scan are taken into account even if you do 
not activate the Select all points menu.

Open the ScanOnCloud1.CATPart document.

1.  Click the 3D 

Curve icon 

.

The 3D curve 

dialog box is 

displayed.

2.  Choose the 

curve creation 

type.

Whatever the chosen 
type, the curve is 
previewed in dotted line 
as you move the 
pointer.

●     Through points: 
the resulting curve 
is a multi-arc curve 
passing through 
each selected point.
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●     Control points: the 
points you click are 
the control points of 
the resulting curve

●     Near points: the 
resulting curve is a 
single-arc, with a 
set degree and 
smoothed through 
the selected points.

3.  Click OK to create the curve.

A 3DCurve.xxx appears in the specification tree.

4.  Double-click your 
curve, right-click 
on the 
manipulator to 
display the 
contextual menu. 

Please refer 
to the 
Creating 
Associative 
3D Curves to 
get the 
corresponding 
information.

It is now possible to select a scan on cloud before entering the 3D curve creation dialog box. To do so, 
click the Scan on Cloud in the specification tree and click the 3D Curve icon.

Selecting a scan of 
cloud

It is possible to select a scan of cloud either in the specification tree or directly in the cloud from the contextual menu: 

The Select all points contextual menu is available within the 3D curve action only, i.e. it is not available when you select the 
scan before entering the action but appears when the 3D Curve dialog box is open.
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●     Right-click the Scan 
on Cloud.xxx in the 
specification tree 
and select Select 
all points.

●     Right-click the cloud 
and select Select 
all points.

 

Here is an example with Through Points

Only scans of the type "scan on cloud" can be selected since other types of scans might contain too many 
points. 

●     Use the F5 key to move the manipulators into a different plane of the compass. See Managing the 
Compass.

●     The creation plane for each free point is defined according to the current plane/compass orientation on 
the previous point. Therefore you can change creation planes within the same curve, by setting a new 
current plane/compass orientation on several points.

●     Check the Disable geometry detection button, when you need to create a point close to a geometric 
element yet without constraining it onto the existing geometry.

●     Check the Hide previsualisation curve to hide the previsualisation curve you are creating.

For further information on the proposed Options, please refer to Creating Associative 3D Curves. 

You can use standard shortcuts (Ctrl and Shift keys) to select, multi-select, and de-select any combination 
of control points on these curves.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum 
creation, temporary analysis, auto detection (except for Snap on Control Point option), attenuation, and 
furtive display.
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Creating Free Form Curves on Surfaces

This task explains how to create trimming curves on a surface.
Two types of curves are available for creation:  freeform curves passing through all points you click, or  
isoparametric curves.
These curves must lie on the surface, but do not need to divide it.

Open any document containing a surface from the samples directory, or the CurveOnSurface1.CATPart 
document.

1.  Click the Curve on Surface icon .

2.  Select the surface on which the curve is to be created.

The Options dialog box is displayed letting you choose the curve type: an isoparametric curve, 

or a user-defined curve (Point by point). 

 Point by Point

If you choose the Point by point 
creation type, you need to define 
the curve creation mode: by 
interpolation or smoothing.

 

●     If you choose to use the Through Points mode, the resulting curve is a multi-arc parametric curve 
passing through each selected point.

●     If you choose the With control points mode, the points you click are the control points of the 
resulting parametric curve, as if you were using the editing capabilities (see Editing Curves Using 
Control Points).
This is the default value.

●     If you choose the Near Points mode, the resulting curve is a single-arc parametric curve, with a set 
degree and smoothed through the selected points.
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1.  Choose a mode and click anywhere on 

the selected surface. 

In the illustration, the Auto detection 

mode is active to Snap On Edge icon 

( from the Dashboard), therefore 

clicking anywhere on the surface lets 

us define a point on its edge.

A dot is displayed identifying the 
starting point location on the 
surface.

2.  Click as many locations as you wish the 

curve to go through.

Dots are displayed where you 
clicked, and the curve is previewed 
as you move the pointer around.

 

You can modify the shape of the 
curve at any time while it is being 
created. 

For example, using the manipulators 
on the control points, you can move 
the pointer above any of the 
creation points and pull on the 
manipulators up to the surface 
edges.

Capabilities are available from the contextual 
menu when right-clicking a contact point.

3.  Double-click to create the end point of the curve the surface, or click OK.

The curve end point can be anywhere on a surface or on an edge.

The curve has been created on the selected surface, following its shape.
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The surface can now be used for other purposes, such as trimming the surface, for example.

Click the Break icon  and select an area 

delimited by the curve to trim the initial 

surface (see Redefining Surface Limits).

●     Any surface can be used, whether planar or previously deformed.

●     If you choose the Near Point option, check the Order option fr

 Isoparametric
 

 

●     Manual selection: you can create as 
many isoparametric curves as necessary, 
in both U and V directions, while being in 
the command.

 

1.  Run the mouse on the surface and click 
to create the curve.
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2.  Still in the command, perform the 
same operation to create the second 
curve.

●     Each created curve can be independently modified using the 3D manipulators.

●     Capabilities are available from the contextual menu when right-clicking a contact point.
You can select the Invert Parameter option to inverse the direction of the curve.

3.  Click OK.

The curves have been created on the selected surface.

 

 
●     Automatic selection: you can create as 

many isoparametric curves as necessary, 
in both U and V directions, while being in 
the command. 

 1.  Define the value for U and V directions.
2.  Click the surface to preview the created 

curves.
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●     Each created curve can be independently modified using the 3D manipulators.

●     Capabilities are available from the contextual menu when right-clicking a contact point.
You can select the Invert Parameter option to inverse the direction of the curve.

 3.  Click OK.

The curves have been created on the selected surface.

 

     

 Creating a tangent curve:
 

a.  Use the With control points option 

and click the first two points on the 

surface edge (parametric line).

b.  Continue creating the curve as usual
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c.  if you wish to make it tangent on both 

sides of the surface, proceed by 

clicking two points on the other edge

d.  finish as usual, by clicking the last point on the 

surface edge.

This is especially useful when 
breaking a surface. The surface 
edge presents a tangency 
continuity.

 The resulting curves will always lie on the surface, even if you modify them using the control points 
capability after creation time.

To facilitate the edge detection, for example, use the remote auto detection capability.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum 
creation, auto detection, and contact points.
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Projecting Curves

This task explains how to project curves on surfaces.

Open the ProjectCurve1.CATPart document.

1.  Select a curve.

2.  Click the Project Curve icon .

The Projection dialog box is displayed. 

3.  Choose the projection orientation from the Projection dialog box:

●     Projection Normal to the Surface

●     Projection According to the Compass

4.  Press the Ctrl key and select the surface or set of surfaces on which the curve should be 

projected.

The projected curves are displayed, in dashed green, on the target surface along some 

information: 
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Projection according to
the compass orientation 

Projection according to
the normal to the surface

  
The projected curves are BSplines lying on the surface. 
The Converter Wizard is automatically used to process the resulting curve and generate either 
a 2D NUPBS (Non Uniform Polynomial B-Spline) curve identified by the Exact text, or a 3D 
NUPBS curve (identified by  Cv text).

If you wish to further control the projected curve, right-click the displayed text and choose the 
Edit contextual menu. The Converter Wizard is then explicitly launched allowing you to control 
the new curve creation.

For example, in the case of a 2D curve you may wish to generate a single segment curve by 
checking both the Segmentation and Single button in the Converter Wizard, then clicking 
OK.

5.  Click OK in the Projection dialog box to create the projected curves.

If you chose the projection according to the compass orientation, two curves are created on the 

surface, and show up in the specification tree as two different elements. 

●     When you project a curve on two surfaces, there may be no tangency continuity.
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●     Use the Furtive Display icon  to view the control points on 

the projected curve (in blue).

 
●     Check the Display Information option from the Converter Wizard's dialog box to the resulting 

curve's order and number of segments.

●     The element's topology (for example a relimited curve or surface) is taken into account for the 
projection.

●     Multi-selection of curves is allowed.

●     Multi-cell curves can be selected: the resulting projected curve will also be a multi-cell curve.

Available capabilities from the Dashboard are: datum creation, and keep original.
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Creating Blend Curves 
This task explains how to create blend curves.
Blending means that a connecting curve will be created between two selected curves, taking certain 
continuity, position and tension constraints into account.

Open the BlendCurve1.CATPart document.

1.  Select two curves.

2.  Click the FreeStyle Blend 

Curve icon .

The Blend Curve dialog box 

opens.

3.  Select the second curve, in case 

you have not previously 

selected it.

The blend curve is 
automatically previewed. By 
default it connects the curves 
at their end points closest to 
the selected points.

 

4.  Make sure  the Continuity icon 

  is active in the Dashboard 

and right-click onto the 

identifier to edit the continuity 

constraint, using the contextual 

menu.

The default continuity type is 

Tangent.
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You can do the same on the 

other end point. 

5.  Make sure the Contact Points 

icon  is active in the 

Dashboard, to display the 

contact points on the blend 

curve end-point.

Capabilities are available from the 
contextual menu when right-clicking a 
contact point.

6.  Move the pointer close to the 

contact point and drag the 

manipulator to modify the blend 

curve connection to the initial 

curves.

7.  Still from the Dashboard, make 

sure the Tensions icon  is 

active, and modify the tension 

by sliding the displayed value 

along the green segment.
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This segment represents the 
direction and limits of the 
blend curve tangent at its 
end points.

 

8.  You can also edit the value, or 

invert the tension direction, 

using the contextual menu on 

the value.

 

 
Tensions are now homogenized 
between blend surfaces and blend 
curves, so that the borders of a blend 
surface have the same shape as the 
blend curves, providing they are built 
on the same supports.

This homogenization is only possible 
with an approximated blend surface.
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9.  Once you are satisfied with the 

new curve, click OK in the 

Blend Options dialog box. 

The blend curve is computed .

The curve resulting from the blend remains selected by default. If you wish to perform analyses, make sure 
you select the other curves using the Ctrl-key.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum 
creation, auto detection (Snap On Vertex option only), attenuation,  continuity, contact points, tensions, and 
furtive display.
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Creating Styling Corners

This task explains how to create a styling corner, that is a connecting curve of a given radius between 
two other planar curves.
Styling corners are especially useful to create good quality surfaces based on a curve net, as described in 
Creating a Net Surface (available with the FreeStyle Profiler product only).

Open the StylingCorner1.CATPart document.

1.  Click the Styling Corner icon .

The Styling Corner dialog box is displayed.

2.  Select the two curves to be connected by a styling 

corner.

3.  Key in a radius value.

4.  Click Apply.

The corner is previewed, with manipulators, at 

the circle center, the constant radius limit (the 

segment between the two solid radius lines), 

and at the contact points, provided this option 

is active in the dashboard.  
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Capabilities are available from the contextual menu when 
right-clicking a contact point.

It may be interesting to perform a curvature analysis clicking the Porcupine Curvature Analysis icon 

 to visualize the resulting corner's curvature, and possibly modify it using the corner's manipulators.

In this case, it may be useful to smooth the curvature at the contact points and reduce the constant 
radius area:
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5.  Modify the options as needed: 

●     the Radius value in the editable field

●     the Single Segment option to impose a limited 
number of control points for the corner curve, thus 
resulting in a single arc curve.

In this case, the generative circle is not displayed, only 
contact points are, provided the Contact Points option is 
active in the dashboard.

Depending on the radius value, there may be several 
solutions. In this case, you are prompted to select one of 
the proposed solutions.

The concatenation mode (see below) is not available with 
this mode.

●     the resulting curve type:
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a.  Trim: to create a three-cell curve limited to the 
initial curves endpoints.
You can display their control points independently 

if you use the Control Points icon  (it creates 

another independent curve corresponding to the 
selected cell).
Initial curves are duplicated and trimmed at the 
contact points with the corner segment.

b.  No Trim: to create the corner arc only limited at 

the intersection with the initial curves

Initial curves are not modified.

c.  Concatenation: to create a mono-cell curve 

limited to the initial curves endpoints. You can 

display its control points independently if you use 

the Control Points icon  (it creates another 

independent curve corresponding to the whole 

curve).

Initial curves are duplicated, trimmed at the 

contact points with the corner segment, and 

concatenated with the latter. 
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6.  Click OK to create the styling corner.

A useful application of this command is to create a set of styling corners based on intersecting curves, 
then create an associate net surface based on these styling corners. You can then modify the initial set of 
curves and the surface automatically is recomputed.
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Matching Curves

This task explains how to match a curve with another curve, a point on curve or a 3D point..

Open the MatchCurve1.CATPart document.

1.  Select the curve you wish to match to another curve.

2.  Click the Match Curve icon .

The Match Curve dialog box is displayed. 

 
 

3.  Select the second element for the match curve to be joined to. It can either be:

1.  a curve

2.  a point on curve with history

3.  a datum point on curve

4.  a 3D point

5.  a vertex

 

 

 1. Match between a curve and another curve 2. Match between a curve and a point on curve 
with history

3. Match between a curve and a 
datum point on curve
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 4. Match between a curve and a 3D point 5. Match between a curve and a vertex

  

 
●     If a curve is selected as the second element, all continuities can be applied (point, tangent, and curvature continuities)

●     If a curve or a point on curve with history is selected as the second element, a point or curvature continuity can be applied. 

●     If a datum point on curve, a 3D point, a vertex is selected as the second element, a point continuity will be applied.

 If the second element to match (a point on curve with history, or a vertex) lies one more than one support,  the  appears.

Please refer to Selecting a Support for further information.

The first curve is automatically modified so as to be connected to the second element while taking the continuity type into account. 

The number displayed on the first curve (Nx) corresponds to number of control points on that curve.

●     The Project End Point option allows a linear 
projection of the minimum distance between two 
curves by projecting the initial curve onto the 
target curve.

  

 
●     The Quick Analysis option enables to perform a violation diagnosis of the curve matching. The original degree is kept (it is no more 

automatically increased). Several parameters are taken into account between the two curves: 
❍     distance 

❍     continuity degree

❍     curvature difference

4.  Click Ok in the Match Curve dialog box to create the matched curve as it is previewed.

If a continuity type leads to some 
inconsistencies regarding the curve's 
original degree, a warning message is 
issued.

Make sure the U, V orders icon  is active in the Dashboard so that the numbers of control points are displayed.
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In order to reach the correct degree (0 or 180 degree) and percentage (0%), you can either:

- increase the number of control points by 
clicking the number (the value is increased 
by one) or by selecting a number from the 
contextual menu, or 

- modify the continuity type by clicking it 
(it is displayed sequentially) or by 
selecting a type from the contextual 
menu.

Working with the FreeStyle Dashboard

1.  Make sure the Continuity icon  is active 

in the Dashboard and, right-click onto the 

identifier to edit the continuity constraint, 

using the contextual menu.

You can choose from the point, tangency 
or curvature continuity type to be taken 
into account.

2.  Still from the Dashboard, make sure the 

Tensions icon  is active, and modify the 

tension by sliding the displayed value along 

the green segment.

This segment represents the direction and 
limits of the match curve tangent at its 
end-points.

3.  Make sure the Contact Points icon  is 

active in the Dashboard, to display the point 

manipulators and to move the points along 

the curve, thus interactively redefining the 

connection location.
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4.  Click OK in the Match Curve dialog box to 

create the matched curve as it is previewed.

5.  When working in P2 mode, click the Break 

Surface or Curve icon  and select the 

curve to be broken.

6.  Select the side to be removed.

7.  Click OK in the Break Options dialog box.

A new split curve is created replacing the 

initial one.

The curve resulting from the match remains selected by default. If you wish to perform analyses, make sure you select the other curve using 
the Control key.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, auto detection (Snap On 
Vertex option only), attenuation,  continuity, contact points, tensions, and furtive display.

 

 

62Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Editing Curves Using Control Points

This task explains how to modify a curve using its control points.

Open the EditControlPoints1.CATPart document.

1.  Select the curve you wish to edit.

2.  Click the Control Points icon .

Control points and lines are displayed, 

along with the 3D compass and the curve 

degree.

●     If you select a curve that has been created outside the FreeStyle workbench, and the curve is not a 
NUPBS curve (Non-Uniform Polynomial  B-Spline), the Converter Wizard will be automatically 
displayed when the curve cannot be exactly converted. This allows you to control the conversion 
tolerance. 
However, when a curve can be exactly converted, such as a spline, or line for example, the Converter 
Wizard is not displayed, the conversion is done automatically and a message is issued. In this case, 
the Exact text is displayed on the element for information.

  

●     Planes and lines are used to quickly orientate the compass in the control points command. Therefore if 
you select a plane or a line, it will modify the compass orientation. 

  
 

●     By default all control points and mesh lines are selected. Click a specific point to deform the surface at 
this point only, or select a set of points using the Ctrl-key or Shift-key while clicking (multi-selection 
capabilities). The same applies to mesh lines.
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3.  Move the pointer over a point or a line.

Arrows are displayed according to the 
Support and Law options active in 
the Control Points dialog box.

●     Support defines the type of translation to be 
applied

●     Law defines the type of deformation that is 
to be applied when several control points 
have been selected.

For further information on supports and laws, 
refer to How to Use the Support and Law 
Options? 

In P1 mode, you can modify curves according to two laws only: 

1.  Move selected points identically
2.  Stretch selected points

You cannot specify a Support.
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4.  Pull on the arrow matching the direction 

in which you want to deform the curve.

 

5.  Use the Dashboard to display the order 

number directly on the curve, using the 

U, V Orders  icon.

The value is displayed on the curve.

6.  Use the contextual menu to choose the 

order number for the curve.

If you increase the order number to 
11, the result is: 

 

7.  Click OK in the Control Points dialog box to validate the modifications.
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●     Use the Control Points dialog box to modify the curve according to certain predefined laws.

●     To display the order number and continuity type directly on the curve, use the Dashboard's the 

Continuity  and U, V Orders  icons (P2) or the specified settings (using the Tools -> 

Options -> Shape -> FreeStyle -> General tab) (P1). 

You can edit these by right-clicking the displayed text, and choosing a new order number, or continuity 
type.

 

When selecting several curves, if a continuity 
constraint exists, the continuity tag displayed is 
set by default to the same continuity imposed by 
the constraint.

Use the Manipulators (arrows) to modify the curve as it is created. In P2 mode, the following manipulation 
options are available:

 
●     To fine-tune the manipulators, use the attenuation capability from the Dashboard. It lets you define 

the ratio between the mouse displacement and the actual displacement of the manipulator. This 
attenuation factor is saved in the CATIA settings.

●     To snap a point onto external geometry, use the auto detection capability from the Dashboard. 

●     To perform a quick analysis of the mesh line inflection, choose the Inflections checkbox.

The following options are available in P2 mode only:

 
●     Further modification options are available from the More... button of the Control Points dialog box: 

❍     Freezing of the selected points (no other can be selected) and of the Support option

❍     Dynamic display of the initial curve and of the delta as you pull on the control points

❍     Global selection/de-selection of control points using the Select All  and De-Select All  

icons, without having to click the geometry
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The Projection, Smooth, and Symmetry capabilities are only available with the FreeStyle Optimizer 
product.

●     Capabilities are available: 
❍     from the contextual menu when right-clicking a control point, 

❍     from the FreeStyle Dashboard,

❍     specified through the FreeStyle Settings, are: datum creation, keep original, auto detection, and 
attenuation.

●     To have further information about how to smooth curves, see Smoothing Curves.
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Smoothing Curves

This command is only available with the FreeStyle Optimizer.

This task explains how to smooth curves.

Open the SmoothCurve1.CATPart document.

1.  Select the curve to be smoothed.

2.  Click the Control Points icon .

Control points are displayed on the curve, and the Control 
Points dialog box appears.

3.  Define the smooth weight using the slider, and 

click Run.

The curve is smoothed according to the value. 

4.  Click again to repeat the smoothing operation.
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5.  Once you are satisfied with the smoothed curve obtained, click OK in the Control Points dialog 

box.

 

 

You do not need to select the whole curve. You can locally smooth the curve. Simply use the multi-
selection capabilities: 

●     Press and hold down the Shift-key and click on a first point. Still maintaining the Shift-key down, click 
another point of the curve. All points selected between the two selected points are selected as well, 
and the curve is smoothed in this area only.

●     Click a first point, press and hold down the Ctrl-key, then move on to the other points to be selected. 
Only the explicitly selected points are highlighted, and smoothing is performed on these points only.

Capabilities are available: 
●     from the contextual menu when right-clicking a control point, 

●     from the FreeStyle Dashboard,

●     specified through the FreeStyle Settings, are: datum creation, auto detection, and attenuation.
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Extrapolating Curves

This task explains how to modify a curve, or surface boundary, by extrapolation, that is by modification 
of its length. It can be a positive or negative extrapolation meaning that you can actually lengthen or 
shorten the curve.

Open the Extend1.CATPart document.

1.  Select the curve to be extrapolated.

It will be extrapolated on the end-point side closest to 

the selection point.

2.  Click the Styling Extrapolate icon .

The Extrapolation dialog box is displayed.

Only the Tangential extrapolation type is 
available for curves.

3.  Click the Tangential option:

The curve is extrapolated taking into account the  

keyed in length (expressed in model units). 

Here we keyed in 100.

 

If you key in a negative value, the resulting curve 
is created in the other direction.

5.  Click OK to create the extrapolated curve. 
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●     You can also use the manipulators to interactively modify the value.

●     The curvilinear length of the extrapolation is displayed.

●     Capabilities are available from: 
❍     the contextual menu when right-clicking an end point.

❍     the dashboard are: datum creation, auto detection, attenuation.
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Extending Curves
This task explains how to lengthen a curve by extension, that is by modification of its length. Two extension modes are 
available. In one case, it is a positive parametric extension, or it can be an extension by addition of segments to the 
curve. 

Open the Extend1.CATPart document.

1.  Select the curve(s) to 

be extended.

Multi-selection of curves is now 
possible.

 
2.  Click the Extend icon 

.

Manipulators are 

displayed on the 

curve.

 

The Extend dialog 
box is displayed. 

Two working modes 
are available:

If you go over a curve's 
extremity with the mouse, the 
manipulator becomes the 
master manipulator, meaning it 
is active at that extremity. 

 
3.  Use the manipulators to extend the curve on both sides.
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●     With the Keep 
segmentation 
option checked: 
use the 
manipulator to 
define the curve 
extension. 
When the value 
is positive, the  
last segment 
(defined by the 
arc limits) is 
made longer.

The distance tag 

displays the absolute 

curve distance from 

the extremity of the 

original curve.

●     With the Keep 
segmentation 
option 
unchecked: the 
curve is extended 
taking the 
curvature 
continuity of the 
last segment into 
account. This 
means that only 
this last segment 
can be extended.

If you change the mode, the new curve is computed from the original curve, not from the curve previously computed..

4.  Click OK to create the 

extended curve. 

 
Extending Curves Using Absolute and Relative Distance Modes

 
1.  Right-click the distance 

tag which displays the 

absolute curve distance.

2.  Choose the Edit item in 

the contextual menu.
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 The Edit Box dialog 
box is displayed.
The manipulator 
becomes active and 
the distance tag is 
symbolized in green.

3.  Enter the extension 

value.

Here we chose 100mm.

4.  Click Close to apply the 

new value.

This value is always positive.

5.  Again, right-click the 

distance tag.

6.  Choose the Slave item 

in the contextual menu.

This option enables to 

apply the delta curve 

extension to the master 

manipulator and the 

slave manipulator.

A  symbol appears 

near the slave 

manipulator and its 

distance tag is 

symbolized in yellow.

 
7.  Now use the 

manipulators to extend 

the second curve.

You can see that 

both curves are 

extended with the 

same delta 

(93.432mm). The 

slave manipulator 
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''follows'' the master 

manipulator.

 
If you go over the distance tag 
of the slave manipulator with 
the mouse, it becomes active 
again.

  
●     You can also access these contextual menu items by clicking the distance tag and moving sequentially from one 

option to the other (Edit, then Slave, then Free).

●     The Free option enables to free the slave manipulator.

  
You can extend a trimmed 3D or 2D curve: the parameterization of the original curve is used, then the extension is 
calculated.
When extending a 2D curve, a 3D cell is added. Therefore the extended curve is made of two or more cells.
   

The Edit and Keep this point options are also available from the contextual menu when right-clicking the 
manipulator.

Capability are available from the Dashboard: datum creation and keep original.

 

 

75Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Trimming Curves

This task explains how to trim curves by one or more curves or points.

Open the Break2.CATPart document.

1.  Click the Break icon .

The FreeStyle Break dialog box is displayed as well as the Break Report panel and the Tools 

Palette.

2.  Choose the Break type by clicking on the icons on the left.

Three types are available:

●     Curves by points

●     Curves by curves

●     Surfaces by curves (please refer to the corresponding chapter)

Breaking Curves by 
Points

 

 

In the Selection page, the Cut (0) 
text is highlighted.
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1.  Select one or more curves 

to be trimmed. 

 

2.  Click the Cutting (0) text 

and select one or more 

cutting points.

 
3.  Click Apply.

By default, all elements 

are kept.
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The Break Report panel displays all the 

information regarding the cutting elements. 

It lists:

●     the cutting elements that can be used 

for the Break (marked by a green tip). If 

you click on the text, the corresponding 

curve is highlighted in green in the 3D 

geometry.

●     the cutting elements that cannot be 

used for the Break (marked by the 

condition to be applied so that they can 

be used: projection, etc). If you click on 

the text, the corresponding curve is 

highlighted in red in the 3D geometry.

❍     If there is no selection of cutting 

elements, an error message is 

issued and the Break Report panel 

informs you that no element is 

selected.

❍     If a red cross is displayed, it means 

that the problem cannot be 

managed by the system.

This panel can also be opened via the 
Display tab.
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2.  Click the parts of the curves you do 

not want to keep: they appear 

dotted in the 3D geometry.

 

   
 A contextual menu is available on the each 

part of the surface.

●     Keep all: all parts of the all curves are 

kept

●     Keep all but this: all parts of all curves 

are kept except the selected one

●     Remove all but this: all parts of all 

curves are removed except the selected 

one

   
 

5.  Click the <<Settings text 

to access advanced 

settings.

The following options can 

be activated by clicking on 

the icons.

 

Projection  
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●     no projection: click the 

Projection text to make the 

projection optional.

As a consequence, the points 

that do not lie on the trimmed 

curves will not be projected 

onto the surface.

 
If certain points do not lie on the trimmed curves, they will be projected (pseudo-intersections) onto the 

curves according to the direction set in the Break dialog box, that is:

 

●     Compass: click the compass 

icon so that the projection is 

normal to the compass.

   
 

●     Normal: click the normal icon 

so that the projection is 

normal to the element.
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Relimitation  

 

●     Keep mesh: click the Keep 
mesh icon so that the curves 
are topologically relimited and 
the control points of the initial 
curves are kept.
Here is an example with a 
projection normal to the 
compass.

 

●     Shorten mesh: click the 
Shorten mesh icon so that the 
curves are geometrically 
relimited and the control 
points of the resulting curves 
are kept.
Here is an example with a 
projection normal to the 
compass.
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Breaking Curves by 
Curves

 

 

In the Selection page, the Cut (0) 
text is highlighted.

 

1.  Select one or more curves 

to be trimmed. 
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2.  Click the Cutting (0) text 

and select one or more 

cutting curves.

 
3.  Click Apply.

By default, all elements are kept.  

The Break Report panel displays all the 

information regarding the cutting elements. 

It lists:

●     the cutting elements that can be used 

for the Break (marked by a green tip). If 

you click on the text, the corresponding 

curve is highlighted in green in the 3D 

geometry.

●     the cutting elements that cannot be 

used for the Break (marked by the 

condition to be applied so that they can 

be used: projection, extrapolation, etc). 

If you click on the text, the 

corresponding curve is highlighted in red 

in the 3D geometry.

❍     In case of an extrapolation problem, 

the side of the curve to be 

extrapolated is circled in red.
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❍     If there is no selection of cutting 

elements, an error message is 

issued and the Break Report panel 

informs you that no element is 

selected.

❍     If a red cross is displayed, it means 

that the problem cannot be 

managed by the system.

This panel can also be opened via the 
Display tab.

 

2.  Click the parts of the 

curves you do not want to 

keep: they appear dotted 

in the 3D geometry.

You can now cut the cutting elements.

   
A contextual menu is available on the each 
part of the surface.

●     Keep all: all parts of the surface are 

kept

●     Keep all but this: all parts of the 

surface are kept except the selected one

●     Remove all but this: all parts of the 

surface are removed except the selected 

one
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3.  Click the <<Settings text 

to access advanced 

settings.

The following options can 

be activated by clicking on 

the icons.

 

Projection  

 
If certain points do not lie on the trimmed curves, they will be projected onto the surface according to the 

direction set in the Break dialog box, that is:

 

Compass: click the compass icon 

so that the projection is normal to 

the compass
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●     Keep mesh: the curve is 
topologically relimited and the 
control points of the initial 
curve are kept.

 

●     Shorten mesh: the curve is 
geometrically relimited and 
the control points of the 
resulting curve are kept.

  
 

3.  Click OK to trim the curves.

●     Click the Display>> text to manage the display of the 3D icons and the Break Report panel.

●     Available capabilities from the Dashboard are: datum creation, keep original, insert in a new 
geometrical set, and temporary analysis.

 

 

Relimitation  
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Concatenating Curves

This task explains how to concatenate a 3D multi-cell mono-domain FreeStyle curve or separate 
contiguous curves into a mono-cell curve.
The resulting curve is a curvature continuous curve (C2).

Open the Concatenate1.CATPart document.
This document contains a two Join-type elements, and a set of connex curves, each identified by different 
colors.

1.  Click the Concatenate icon .

The Concatenate dialog box is displayed.

2.  Set the tolerance value.

This value defines the maximum parametric deviation allowed between the selected elements 
and the resulting curve when concatenating. 

The Maximum deviation value displayed in the dialog box (see step 4) is computed as the 
standard distance analysis and therefore is not necessarily the minimum tolerance value to be 
set in order to concatenate the curves.

Would the tolerance value you entered not be adequate, a message is issued prompting you to 
increase it. However, to help you, the minimum tolerance value necessary to obtain a result is 
then automatically displayed.
If you are using the Auto Update Tolerance mode, the minimum tolerance value is 
automatically modified; therefore no message is issued.

3.  Select the curves you wish to concatenate and 

click Apply.

Here we selected Join.2 from the specification 

tree, and set the tolerance value to 1.6. 

A single curve is previewed, with its segment limits, provided the tolerance is compatible. If 
not, no concatenated curve is previewed, and the OK button is grayed.

4.  Click More>> in the dialog box.
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5.  Check the Information option.

The corresponding information is displayed on the 

resulting curve, that is:

●     N: number of control points

●     o: the curve order

●     s: the number of segments in the curve

●     the maximum deviation

In case you did not check the Information button, the 

maximum deviation is also indicated in the dialog box. 

 
6.  Check the Auto Update Tolerance option to automatically update the tolerance value in case 

the value you set is too low.

The minimum value to enable the concatenation is displayed and the concatenation is performed.

7.  Click OK in the Concatenate dialog box.

A curve is created, the result of the 

concatenation of the elements making up the 

initial Join.

●     If no resulting curve is displayed once you have clicked Apply, increase the tolerance value.
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●     Multi-selection is available using the Control Key, 
i.e. you can select several Join elements for example, 
and each one will generate a concatenated curve.
(Join.1 in green is still visible behind Curve.19, but 
you can notice the deviation due to the discontinuity 
of the initial element.)

●     Similarly, you can select several contiguous curves using the Control key, or a trap, to generate a 
single curve. 
If the selected curves are not connex (if there is a gap between two curves), the Apply button is 
grayed, and you cannot create the concatenated curve.

  

Set of independent connex curves Resulting concatenated curve

●     If the selected elements present a curvature discontinuity (as illustrated below), you will need to 
increase the tolerance value accordingly.
In this case too, the maximum deviation will increase considerably.
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Initial element presenting a discontinuity Deviation onto a discontinuous element

●     Use the Converter Wizard prior to selecting non 3D NUPBS multi-cells curves for concatenation.

Available capabilities from the Dashboard are: datum creation, keep original and furtive display.
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Fragmenting Curves

In this task you will learn how to fragment multi-arc bodies into mono-arc bodies.

Open the FragmentCurve1.CATPart document.

1.  Select the curve.

2.  Click the Fragmentation  icon   in the Shape 

Modification toolbar.

The selected curve is previewed with separators 
indicating the limits of each arc, thus allowing the 
pre-visualization of the resulting curves.

The Fragmentation dialog box is displayed.
The Type frame does not apply for curves.

3.  Click the Keep original icon  from the 

Dashboard if you want to keep the initial curve when 

fragmenting the body.

4.  Click OK.

The curve is fragmented in as many curves as there were 
arcs in the initial curve. This means that  independent 
curves are created.

In the example, we assigned a different color to each of the 
resulting mono-arc curves.
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●     Multi-selection is available.

●     This function enables you to fragment surfaces as well, see Fragmenting Surfaces.

Available capabilities from the Dashboard are: datum creation, keep original, and furtive display.
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Approximating/Segmenting Procedural Curves

In this task you will learn how to convert any curve, created using other products but FreeStyle, into a 
NUPBS (Non Uniform Polynomial B-Spline) curve, and to modify the number of arcs (segments) onto any 
curve, including these created using FreeStyle products.

This approximation is automatically performed when you try to edit a curve using control points. In this 
case: 

●     when an exact conversion can be performed, it is done automatically, and the Converter Wizard is not 
displayed. This is the often the case with splines and lines.

●     when the exact conversion cannot be performed, as for ellipses, hyperbolas, parabolas, and so forth, 
the converter Wizard is displayed allowing you to define the approximation tolerance.

Open the Approximate1.CATPart document.

 

  

1.  Select the curve to be approximated.

2.  Click the Converter Wizard icon  .

The Converter Wizard dialog box is 

displayed allowing you to define the 

approximation according to a tolerance.

You need to set the values for the different 

options:

●     Tolerance: that is the deviation tolerance from the initial curve. 
On the geometry, a red text is displayed if the tolerance is not respected, that changes to green when 
the new element is within the specified tolerance.

●     Orders: that is the maximum allowed order along the U direction for each curve segment.
This value must be greater than or equal to 2 along U, when the segmentation options are grayed 
(one segment only). Otherwise, it must be greater than 4 included (when there are several 
segments).
The maximum value allowed per segment is defined by the Max order field in the FreeStyle Settings 
and must be less than or equal to 16.

In P1 mode, the Max order is set to 16 and cannot be modified.
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●     Segmentation:  that is the maximum allowed segments along the U direction.
If Single is checked, a mono-segment curve  is created.

When one of these options is inactive, the system automatically optimizes this option's  parameters to 
comply with the other options' values.

Furthermore, two buttons offer other capabilities:

1.  3D conversion: to convert a curve on surface into a 3D curve
2.  2D conversion: to retain the 2D of a curve on surface

Depending on the type of the initial element, a text is displayed indicating what approximation 
needs to be performed: 

●     CV: the initial curve is not a NUPBS and needs to be approximated using the Converter 
Wizard parameters

●     EXACT: the initial curve can be converted in exact mode (no parameter needs to be set)

●     Seg: the initial curve already is a NUPBS

 

Provided the Continuity icon  is active from the Dashboard, and at least one conversion option is 

active (Tolerance, Orders, or Segmentation, i.e. you are not in exact conversion mode), a continuity 
constraint can be imposed identically on both curve end points.
Two continuity types are available: tangent or curvature continuity. By default, it is tangent, and you can 
change it either by using the contextual menu or by clicking the text in the geometry.
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3.  Click More>> to display more options:

●     Check the Information option to display further 

information on the element: 

❍     Max: the maximum deviation in relation to 

the initial element

❍     N: number of control points

❍     o: the curve order

❍     s: the number of segments in the curve

●     Check the Control Points option to display the 

curve's control points.

●     Check the Auto Apply button to dynamically 

update the resulting curve. 

Furthermore, the maximum deviation, minimum and maximum radius values are displayed in the 
Converter Wizard for information

4.  Click OK.

The curve modification is taken into account.

●     Multi-selection of curves is available. 

●     You can mix the approximation of curves and surfaces.

●     The Priority check button indicates which of the Orders or Segmentation parameter is taking 
precedence over the other one. 

●     Use the Exact conversion mode (no parameter needs to be set) on a NUPBS element to display the 
number of control points, curve order, and number of segments in the curve.
Note that in this case, the initial element is duplicated.

To convert a multi-cells curve, select it from the specification tree. If selected in the geometry, you might 
be selecting only one cell instead of the whole curve.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum 
creation, keep original (depending on the selected element), continuity, and furtive display.
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Creating and Managing Surfaces
This chapter deals with surface creation and management using the FreeStyle Shaper workbench. 

 See also the FreeStyle Dashboard tools as they affect the curve creation and modification.

Create planar patches: use the compass to define the creation plane, click two points.

 Create a surface from three points: click two points, drag the pointer and click a third point.

 Create a surface from four points: click at least three points on existing geometry and a fourth point.

Create a surface on an existing surface: select a surface, click a point, drag the pointer over the surface 
and click another point still on the surface. 

Create revolution surfaces: select a profile, a rotation axis, and define the angular limits of the 
revolution surface.

Edit surfaces using control points: select a surface, set the deformation options, pull on the control 
points and mesh lines in specific directions.

Edit a surface boundary: select a surface boundary and edit it using its control points.

Extrude a surface: select a curve, set the extrusion direction and value.

Offset surfaces: select a surface, specify the offset type (simple or variable), the offset value and 
constraints to be taken into account when offsetting (deviation tolerance, maximum orders, etc.).

Extrapolate a surface: select a surface boundary, specify the extrapolation type and value.

Create blend surfaces: click an edge on two surfaces, set the display options allowing the modifications 
of continuities and tensions, manipulate the coupling points defining the blend.

Create an ACA Fillet: click the icon and select two edges.

Create filling surfaces: select contiguous surface boundaries forming a closed contour, or close it by 
clicking OK.

Create associative filling surfaces: select contiguous surface boundaries forming a closed contour, or 
close it by clicking OK.

 
Manipulate surfaces: select a surface, drag and drop the compass onto it, move the surface along the 
compass axes.

 
Rotate a surface: select a surface, drag and drop the compass onto it, select, hold and glide on one of 
the compass' arc of circle
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Match surfaces: select a surface edge and a boundary on another surface, specify the matching 
parameters using manipulators on coupling and control points, and the contextual menu to set 
continuities and tensions. 

Multi-side matching: successively select a surface edge and its target curve on another surface, specify 
the matching parameters, and use the contextual menu to set continuities or surface order.

Extend a surface: select a surface boundary, specify the extension type and value.

Smooth surfaces: select a surface, set the smoothing weight and click Run.

Redefine surface limits: click the icon and select the part of the surface to be removed.

 
Restore a surface: select the surface to be restored and click the icon.

Concatenate surfaces: select a two-cell surface, or two separate surfaces, and set the tolerance value.

 Fragment surfaces: select a surface and specify the breaking options.

 Disassemble elements: select a multi-cell element, and choose the disassembling mode.

Approximate/segment procedural surfaces: select a surface, specify the approximation tolerance, and 
the resulting surface maximum orders and/or segments

Copy geometric parameters: select the template curve and select the target curves.

 Create a Continuity Constraint: click the Continuity Constraint icon and select the elements to be 
connected.
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Creating Planar Surfaces

This task explains how to create planar patches, that is planar surfaces.

Open a new .CATPart document.

1.  Click the Planar Patch icon .

The 3D compass is displayed in the document and 
looks like this:

The solid planes of the 3D compass indicate in 
what plane any action is to be performed.

By default the creation plane is the XY plane. However, you can right-click the compass to 
display other options:

a.  Make XZ the Privileged Plane: elements are created in the XZ plane
b.  Make YZ the Privileged Plane: elements are created in the YZ plane
c.  Make Privileged Plane Most Visible: the plane in which elements are created is the 

plane seen most.

Keep the default working mode.
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The surface is created in the current active plane as defined using the Current plane orientation toolbar 

containing the  Flip to UV or XY , Flip to VW or YZ   or Flip to WU or XZ  icons.

To find out more about the compass, see Moving Objects Using the 3D Compass.

2.  Click anywhere in the window.

An outline appears and evolves as you move the 
pointer in the main window. Two values are 
displayed indicating the length and width of the 
patch.

If you call the function when a plane is selected, the surface is created in the selected plane otherwise it 
is created as described in the following cases. 

●     If the 3D compass is in the model, the surface is created in the plane defined by the base.

●     If the 3D compass is in the upper-right corner of the screen, the surface is created in the plane 
parallel to the compass base and passing through: 

❍     the origin of the model if the first point selected is in space

❍     the first point selected on geometry
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3.  Right-click and choose Edit dimensions.

If you do not explicitly enter the dimensions of the 
surface, simply click again when you have reached 
the adequate size.

The planar patch is created.

 

●     Once the first point is defined, right-click anywhere, and choose the Edit Orders menu item, to edit 
the surface degree (in U and V) using the Orders dialog box just like you edited the dimensions.

●     Using the Ctrl-key, the planar patch is 
centered around the point corresponding to 
the initial click, otherwise, by default, this 
point corresponds to one corner or the patch.

Available capabilities from the Dashboard are: datum creation, and auto detection.
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Creating a Surface from Three Points

This task explains how to create surfaces by clicking three points in pre-existing geometry or space.

Open a new .CATPart document.

1.  Click the 3-Point Patch icon  in the Surface Creation toolbar.

 
2.  Successively click two 

points in space, or on 

already existing geometry, 

to define the first direction 

of the patch.

 
A line is displayed to 

show the direction, and 

a text indicates the 

length of the segment.

3.  Drag the pointer.

A planar patch is pre-

visualized and evolves as 

the pointer moves in 

space: the first two points 

making up the direction, 

the second length of this 

same patch being given by 

the distance between the 

first line and the normal 

projection from the pointer 

location onto the privileged 

plane containing the first 

point.
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You can also right-click, 
and choose the Edit 
Dimensions menu 
item, to display the 
Dimensions dialog box 
that allows you to define 
exactly the second 
length of the patch.

The surface is created in the current active plane as defined using the Current plane orientation toolbar 

containing the  Flip to UV or XY , Flip to VW or YZ   or Flip to WU or XZ  icons.

 

4.  Click a third point to define 

the second direction of the 

patch as well as its area.

The planar patch is 

created.

●     Right-click and choose the Edit Orders menu item to edit the surface orders (U and V) at any time 
during the creation.

●     Use the Ctrl-key to create a patch symmetrically on each side of the segment defined by the first two 
points.

Available capabilities from the Dashboard are: datum creation, and auto detection.
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Creating a Surface from Four Points

This task explains how to create surfaces by clicking four points in pre-existing geometry and space.

Open the FourPointsPatch1.CATPart document.

1.  Click the 4-Point Patch icon   in the Surface Creation toolbar.

2.  Click one of the curves.

You can click anywhere on any curve, at the intersection of 
curves, or on any other element.

 

3.  Successively click two other points on the pre-existing 

geometry. An outline is previewed, representing the 

surface as it is defined.

 

4.  Click anywhere in the document to create the last 

point used in the surface definition.

If you click in space, the patch is a planar patch that 

belongs to the plane defined by the first three points.

If you click the fourth point on existing geometry, the 

resulting surface will not necessarily be planar.
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5.  Once all four points have been clicked, the corresponding surface is automatically created.

 

●     Right-click and choose the Edit Orders menu item to edit the surface orders (U and V) at any time 
during the creation.

●     Available capabilities from the Dashboard are: datum creation, and auto detection.
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Creating a Surface on an Existing Surface

This task explains how to create a surface on an existing surface. The newly created surface will lie on 
the initial one.

Open the SurfOnSurf1.CATPart document.

1.  Select an existing surface.

2.  Click the Geometry Extraction icon .

3.  Click on the surface, where you would like a corner of 

the new surface to be located.

If you press the Ctrl-key while clicking, the surface is 

created symmetrically in relation to the initial surface 

center.

4.  Drag to generate a rubberband matching the new 

surface.

5.  Click once you are satisfied with the new surface as 

visualized.

6.  A surface is created lying exactly on the initial surface:
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●     As opposed to the creation of planar patches, you cannot define the surface orders (U and V) prior to 
or while creating the surface. The resulting surface orders are identical to those of the initial surface. 
However, these values can later be edited (see Editing  Surfaces Using Control Points).

●     These surfaces, as any other surfaces, can be edited using the control points.

●     If you move the pointer to the edge of the initial surface, the new one will automatically snap on the 
initial boundary.

●     Similarly, you can create curves on an already existing curve. Using the Ctrl-key will then create a 
curve symmetrically in relation to the initial curve center.

●     See Creating Curves on Surfaces to find how to use the remote auto detection capability.

Only the datum creation capability is available from the Dashboard.
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Creating Revolution Surfaces 

 
This task shows how to create a surface by revolving a planar profile about an axis.

 
Open the Revolution1.CATPart document.

 
1.  Click the Revolve icon  .

The Revolution Surface Definition dialog box 

appears. 
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4.  Click OK to create the surface.

The surface (identified as Revolute.xxx) is added to the 
specification tree. 

●     There must be no intersection between the axis and the profile. However, if the result is topologically 
consistent, the surface will still be created.

●     If the profile is a sketch containing an axis, the latter is selected by default as the revolution axis. You 
can select another revolution axis simply by selecting a new line.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing 
Parameters chapter.

 

 

 

2.  Select the Profile and a line indicating the desired 

Revolution axis.

3.  Enter angle values or use the graphic manipulators 

to define the angular limits of the revolution surface.
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Editing Surfaces Using Control Points

This task explains how to modify a surface using control points and mesh lines.

Open the EditControlPoints1.CATPart document.

1.  Select the surface.

It will be duplicated if the Keep Original icon is active in the FreeStyle Dashboard.

2.  Click the Control Points icon .

The 3D compass is displayed showing the privileged plane in which you are working when you are 

manipulating the surface.

If you select a surface that has been created outside the FreeStyle workbench, and the surface is not 
based on a NUPBS  (Non-Uniform Polynomial  B-Spline), the Converter Wizard will be automatically 
displayed when the surface cannot be exactly converted. This allows you to control the conversion 
tolerance. 
However, when a surface can be exactly converted, the Converter Wizard is not displayed, the conversion 
is done automatically and an information message is issued.

As soon as you clicked the icon, control 
points and mesh lines are displayed. They 
are used to manually pull on the surface so 
as to deform it.

Planes and lines are used to quickly orientate the compass in the control points command. Therefore if 
you select a plane or a line, it will modify the compass orientation. 
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The Control Points dialog box is displayed:

Use it to define the type of operation to be 
performed on the control points.

●     Support defines the type of translation 
to be applied

●     Law defines the type of deformation 
that is to be applied when several 
control points have been selected.

For further information on supports and 
laws, refer to How to Use the Support and 
Law Options? 

Here, choose the Translation along the 
normal to the surface and Bell law 
options.

In P1 mode, you can modify curves according to two laws only: 

1.  Move selected points identically
2.  Stretch selected points

You cannot specify a Support.

3.  Move the pointer onto one of the control points or mesh lines. 

Manipulators automatically appear. They represent the directions in which you can perform a 

deformation.

4.  Pull on the arrow matching the 

direction in which you want to 

deform the surface.

The surface follows the shape indicated by 
the mesh line or control point.

You can activate other support and law 
options and continue deforming the surface.
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By default all control points and mesh lines are selected. Click a specific point to deform the surface at 
this point only, or select a set of points using the Ctrl-key or Shift-key while clicking (multi-selection 
capabilities). The same applies to mesh lines.

5.  Click More... in the Control Points 

dialog box.

Further modification options are 

available:

●     Selecting all control points  or de-

selecting them all  at a time 

without clicking in the geometry.

●     Using the Harmonize icon  you smoothly  propagate the control points organization over the 

surface. It is especially useful when the boundary mesh lines have been constrained within a given 
plane for example.
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●     Freezing of directions or of the selected points (no other can be selected) and the modification can be 
performed only according to the allowed directions, i.e. some modifications may no longer be possible

●     Dynamic display of the initial surface 
and of the delta as you pull on the 
control points.

The initial surface is represented by black 
solid lines (external edges) and dotted lines 
(inner isoparametric curves).

The maximum deviation is given for 
information.

●     Smoothing (refer to Smoothing Surfaces).

    
To display the order number and continuity 
type directly on the surface, use the 

Dashboard's the Continuity  and U, V 

Orders  icons (P2) or the specified 

settings (using the Tools -> Options -> 
Shape -> FreeStyle menu) (P1).  

You can edit these by right-clicking the 
displayed text, and choosing a new order 
number, or continuity type.

Available continuity types are: Free, Point, 
Tangent and Curvature.
The continuity type affects how the surface 
border is evolving when the whole surface is 
modified. 
A warning message can be displayed on the 
geometry when the chosen continuity and 
the chosen Support and Law do not comply.
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When selecting several surfaces, if a 
continuity constraint exists, the continuity 
tag displayed is set by default to the same 
continuity imposed by the constraint.

6.  Click OK in the Control Points dialog box to validate the modifications.

The surface is modified.

 
●     Click any specific point, or mesh line to deform the surface at this element only. By default, selected 

points are displayed in red, and are green when deselected.
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●     Deformation can also be done using the 

Tuner dialog box displayed using the 
Edit  contextual commands on control 
points or mesh lines. With this dialog 
box you can: 

❍     specify the exact position of the 
control point in space

❍     define a step value by which a 
control point/mesh line moves (Step 
field).
Once the value has been defined in 
the Tuner dialog box,  press and 
hold the Shift key then click one of 
the manipulator's arrow to move the 
selected control point by the defined 
step value.

Use the Manipulators (arrows) to modify the surface. In P2 mode, the following manipulation options are 
available:

 
●     To fine-tune the manipulators, use the attenuation capability from the Dashboard. It lets you define 

the ratio between the mouse displacement and the actual displacement of the manipulator. This 
attenuation factor is saved in the CATIA settings.

●     To snap a point onto external geometry, use the auto detection capability from the Dashboard. 

●     To perform a quick analysis of the mesh line inflection, choose the Inflections checkbox.

●     You cannot move unselected points unless no point is selected.

   

The following options are available in P2 mode only:

 
●     Further modification options are available from the More... button of the Control Points dialog box: 

❍     Freezing of the selected points (no other can be selected) and of the Support option

❍     Dynamic display of the initial curve and of the delta as you pull on the control points

❍     Global selection/de-selection of control points using the Select All  and De-Select All  

icons as shortcuts to select/release all control points of the selected elements,, without having to 
click the geometry.

 
●     The Freeze, Select All, and De-Select All capabilities are also available on the contextual menu 

displayed when right-clicking a control point, and depending on the geometry, with the following 
capabilities: 

❍     Project on the plane

❍     Project on the normal

❍     Harmonize

Note that using the contextual menu on an element,  when several element have been selected, applies 
the chosen capability on this element only, and not on the whole selection. However, if you apply the 
same capability from the Control Points dialog box,  a given all the selected elements will be affected.
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●     The Enable local plane detection 

 icon allows you to find whether 

certain control points and mesh lines are 
aligned within a specific plane.

In this case, text are displayed along U and 
V indicating where the detection is active.

  

Right-click these texts to choose to retain, 
or not, the planar organization of control 
points in one direction.

●     Projection: Use this capability to project selected points according to the local 3D compass either in 

the current plane or according to the normal to the current plane:

1.  Bring the 3D compass onto the surface

2.  Select a mesh line or a subset or control points (you can also select all points but in this case the 

whole surface is projected according to the compass)

3.  Click the Projection icon .
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●     Select a mesh line and the compass 
plane, and click one of the following 
icons: 

-  : the points are projected 

along the compass plane

-  : the points are projected 

along the normal to the current 
plane. 
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●     Click the Symmetry icon to perform a 
symmetrical modification in relation to 
the current plane. 

You can choose to use the current plane (by 
clicking OK in the dialog box), or to define a 
new plane as the current plane (by clicking 
Cancel first, then creating a new plane).

If you choose the current plane, you can 
modify its location using the manipulator, 
prior to confirming its use in the dialog box.

Use the F5 key to display the quick compass orientation toolbar and move the manipulators into a 
different plane of the compass. See Managing the Compass.

●     Use the F6 key to "quickly" orientate the 
compass :

❍     along an axis, by selecting either: 
■     an existing plane,

■     a mesh line, or

■     two control points 

❍     in a plane, by selecting either: 
■     a local plane,

■     two mesh lines, or

■     three control points

When you click this key, the control 
points are deactivated.

●     Press both F6 and Control keys to create 
either a Mean Plane or a 3 Point Plane 
plane using control points in order to 
project them: 

❍     Mean Plane: select a mesh line
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❍     3 Point Plane: select a point, the 
two extreme points are automatically 
defined

Capabilities are available:

●     from the contextual menu when right-clicking a control point,

●     from the Dashboard,

●     specified through the FreeStyle Settings, are: datum creation, keep original, auto detection, 
attenuation, continuities and orders

The Harmonize and Local Detection capabilities are only available with the FreeStyle Optimizer 
product.
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Editing a Surface Boundary

This task explains how to modify a surface boundary as created in Creating Free Form Curves on 
Surfaces using its control points.

Open the CurveOnSurface2.CATPart document.

1.  Select the surface boundary you wish to edit.

2.  Click the Control Points icon .

Control points and lines are displayed along that boundary.

 

 

 By default all control points are selected. Click a specific point to deform the boundary at this point only, 
or select a set of points using the Ctrl-key or Shift-key while clicking (multi-selection capabilities).

3.  Modify the boundary pulling on its control points or the 

mesh line.

 

4.  Click OK in the Control Points dialog box.

The boundary is modified.
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Only the boundary and its control points are modified. Any other boundary of the surface is not 
affected by these modifications.
See also Editing Curves Using Control Points.

Capabilities are available: 
from the contextual menu when right-clicking a control point, 
from the Dashboard,
specified through the FreeStyle Settings, are: datum creation, auto detection, 
attenuation, continuities and orders.
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Extruding Surfaces 
In this task you will learn how to create a surface by extrusion from a curve. This can be any type of 
curve, such as planar curves, 3D curves, surface edges, or curves on surfaces.

Open the Extrude1.CATPart document.

1.  Click the Extrude Surface icon .

2.  Select the curve from which you want to extrude a 

surface.

A manipulator is also displayed on the curve, 
oriented according to the 3D compass.

The Extrude Options dialog box is displayed:
●     the Normal to the curve icon is the default icon and 

indicates the direction orthogonal to the curve plane

●     the Compass direction icon enables you to manipulate 
elements using the 3D compass

●     the Length field indicates the extrusion length

●     the Display corners check button, allows the 
visualization of manipulators at the curve extremities

All the parameters entered in this dialog box are retained 
when the box is closed.

3.  Click the manipulator on the curve and drag the 

pointer to extrude the surface in the given direction.

Capabilities are available from the contextual menu when 
right-clicking the manipulator.

When you press the Ctrl-key while dragging the pointer, you 
can perform a symmetry.
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The previewed extruded surface is dynamically displayed as 
you drag.

The segment number and the degree of the resulting surface 
are displayed:

●     a full line indicates the segment limit

●     a dashed line indicates the surface order

You can move back and forth between the compass and the surface to define the orientation after having 
extruded the surface, as long as you have not performed the final step.

4.  Click  OK to create the surface.

●     When the selected curve is not a 3D NUPBS (Non Uniform 
Polynomial B-Spline) curve, the Cv text is displayed. 
Right-click the Cv text and choose the Edit contextual 
menu to access the Converter Wizard allowing you to 
control the curve (order and segment number) on which 
the new surface is based.

●     Check the Furtive Display icon  to visualize the 

initial curve control points as you are extruding it.

●     You can select the edges of the surface to extrude either by: 
❍     clicking on them in the 3D geometry

❍     using the selection trap (all the edges will be selected)

❍     clicking the surface in the specification tree (all the edges will be selected)

●     Available capabilities from the Dashboard are: datum creation, auto detection (Snap On Vertex and 
Snap On Cpt options only), attenuation, and furtive display.
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Offsetting Surfaces

This task explains how to create an offset surface, based on an existing surface.

Open the Offset1.CATPart document.

1.  Select a surface, or a set of surfaces.

2.  Click the Offset icon .

The offset surface is automatically visualized as a meshed surface.

3.  Choose the options you wish from the Offset Surface dialog box:

●     the offset type: a simple offset creates a surface which points 

are all at the same distance from the initial surface, 

whereas a variable offset lets you set the offset distance at each 

corner point of the  surface.

●     the limits, that is constraints to be taken into account when 

computing the offset surface. You can specify whether it should 

comply with a given tolerance, 

or it should have a maximum order in U and V. The resulting 

surface will lie within these constraints.
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●     Display, that is the elements to be displayed on the geometry.

When you click the More... button: the type of information to be displayed on the offset surface before it actually is created. This information is useful to let 
you fine-tune the offset specifications. 

●     Offset values: the distance between any point of the initial surface and the resulting surface.

●     Normals: identifying the direction of the initial surface. Click on the arrow to invert the offset.

●     Order: the order value in U and V

●     Tolerance: the exact tolerance deviation

●     Corners: displays or hides the manipulators at the four corner points (only in Simple mode) to make Snap on Geometry possible. When you are in 
Variable mode, the Corners option is checked: if you pull the central manipulator, all manipulators are temporarily linked to each other, basically they 
have the same behavior as regular control points.

4.  By default the Edit dialog box is displayed. If not, right-click the offset 

value box on the surface to display it, and enter the offset value.

5.  Click Close to validate the offset value.

You can also move the pointer over one of the corner points, and directly pull on the displayed manipulators. 
The offset value is dynamically modified.
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6.  Click OK in the Offset Surface dialog box to create the offset surface.

You can also select a point either in the 3D or in the specification tree to impose the offset value.
The value will be set as well as the distance corresponding to the normal projection of the input point onto the surfaces.

If no projection is possible, no selection is possible and a message error is issued.

   
You can also create variable offset: 

 

a. Click Variable in the Offset Surface dialog box.

b. You can modify the delta in order.
This means that the maximum order number of the offset surface will not 
exceed the initial surface order number plus the indicated value. 

Offset values are displayed at each corner of the surface.
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c. Move the pointer over a corner point and drag it in the desired direction to 
dynamically modify the value.

d. Right-click another offset value and using the Edit dialog box, change this 
value.
Here we modified two values from 15 to 40.

e. Click OK in the Offset Surface dialog box.
The offset surface is created.

●     The same method applies when offsetting a set of surfaces. As all surfaces may not present the same orientation,
check the Normals option from the Offset Surface dialog box and right-click arrows: a contextual menu displays on each arrow and enables you to 
Reverse or Adjust all.
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●     If the offset is performed on a surface relimited using the break command, the result is a relimited surface, 
even though the pre-visualization presents the initial (not relimited surface):

 

●     If the offset value is superior to the maximum value, an error message is 
issued. Nevertheless, you can create the offset.

Multi-selection of surfaces is available.

Capabilities are available from: 
●     the contextual menu when right-clicking the manipulator

●     the Dashboard: datum creation, keep original, auto detection, attenuation, and furtive display.
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Extrapolating Surfaces

In this task you will learn how to extrapolate a surface, that is add an extra surface to the initial one while taking 
continuity constraints into account.

Open the Extend1.CATPart document.

1.  Select a surface boundary.

A manipulator is displayed.

2.  Click the Styling Extrapolate icon .

The Extrapolation dialog box is displayed. Two options are 
available:

●     Tangential: the surface is extended along the tangent to 
the surface on the selected boundary, and of a given 
distance (G1 continuity).

●     Curvature: the surface is extrapolated by the specified 
value, complying with the surface curvature  (G2 
continuity). No manipulator is displayed.

3.  Click  Tangential and pull on the manipulator till you 

reach 60 in the Length field of the Extrapolation 

dialog box.

The extrapolation is pre-visualized and dynamically 

evolves as you modify the extension length.

You could just as well enter the value directly in the 
Length field.

4.  Click OK.

The extrapolated surface is created.

Here are two views of the extrapolated surface, illustrating the tangency constraint on the selected edge.

128Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Similarly, if an edge is selected, and the Curvature option active, the surface is extrapolated according its initial 
curvature:

  

With Curvature option With Tangential option

●     To extrapolate a set of surface boundaries, you need to select these, using the Ctrl-key, before clicking the 

Extrapolate icon .

●     The curvilinear length between the middle of the selected original surface edge and the middle of the extended surface 
is displayed.

●     Whether in Tangential or Curvature mode, check the Exact option if you want to switch to the exact mode. The 
figures below show a surface extrapolated when Exact mode is checked and unchecked. 

❍     when the Exact option is checked, computation is analytical and the resulting surface presents the same degree as 
the initial surface. 
Since you chose this constraint, there may be no possible result in some cases.

❍     when the Exact option is not checked, the extrapolation is computed according to the geometric mode.

 

Exact mode not checked Exact mode checked

●     Using the Tangential option, capabilities are available from the contextual menu when right-clicking a control point.

●     Only the datum creation capability is available from the Dashboard.
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Creating Blend Surfaces

This task explains how to create a blend surface between two pre-existing surfaces.

Open the BlendSurface1.CATPart document.

1.  Click the FreeStyle Blend Surface icon .

The blend surface is 
previewed, and the 
Blend Surface dialog 
box is displayed.

Three modes are available to create blend surfaces: 
●     Analytic: when the selected surface edges are isoparametric curves, the blend surface is computed in exact mode, based on the selected surfaces' control points. 

Moreover, the blend surface presents a  point, tangency and curvature continuity with the initial surfaces.
When in analytic mode and Tangency continuity, depending on the geometry configuration, twisted surfaces may be generated. In this case, it is best to use the 
Proportional continuity, that allows the creation of the blended surface while taking the tangency continuity into account, then check the continuities if needed.

●     Approximated: regardless of the type of the selected surface edges, the blend surface is created according to an approximation between the initial surfaces.

●     Auto: the system optimizes the computation mode, trying first to create the blend surface in Analytic mode, then, if not possible, in Approximated mode.

When in P1 mode, only the Auto mode is available.

Information on the blend surface is displayed in the Blend Surface dialog box:

●     the blending type used (especially useful when working in Auto mode)

●     the number of patches making up the surface

●     the order of the blend surface along U and V
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2.  Move the 

pointer over 

one of the 

surfaces and 

click one of 

its edges.

You can 

select edges 

either from 

outside the 

surface (i.e. 

the arrow 

points 

towards the 

surface) or 

from within 

the surface 

(i.e. the 

pointer is 

over the 

surface when 

selecting the 

edge)

3.  Click the 

edge of the 

second 

surface.

 
The  tag informs you that there is only one surface to be selected.
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 In case the selected edge relies on more than one support, the  appears.

Please refer to Selecting a Support for further information.

The blend surface is previewed.

4.  Right-click a limit point and choose one of the options from the 

contextual menu. 

5.  From the Dashboard, click on the Continuity icon  and 

right-click onto the identifier to edit the continuity constraint on 

the boundary of the blend surface and the selected surfaces, 

using the contextual menu.

Change both continuities to Tangent. 

Available continuity types are: Point, Tangent, Proportional and Curvature. 
●     Point: . the surfaces share each point of their common boundary, i.e. there is no gap between the surfaces

●     Tangent: the surfaces share a common tangent plane (i.e. normal) at each point of their connection

●     Proportional: similarly to the Tangent option, surfaces share a common tangent plane  (i.e. normal) at each point of their connection, but the longitudinal 
variation from one point to the other is smoother, as the system automatically re-distributes the control point location on the blend surface
This mode is automatically set for both limits of the blend surface.

●     Curvature: the surfaces share a common curvature and tangent plane at each point of their connection

6.  Still from the dashboard, click the Tensions icon .

The tension values are displayed on the element along with a 

green segment representing the direction and limits of the 

blend surface tangent at its middle-points. You can modify 

the tension values by sliding the green triangle along the 

direction.
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7.  Right-click on the top boundary tension identifier and choose 

Invert direction.

 

●     In the case of an approximated blend type, you can modify the local 
tangent and curvature parameters.
You can modify the tangency between the free edges and the edges 
of the support surface by clicking either Tangent or Normal.

●     If you move the coupling points onto the edges of the support 
surface, only the normal direction is kept for the free edges of the 
blend

Tensions are now homogenized between blend surfaces and blend 
curves, so that the borders of a blend surface have the same shape as 
the blend curves, providing they are built on the same supports.

This homogenization is only possible with an approximated blend 
surface.
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8.  Invert the top tension to come back to the initial surface, click 

 to deactivate the tensions, and click the Contact Points 

icon .

Manipulators are displayed on the connection, allowing you to 
interactively define the blend limits by simply sliding them 
along the boundaries.

You can edit the contact points by right-clicking any of them to display the contextual menu and choosing the Edit item.
The Tuner dialog box opens to let you key in a new value, in percentage of the total boundary.

If you click on the Furtive Display 

icon  from the dashboard, control 

points of the created element are 

displayed.

9.  Click OK in the Blend Surface dialog box to create the blend surface.

It remains selected, thus allowing to immediately analyze its connection to the other surfaces, for example.

 The Project end points option allows linear projection of the smaller edge, if selected first, onto the other surface as shown to the left. To the right is the resulting 
blend without the Project end points option.

Should there be a twist between the two surfaces, the blend surface is not created. Modifying the continuity may enable the blend creation.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings,  are: datum creation, continuity, contact points, tensions, and furtive 
display.
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Creating an ACA Fillet

This task explains how to create an ACA fillet surface between two given surfaces.

Open the ACAFillet.CATPart document

1.  Click the Fillet icon .

The Fillet dialog box is 

displayed. 

2.  Select the two edges where you 

want to create the fillet.

Two vectors and the continuity 

symbol appears (G2).
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3.  Click Apply create the fillet.

 

4.  When you activate minimum 

radius, a new vector appears 

enabling you to change the 

minimum radius in the middle of 

the fillet.

Alternatively, you can change 

the value using the up and 

down arrows in the Minimum 

Radius .

 

 

The dialog box displays several options helping you to create the fillet:
●     Continuity : Quality of continuity between fillet and reference surfaces. (G0 - G2)

●     Segments/Order : Order of the fillet surface in direction of common edges 

●     Radius : Fillet radius 

●     Minimum Radius : Minimum radius in the middle of the fillet (optional)
❍     Relative : Minimum radius is relative the minimal variable radius

❍     True Minimum (only for G2) : Minimum radius is controlled. Trace curves will be computed in 
dependency of G2

●     Arc Type (only for G1) 
❍     Blend : Creates a blend surface between the traces

❍     Approx : Creates a circular bezier approximation

❍     Exact : Creates a rational surface with true circular sections

●     Parameter : Different options for parameterization of the result and fillet surface 
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❍     Default : Internal computed best filling parameterization

❍     Patch 1 : Parameterization is taken from the 1st patch

❍     Patch 2 : Parameterization is taken from the 2nd patch

❍     Average : Average of parameterization from patch 1 and patch 2 is taken

❍     Blend : Traces have parameterization of their correspondent surface

●     Edge Tolerance : Tolerance for common edge detection. If no common edge is detected, variable 
fillet is not possible

●     Options 
❍     Extrapolate - Fillet surface also on extrapolation of reference surfaces

❍     Trim - Face trimming of reference surfaces on fillet boundaries 

❍     Variable - Activates variable radius (only possible if edge tolerance is met) 

❍     Feature Modeling - Enables shape modifications of the fillet 

❍     Chordal Fillet (only for Variable off) - Instead of the radius, the chord length of the cross-
sections defines the fillet

For further information, please refer to the CATIA Automotive Class A documentation.
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Creating Filling Surfaces

In this task you will learn how to fill the space between three surfaces.

You can fill the space between three or more elements (up to nine). The elements can be either curves or any surface type element. 
These elements must be contiguous in only one point.

Open the Fill1.CATPart document.

 
1.  Click the Fill icon .

The Fill  Options dialog box is displayed allowing you to define the 
Deformation direction (P2 only).

This will let you deform the resulting filling surfaces according to 
the Compass Direction or Normal to the Surface Direction.

2.  Select the boundary of the first surface.

3.  Select the boundary of an adjacent surface.

4.  Select the boundary of all other surfaces, still going from 

one surface to its direct neighbor.

Once you have selected the last boundary contiguous to the first 
selected surface, the filling surfaces are created. 

If you checked the Continuities option from the Dashboard (P2) 
or the FreeStyle Settings, the corresponding information is 
displayed on the surfaces:

5.  Right-click the displayed text to edit the continuities. 

You can choose from Point or Tangent continuity, depending on the geometry configuration. Tangent continuity is available only 

when filling a closed contour.
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6.  Use the manipulators at the center point (P2 only) to 

deform the generated surfaces. The deformation depends 

on the chosen icon: Normal to the Surface Direction, or 

according to the Compass Direction.

While deforming, set continuities are retained.

Capabilities are available from the contextual menu when right-
clicking the manipulator.

The center point is not displayed if only one filling surface is created or when four filling surfaces are generated. 

7.  Click OK to create the filling surfaces.

●     You can use the graphic properties to modify the colors of the filling surfaces to better identify them. To this end, select each surface 
either in the geometry or in the specification tree, and call the Properties dialog box; Graphic tab, and modify the Fill color.

●     You can fill the space between different types of elements. For example, select a curve, two surfaces supporting a blend surface and 
the blend itself. In this case, the intersections between the selected edges on the surfaces and the blend limits are automatically 
detected, and the filling surface created accordingly.
Furthermore, only the Point continuity is available on the curve.

Similarly, you can fill three or more open-sided contours when composed of surface boundaries only. A temporary blend curve is created 
to close the contour when you click Apply, allowing the system to compute the filling surfaces.

You can also fill the space between two intersecting curves, or surfaces, forming an open angle. To do this, simply select these curves or 
surface boundaries, then click Apply in the Fill Option dialog box. The system automatically creates temporary curves matching the 
selected ones to close a contour before filling it.
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●     Make sure you select contiguous surface boundaries, especially when filling the space between more than three surfaces. Do not 
select boundaries randomly.

●     If four edges have been selected, a mono-patch surface is created. However, if three, five or more edges (up to nine) have been 
selected, as many surfaces are created as selected edges.

●     A gap between two selected boundaries, that exceeds the set tolerance (0.01 mm)  is identified for correction purposes. A text is 
displayed, indicating the gap value, and the fill cannot be performed.
If the gap is smaller than 0.01 mm, the fill is automatically performed complying with the tolerance all around the selected edges.

●     Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, temporary analysis, 
auto detection (Snap On Edge option only), attenuation, continuities and furtive display.
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Creating Associative Filling Surfaces

In this task you will learn how to fill the space between three or more surfaces.

You can fill the space between three or more elements (up to nine). The elements can be either curves 
(only one intersection between the curves is allowed) or any surface type element. These elements must 
be contiguous in only one point.

Open the Fill2.CATPart document.

 
1.  Click the FreeStyle Fill icon .

The Fill dialog box displays:

2.  Choose the Fill Type:

●     Analytic: one or more filling surfaces will be created, depending on the number of 

elements.

❍     If there are four elements, one surface will be created with supporting edges as borders

❍     If there are three, five or more elements, two cases can occur:

 1.  several surfaces (four-side surfaces) with a barycenter point will be created: there will 
be as many surfaces as there are continuity changes:
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 2.  one or n surface(s) (four-side surfaces) will be created if a continuous continuity 
between the elements is respected.

 
●     Power: one filling surface is created. All continuity types are available using the contextual menu

 

●     Auto: the best orders and number of patches will be chosen by the application depending on the 
inputs

 In our example, we chose the Auto type.  
 

3.  Select the boundary of the first surface.
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4.  Select the boundary of an adjacent surface.

Information on existing gaps between 

supporting edges is displayed in the 3D 

geometry.

The maximum gap value allowed is 

0.1mm.

5.  Select the boundary of all other surfaces, 

still going from one surface to its direct 

neighbor.

 
 Once you have selected the last boundary 

contiguous to the first selected surface, the filling 
surface is created. 

 If you checked the Continuities option from the 
Dashboard (P2) or the FreeStyle Settings, the 
corresponding information is displayed on the 
surface.

 

 

 The Information frame informs the user about the 
resulting fill: type, number of patches, and the U/V 
order.
Here the most appropriate type for this fill is the 
Analytic type.
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6.  Check the Furtive Display option from the 

Dashboard (P2) to display the control 

points and visualize the number of orders.

7.  Click More>> to display further options:
 

 
●     Limits, that is constraints to be taken into 

account when computing the fill surface. You 
can specify whether it should comply with a 
given tolerance, or it should have a maximum 
order in U and V. The resulting surface will lie 
within these constraints.

❍     U/V Orders: number of control points by 
patch
The minimum orders 2 / 2 for all fill types

❍     U/V Patches

❍     Tolerance: the maximum tolerance is 0.1. 
The smaller the tolerance is, the more 
precise the created fill surface is.

The Maximum Tolerance and Order are defined in 
Tools -> Options -> Shape -> FreeStyle.
Please refer to the Customizing section.

 If you create a fill then you decrease the order 
value in Tools -> Options -> Shape -> 
FreeStyle, the created fill will keep the former 
value. Nevertheless, if you edit the fill and 
decrease its order value directly in the Fill the 
dialog box, the new order value will be set as the 
maximum value, until it reaches the value defined 
in Tools -> Options -> Shape -> FreeStyle.
However, if you create a new fill, the maximum 
order value will be the one defined in Tools -> 
Options -> Shape -> FreeStyle.
The tolerance value is comprised between 0.001 
mm and 0.1 mm. May you define a higher value, 
the maximum value would still be 0.1 mm.
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Options in the Limits frame are grayed in the case of an Analytic type with three, five, or more input 

elements.

 
8.  Right-click the displayed text to edit and 

modify the continuities. 

You can choose from Point, Tangent or 

Curvature continuity, depending on the 

geometry configuration. Tangent continuity 

is available only when filling a closed 

contour.

 
9.  Click OK to create the filling surfaces.

The Constraint option you to define the 
Deformation direction (P2 only). This will let you 
deform the resulting filling surfaces according to 
the Compass Direction or Normal to the 
Surface Direction.
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Use the manipulators at the center point (the 

barycenter point) to deform the generated 

surfaces. The deformation depends on the chosen 

icon: Normal to the Surface Direction, or 

according to the Compass Direction.

While deforming, set continuities are retained.

Capabilities are available from the contextual menu 
when right-clicking the manipulator.
The deformation direction after fill creation is 
managed by the center point frame and the point 
translator into 3D model. This point translator can 
be moved along a normal to resulting fill or on one 
of the compass direction. It has also the possibility 
to snap on any particular point.

The Constraint option is only available with the 
Analytic type.

●     In case the selected surface lies on more than one support, the  appears.

Please refer to Selecting a Support for further information.

●     Please refer to the Creating Filling Surfaces chapter to have further information on the deformation 
direction.

●     Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum 
creation, temporary analysis, auto detection (Snap On Edge option only), attenuation, continuities and 
furtive display.
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Manipulating Surfaces Using the Compass

This task explains how to move and translate surfaces independently from any other element in the document 
using the compass.

Open the Manipulate1.CATPart document.

1.  Click the Select icon  and select the surface you wish to move.

2.  Point to the compass manipulation handle (the red square located on the privileged plane at the base of 

the compass). 

The cursor shape changes to a cross.

3.  Drag and drop the compass over 

the surface you wish to move 

about.

The compass now is displayed in 

green.

Make sure you choose to display the bounding box using the Display manipulation bounding box option from 
the Tools -> Options -> General -> Display dialog box, Navigation tab to display the whole bounding box 
as shown below, not just the compass over the geometry.

4.  Move the pointer over any bounding box boundary, and drag the surface where you wish to move it.

5.  Pull along a horizontal axis to slide the surface to the right or to the left.
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6.  Similarly you can pull along a vertical axis to move the surface up or down.

The displacement distance is displayed as you move the surface around.

7.  Release the mouse-key.

The surface has moved to a new location.

For further details and general manipulation tasks refer to the Infrastructure User's Guide: Manipulating 
Viewpoints Using the Mouse and Compass and Manipulating Objects Using the Mouse and Compass.
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Rotating a Surface Using the Compass

This task explains how to rotate surfaces independently from any other element in the document, using 
the compass.

Open the Manipulate1.CATPart document.

1.  Select the surface you wish to move.

2.  Point to the compass manipulation handle (the red square located on the privileged plane at the 

base of the compass). 

The cursor shape changes to a cross.

3.  Drag and drop the compass over the surface 

you wish to rotate.

The compass now is displayed in green.

If you checked the option Display 
manipulation bounding box in the 
Navigation tab via the Tools -> Options -
> General -> Display menu item, a box 
will appear around the selected surface.

4.  Move the pointer over the arc of circle on the 

compass indicating the direction in   which you 

want to rotate the surface.

The arc of circle is highlighted.
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5.  Drag in the desired direction.

The surface rotates within the plane indicated 

by the selected arc of circle.

6.  Release the mouse-key. 

The surface is set to the new direction.

●     The surface has rotated about an axis. However, this has not changed anything to any other element 
present in the document.

●     Multi-selection, whether using a trap or the Ctrl-click, is available to rotate a set of elements.
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Matching Surfaces
In this task you will learn how to match two surfaces, or a surface to a curve, that is extend one surface 
to come up to the other element, specifying the continuity between the two elements.

Some options are only available in FreeStyle Optimizer.

Open the MatchSurface1.CATPart document.

1.  Click the Match Surface icon .

2.  Select the edge of the surface to be 

matched.

The boundary is highlighted. 

3.  Move the pointer onto the second surface.

Possible boundaries for the match are highlighted 
as you move the pointer along.

4.  Click the surface when the adequate 

boundary is highlighted.

The match is automatically applied. The first surface is recomputed so as to be connected to the second 
surface.
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The Match Surface dialog box is displayed:

In P1 mode, only the Diffusion option is available.

5.  Define the matching type, that is 

computation mode,  using the list:

●     Analytic: available only when the selected 
curve is an isoparametric curve. The match is 
computed based on a mathematical formula 
leading to an exact location of each of the 
selected curve's control point.
Furthermore, if both selected curves present 
the same number of control points, the 
deviation is null. 

●     Approximated: regardless of the type of the 
selected surface edges, the match is based on 
the discretization of the selected elements, 
and is approximated accordingly.

●     Auto: the system optimizes the computation mode, trying first to create the match surface in 
Analytic mode, then, if not possible, in Approximated mode.

When in P1 mode, only the Auto mode is available.
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Information on the match surface is displayed in the Match Surface dialog box:
●     the number of patches making up the surface

●     the order of the surface to be matched

●     the matching type used (especially useful when working in Auto mode)

●     the delta from the initial surface.

6.  From the Dashboard, click the Contact 

Points icon .

Manipulators are displayed on the connection, 
allowing you to interactively define the match 
limits by simply sliding them along the target 
curve.

You can edit the contact points by right-clicking 
to display the contextual menu and choosing the 
Edit item.

You can also use the Snap on Geometry option.
Capabilities are available from the contextual 
menu when right-clicking a contact point.

7.  Still from the Dashboard, click on the 

Continuity icon  and right-click onto 

the identifier to edit the continuity 

constraint on the boundary of the match 

surface on the target element, using the 

contextual menu.

In the example, we impose a tangency 
constraint on the target surface. We 
keep a point continuity on the initial 
surface.
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Available continuity types are: point, tangent, curvature, proportional and free. 
●     Point: the surfaces share each point of their common boundary, i.e. there is no gap between the 

surfaces.

●     Tangent: the surfaces share a common tangent plane (i.e. normal) at each point of their connection

●     Curvature: the surfaces share a common curvature and tangent plane at each point of their 
connection

●     Proportional: similarly to the Tangent option, surfaces share a common tangent plane  (i.e. normal) 
at each point of their connection, but the longitudinal variation from one point to the other is 
smoother, as the system automatically re-distributes the control point location on the matched 
surface.
This mode is automatically set for both limits of the matched surface.

●     free: no constraint is imposed on the curve's control points.

If a continuity type leads to some inconsistencies, a message is displayed on the surface, so that you can 
modify the continuity type: 

8.  Still from the Dashboard, click the 

Tensions icon  (P2 only).

The tension values are displayed on 
the element along with a green 
segment representing the direction and 
limits of the match surface tangent at 
its middle-points. You can modify the 
tension values by sliding them along 
the direction. 

Default tensions and tangents are 
indicated by the Init string.

 
You can right-click the tension value to 
enter a new value within the 0 to 1 
range, using the Tension Tuner dialog 
box.
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Local tangents (identified by the green 
arrows) are displayed as well enabling 
you to modify their angle and local 
tension. 

1.  Right-click the local tangent to 
choose from:

●     a specific value you key 
in (User), in this case 
you can modify the value 
by right-clicking it

●     the first surface tangent 
(Initial)

●     the target element 
tangent (Target).

 
2.  You can also choose the Edit 

angle contextual menu to 
display the Angle Tuner dialog 
box, allowing you to specify a 
given angle.

9.  Click on More to display further options:

10.  Check the Quick connect checker and 

orders option: depending on the type of 

continuity connection, three values can be 

displayed:

a.  the distance (mm): the 

maximum distance between the 

two elements

b.  the  angle (degrees) between 

the tangents to the surfaces

c.  the surface order for each 

surface

d.  the curvature (%): that is the 
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ratio between both surface 

curvatures

11.  Check the Control Points option to 

display the control points and mesh lines 

on the surface, allowing you to 

dynamically modify them. Click Run to 

recompute the match surface.

See Editing Surfaces Using Control 

Points to find more about available 

options. 

When a modification is not consistent with 
constraints previously set, as the choice of 
continuity for example, a message is displayed on 
the geometry. You then have the choice not to 
perform the modification, or to modify the 
constraint in order to edit freely the control 
points.

When checked, the Diffusion option, propagates evenly any modification performed using the control 
points.

12.  Click OK in the Match Options dialog box.

 If you select a frozen surface (a surface with an history) or a non-Nurbs surface as input, a dialog box is 
issued warning you that an automatic conversion will be automatically performed before the matching 
operation:
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 - if an exact conversion is possible, a new Nurbs surface will replace the input one in order to 
perform the match. This new surface will be added in the specification tree.

- if there is a deviation or no exact conversion exists, the Converter Wizard panel appears 
allowing you to define the approximation according to a tolerance using parameters such as U, 
V orders, patch numbers, and deviation tolerance.

The match operation does not modify the input 
surface, except if you modify its order:

 

1.  From the Dashboard, click the U, V 

Orders icon . 

Numbers indicate the order number of the 

element along the U and V directions.

2.  Right-click a tag number and choose 

Automatic from the contextual menu to 

modify the order and the segmentation of 

the matching surface and reach the 

desired continuity constraint.

The Keep original option enables you to work on a copy of the input surface. 

●     The Project end points option allows linear projection of the smaller edge, if selected first, onto the 
smaller surface as shown to the left. To the right is the resulting match without the Project end 
points option:
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●     The Project boundary option allows to 
directly project the first selected boundary 
onto the second surface, by selection of the 
surface only. (You do not need to select a 
boundary on the target surface.)

●     The Move on main axis option constrains the matched surface so that its control points can only be 
moved along the compass' main axis.

 

 
Unchecked Move on main axis option Checked Move on main axis option 

The Move on main axis option is only available with FreeStyle Optimizer.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum 
creation, keep original, auto detection, attenuation,  continuity, contact points, tensions, and furtive 
display.
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Multi-Side Matching 

 

In this task you will learn how to match a mono-cell non relimited surface to at least two, and at most 
four,  other surfaces. The source surface's edges will be deformed to match the target curves on 
surfaces, taking continuities into account.

Some options are only available in FreeStyle Optimizer.

Open the MatchSurface2.CATPart document.

1.  Click the Multi-Side Match Surface icon 

.

The Multi-side Match dialog box is displayed. 

2.  Set the deformation options:

●     Diffuse deformation:  if checked, the 

deformation is spread over the whole matched 

surface, not only to a limited number of control 

points.

●     Optimize continuities: if checked, the 

deformation is done optimizing the user-defined 

continuities rather than according to the control 

points and mesh lines.
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3.  Select the first edge of the surface to be 

matched.

It is automatically detected as you move the 

pointer then highlighted once selected.

4.  Select the target curve for the first selected 

edge.

An arrow is displayed indicating which source 

edge is to be matched to which target curve.

Note that in case an incorrect edge is 

detected, a contextual message helps you 

select the adequate target curve. 

5.  Click the Continuity icon from the dashboard, to visualize texts on the geometry.

Then right-click the texts to modify the continuity type (point, tangency, curvature) or to 

increase/decrease the edge order.

6.  Continue selecting pairs of source and target 

curves to be matched, as needed.

7.  Click Apply to visualize the matched surface.

If you already selected four source edges 
and four curves, the match is automatically 
computed.
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8.  Click OK to create the multi-side match surface.

●     All source edges must belong to the same surface.

●     Only a complete surface, i.e. that has not been previously relimited, can be matched.

●     Target curves necessary are surface boundaries or isoparametric curves, therefore laying on a 
surface. They cannot be curves created in space.

●     Checking the U, V Orders  icon from the Dashboard, displays texts indicating the resulting 

surface order along U and V.
Right-click these texts to choose a new order value.

●     A surface can also be matched onto a relimited surface.

●     The match takes into account continuities and order, but also existing geometric configurations. 
For example, in the example below, the two target surface overlap. In this case, the system 
automatically relimits the matched surface where the target surfaces overlap:

Available capabilities from the Dashboard are: datum creation, auto detection (Snap On Edge option 
only),  continuity, and furtive display (control points are displayed on both the surface to be matched and 
the target surfaces).
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Extending Surfaces

In this task you will learn how to extend a surface, that is make it bigger or smaller depending on which side of the manipulator you 
pull.

Open the Extend1.CATPart document.

1.  Select a surface boundary.

A manipulator is displayed.

2.  Click the Extend icon .

 The Extend dialog box is displayed. 

Two working modes are available:

 

1.  With the Keep segmentation option checked: the surface is 
extended according to its initial parameterization.

2.  With the Keep segmentation option unchecked: the surface is 
extended taking the curvature continuity into account. This 
means that segments are added to the initial surface.
In this mode, you can hold the Ctrl key down and move the 
manipulator to generate a symmetric extension.

Checking the Preview button, you can preview the modification by a mesh, and display the surface order as well as the number of 
segments along both U and V directions.

The extended length value is also displayed when moving the manipulator.
The surface is then updated when you release the mouse. The extended length value remains.
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3.  Click OK.

The extended surface is created.

●     You can also define a step value to extend the surface:

1.  When the manipulators are displayed, right-click one of 
them and choose the Edit contextual menu.

The Tuner dialog box is displayed, in which you can 
key the extension step value.

2.  Move the pointer back over the manipulator, and 
pressing and holding the Shift key, click the 
manipulator.

The surface is extended by the set step value and the length 
value is displayed.

Depending on the manipulator's arrow that is clicked and the 
keyed in value (negative values are allowed) the surface is 
extended in one direction or the other. Note however that 
when the Keep Segmentation mode is unchecked, the 
surface can only be extended and not shortened.

The Keep this point capability is also available from the contextual menu.

Capability are available from the Dashboard: datum creation and keep original.
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Smoothing Surfaces

In this task you will learn how to smooth a surface.

Open the Smooth1.CATPart document.

1.  Select the surface to be smoothed.

2.  Click the Control Points icon .

Control points are displayed on the surface, and the 
Control Points dialog box appears.

 

3.  Define the smooth weight, and click Run.

The surface is smoothed according to the value. 

4.  Click again to repeat the smoothing operation if 

needed.

 

 

5.  Once you are satisfied with the smoothed surface obtained, click OK in the Control Points dialog 

box.

You do not need to select the whole surface. You can choose at which point, or mesh line, the surface 
should be smoothed. Simply use the multi-selection capabilities: 

●     Press and hold down the Shift-key and click a first point. Still maintaining the Shift key down, click 
another point of the curve. All points selected between the two selected points are selected as well, 
and the surface is smoothed in this area only.

●     Click a first point, press and hold down the Ctrl-key, then move on to the other points to be selected. 
Only the explicitly selected points are highlighted, and smoothing is performed on these points only.

Capabilities are available: 
●     from the contextual menu when right-clicking a control point

●     from the Dashboard are: datum creation, auto detection, and attenuation.
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Redefining Surfaces Limits

This task shows how to redefine the limits of one or more surfaces by splitting it along one or more curves.

Open the Break1.CATPart document.
 

1.  Click the Break icon .

The FreeStyle Break dialog box is 

displayed as well as the Break Report 

panel and the Tools Palette.

2.  Choose the Break type by clicking on the 

icons on the left.

Three types are available:

●     Curves by points

●     Curves by curves

●     Surfaces by curves (as in our scenario)

 

In the Selection page, the Cut (0) text is 

highlighted.

3.  Select the surface(s) to be cut. 
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4.  Click the Cutting (0) text and select the 

cutting curve(s).

 

 
5.  Click Apply.

By default, all elements are kept.  

The Break Report panel displays all the information 

regarding the cutting elements. It lists:

●     the cutting elements that can be used for the 

Break (marked by a green tip). If you click on the 

text, the corresponding curve is highlighted in 

green in the 3D geometry.

●     the cutting elements that cannot be used for the 

Break (marked by the condition to be applied so 

that they can be used: projection, extrapolation, 

etc). If you click on the text, the corresponding 

curve is highlighted in red in the 3D geometry.

❍     In case of an extrapolation problem, the side 

of the curve to be extrapolated is circled in 

red.

❍     If there is no selection of cutting elements, an 

error message is issued and the Break Report 

panel informs you that no element is 

selected.

❍     If a red cross is displayed, it means that the 

problem cannot be managed by the system.
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This panel can also be opened via the Display tab.

 

6.  Click the parts of the surface that you do not 

want to keep.

A contextual menu is available on the each part of 
the surface.

●     Keep all: all parts of the surface are kept

●     Keep all but this: all parts of the surface are 

kept except the selected one

●     Remove all but this: all parts of the surface are 

removed except the selected one

   
 

7.  Click the <<Settings text to access 

advanced settings.
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●     no projection: click the Projection text to make 

the projection optional.

As a consequence, the points that do not lie on 

the trimmed curves will not be projected onto the 

surface.

 If certain curves do not lie on the surface, they are projected (pseudo-intersections) onto it according to the direction 
set in the Break dialog box:

 

●     Compass: click the compass icon so that the 

projection is normal to the compass

 

●     Normal: click the normal icon so that the 

projection is normal to the element

   
 

Relimitation  

 
●     Shorten mesh: curves are not relimited and 

their limits are redefined. New curves are 

created. 

 
Projection  
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●     The maximum degree variation allowed for each 

patch of the new surface as compared to patches 

of the initial surface can be modified. Click the U 

Order and the V Order text to edit and modify 

the values (besides is an example with U and V 

values set to 8)

The U and V order maximum values are set with 

the Max Order option of the FreeStyle settings.

●     Only 4 edge-patches are created.

 
●     Keep mesh: curves are relimited and the control 

points of each initial surface is kept.

   

Extrapolation  

 
Click the Extrapolation icon  if you want the 

automatic tangency extrapolation of the cutting 

curves to be optional.

As a consequence, one edge is added.

The control points of each initial surface is kept.
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8.  Click OK to create the break surface.

     
●     Click the Display>> text to manage the display of the 3D icons and the Break Report panel.

●     Available capabilities from the Dashboard are: datum creation, keep original, insert in a new geometrical set, and 
temporary analysis.

 

 

170Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Restoring a Surface

In this task you will learn how to restore the limits of a surface or a curve when it has been split using 

the Break Surface or Curve   icon (see Splitting Geometry for the Generative Shape Design 

workbench).

Open the Untrim1.CATPart document.

1.  Click the Untrim icon 

 in the 

Operations toolbar.

The Untrim dialog 

box is displayed. 

2.  Select the surface 

which limits should be 

restored.

The dialog box is 

updated 

accordingly. 

3.  Click OK in the dialog box.
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A progression bar is displayed, 
while the surface is restored.
It automatically disappears 
once the operation is complete 
(progression at 100%).  

The initial surface is 
automatically 
restored.

 
The restored surface or curve is identified as Surface Untrim.xxx or Curve Untrim.xxx.

You can perform a local untrim 
on faces. Three modes of 
selection are available:

●     selection of the face: the 
initial surface is restored
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●     selection of an inner loop: 
only this loop is restored

●     selection of the outer loop: 
only this loop is restored

●     If the surface has been trimmed several times, it is the initial surface which is restored. To partially 
untrim the surface, you need to use the Undo command right after the trim.

●     If the surface to be restored is closed (in the case of a cylinder) or infinite (in the case of an extrude), 
the limits of the untrim feature will be the bounding boxes of the initial surface. Therefore, the initial 
surface and the untrim surface may be identical.

●     You can individually select a vertex or a boundary from the restored surface or curve.

●     Multi-selection is available and allows to create several untrim features in one step. All untrim 
features will appear in the specification tree.

●     The datum creation capability is available from the Dashboard.
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Concatenating Surfaces

This task explains how to concatenate a two-cell mono-domain FreeStyle surface or two separate 
contiguous surfaces into a mono-cell surface.
The resulting surface is a curvature continuous surface (C2).

Open the Concatenate2.CATPart document.
This document contains a set of connex surfaces.

1.  Click the Concatenate icon .

The Concatenate dialog box is 

displayed.

2.  Set the tolerance value.

This value defines the maximum parametric deviation allowed between the selected elements 
and the resulting curve when concatenating. 

The Maximum deviation value displayed in the dialog box (see step 5) is computed as the 
standard distance analysis and therefore is not necessarily the minimum tolerance value to be 
set in order to concatenate the curves.

3.  Select the surfaces you wish to 

concatenate and click Apply.

A single surface is previewed, with its segment limits in both U and V, provided the tolerance is 
compatible. If not, a message is issued prompting you to increase the tolerance value. 

The minimum tolerance value necessary to obtain a result displays as well.
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4.  Change the tolerance value so that it is compatible to create a single surface.

5.  Click More>> in the dialog box.

6.  Check the Information option.

The corresponding information is 

displayed on the resulting surface, that 

is:

●     Nu/Nv: number of control points 

in U and V

●     o: the curve order

●     s: the number of segments in the 

curve

●     the maximum deviation

In case you did not check the Information 

button, the maximum deviation is also 

displayed in the dialog box. 

7.  Check the Auto Update Tolerance button to automatically update the tolerance value in case 

the value you set is too low.

A minimum result to enable the concatenation is displayed and the concatenation is performed.
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No message is issued prompting you to increase the tolerance value as the minimum value is set 
automatically.

8.  Click OK in the Concatenate dialog box.

A surface is created, the result of the concatenation of the initially selected elements  (we 

changed its color to blue for easier identification). This surface is C2 continuous.

●     Only two cells, whether in the same element (join for example) or in separate elements (two different 
cells) can be concatenated at a time. To concatenate more, you need to concatenate the first two 
cells, then the resulting concatenated surface with another cell, and so forth.

●     If the selected surfaces are not connex (if there is an important gap between the two surfaces) the 
Apply button is grayed, and you cannot create the concatenated surface.

●     If the selected elements present a curvature discontinuity you will need to increase the tolerance 
value accordingly.
In this case too, the maximum deviation will increase considerably.

Available capabilities from the Dashboard are: datum creation, keep original, and furtive display.
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Fragmenting Surfaces

In this task you will learn how to fragment multi-segment bodies into mono-segment  bodies.

Open the FragmentSurface1.CATPart document.

1.  Select the surface.

2.  Click the Fragmentation  icon   

in the Shape Modification toolbar.

The selected surface shows the 
limits of each segment in solid 
lines, allowing the pre-visualization 
of the resulting surfaces.

 
The Fragmentation dialog box is 
displayed.

3.  Choose the breaking options:

You can decide to break the surface 

along U, along V or in both U and V 

directions. 

 

4.  Click the Keep original icon  from the Dashboard if you want to keep the initial surface 

when fragmenting the body.
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5.  Click OK.

The surface is fragmented in as many 
surfaces as there were segments in the initial 
surface. This means that  independent 
surfaces are created.

In the example, we assigned a different color 
to each of the resulting mono-segment 
surfaces.

●     Multi-selection is available.

●     This function enables you to fragment curves as well (see Fragmenting Curves).

Available capabilities from the Dashboard are: datum creation, keep original.
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Disassembling Elements

In this task you will learn how to disassemble multi-cell bodies into mono-cell, or mono-domain bodies, 
whether curves or surfaces.

Open the Disassembling1.CATPart document, or any document containing a multi-cell body.

1.  Select the element to be disassembled.

You can select only an edge of a surface, the system 

recognizes the whole element to be disassembled.

Here we selected the join made of three elements, 

each made of several cells.

2.  Click the Disassemble icon   in the Shape 

Modification toolbar.

The Disassemble dialog box is displayed. 
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3.  Choose the disassembling mode:

●     All Cells: all cells are disassembled, i.e. for all the selected 

element, a separate curve is created for each cell.

●     Domains Only: elements are partially disassembled, i.e. 

each element is kept as a whole if its cells are connex, but 

is not decomposed in separate cells. A resulting element 

can be made of several cells.

The number of selected elements, and the number of elements to be created according to the 
disassembling mode are displayed within the Disassemble dialog box.

In the illustrations, we have colored the resulting curves for better identification.

Results when disassembling all cells
(seven curves are created)

Results when disassembling domains only
(three curves are created)

If you wish to create the disassembled elements in a new geometrical set instead of the current 

geometrical set, click the Insert In a New Geometrical Set  icon from the FreeStyle Dashboard.  

4.  Click OK in the dialog box.

In case of a multi-selection, a progression bar appears, displaying the name of the element 
being disassembled. 
It automatically disappears once the operation is complete (progression at 100%). 
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The selected element is disassembled, that is to say independent elements are created, that can be 
manipulated independently.

Multi-selection is available.

Capabilities available from the FreeStyle Dashboard are datum creation and insert in a new geometrical 
set.
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Approximating/Segmenting Procedural Surfaces

In this task you will learn how to convert any surface, created using other products but FreeStyle, into a 
NUPBS (Non Uniform Polynomial B-Spline) surface, and to modify the number of patches (segments) 
onto any surface, including these created using FreeStyle products. 

This approximation is automatically performed when you try to edit a surface using control points. In this 
case:

●     when an exact conversion can be performed, it is done automatically, and the Converter Wizard is not 
displayed.

●     when the exact conversion cannot be performed, the converter Wizard is displayed allowing you to 
define the approximation tolerance.

Open the Approximate1.CATPart document.

 
1.  Select the surface to be 

approximated or segmented.

2.  Click the Converter Wizard icon 

.

The Converter Wizard dialog 

box is displayed allowing you to 

define the approximation 

according to a tolerance.

You need to set the values for 

the different options:

 
●     Tolerance: that is the deviation tolerance from the initial surface. 

On the geometry, a red text is displayed if the tolerance is not respected, that changes to green when 
the new element is within the specified tolerance.

●     Order: that is the maximum allowed order along the U and V directions for each surface patch.
This value must be greater than or equal to 2, in a given direction, when the segmentation options 
are grayed. Otherwise, it must be greater than or equal to 4.
The maximum value allowed per patch is defined by the Max order field in the FreeStyle Settings and 
must be less than or equal to 16.

In P1 mode, the Max order is set to 16 and cannot be modified.
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●     Segmentation:  that is the maximum allowed segments along the U and V directions.

If Single is checked, a mono-segment surface is created.

When one of these options is inactive, the system automatically optimizes this option's  parameters to 
comply with the other options' values.

On the selected surfaces, segments are 
delimited by the solid lines.

Depending on the type of the initial element, a text is displayed indicating what approximation needs to 
be performed:

●     CV: the initial surface is not a NUPBS and needs to be approximated using the Converter Wizard 
parameters

●     EXACT: the initial surface can be converted in exact mode (no parameter needs to be set)

●     Seg: the initial surface already is a NUPBS

Provided the Continuity icon  is active from the Dashboard, and at least one conversion option is 

active (Tolerance, Orders, or Segmentation, a continuity constraint can be imposed identically on the 

selected surfaces.

●     Continuities constraints are applied on the bounding box UV of each cell. Therefore, boundaries are 

isoparametrics to the selected surfaces.

●     One type of continuity can be imposed for each cell of an element; in case of multi-cell elements, 

every cell has the same continuity constraint.

●     Use the contextual menu to select another continuity (point, tangent, or curvature continuity) or click 

the text in the geometry to display the others sequentially.
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If the continuity is certain to be respected 
(if the order value is sufficient and there is 
no segmentation constraint), the 
continuity tags are displayed in green.

If the continuity constraint may be not 

respected, a warning is issued and the 

continuity tags are displayed with the 

update needed color (here in red) defined 

in Tools -> Options -> Visualization.

Note that this warning is displayed for 

information purpose and does not check 

whether the continuity will be respected or 

not.

 

3.  Click  More>> to display more 

options :
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●     Check the Information option to 
display further information on the 
element: 

❍     Max: the maximum deviation in 
relation to the initial element

❍     Nu/Nv: number of control points 
in U and V

❍     o: the surface order

❍     s: the number of segments in the 
surface 

●     Check the Control Points option to 
display the surface's control points.

 
●     Check the Auto apply button to dynamically update the resulting surface. 

4.  Click OK.

The surface modification is taken into account.

●     Surface multi-selection is available. 

●     You can mix the approximation of curves and surfaces.

●     The 3D conversion and 2D icons are grayed as they are useful only for curve conversion.

●     The Priority check button indicates which of the Orders or Segmentation parameter is taking 
precedence over the other one. 

●     Use the Exact conversion mode (no parameter needs to be set) on a NUPBS element to display the 
number of control points, curve order, and number of segments in the curve.
Note that in this case, the initial element is duplicated.

Available capabilities from the Dashboard are: datum creation, keep original (depending on the selected 
element), continuities, and furtive display.

 

 

185Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Copying Geometric Parameters

This task shows you how to copy the geometric parameters of a curve on one or several curves.

Open the CopyParameters1.CATPart document.

 Make sure the furtive display is active from the 
FreeStyle Dashboard.

 

1.  Click the Copy Geometric Parameters 

icon .

The Copy Geometric Parameters 

dialog box displays.

 

 

2.  Select the curve that will be used as the 

template curve.

Control points and segmentation 
parameters display on the curve.

     

 

3.  Select one or more target curves.

Control points and segmentation 

parameters also display: you can see 

that they are different from those of 

the target curve.
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4.  Click Apply to copy the parameters of 
the template curve on the target curves.

 

 

The Copy Geometric Parameters dialog box 
updates:

For the template curve, it shows:

●     Degree by arc: number of control points

●     Arcs number: number of segments

For the target curves, it shows:

●     Input elements: number of selected 
elements

●     Valid curves: number of curves taken into 
account

 

 
5.  Click OK.

While in the command, you can change the template curve still keeping the selected target curves: simply 
click the Template Curve area in the Copy Geometric Parameters dialog box, select the curve, and click 
Apply to copy the parameters.

Only datum and 3D datum curves can be used. 

Capabilities available from the FreeStyle Dashboard are insert in a new geometrical set and furtive 
display.
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Creating a Continuity Constraint

This task shows you how to create a FreeStyle continuity constraint, that is to connect two or more surfaces or 
curves and apply a constraint.

Open the Constraint1.CATPart document.

Make sure the Constraints option is checked in Tools -> Options -> Infrastructure -> Part Infrastructure 

-> Display tab, so that you are able to see the constraints in the specification tree.

1.  Click the Continuity 

Constraint icon .

The Continuity 

constraint dialog box 

displays.

2.  Select the edge of the 

surface to be matched.

The boundary is 
highlighted. 

 

3.  Move the pointer onto the 

second surface.

4.  Click the surface when the 

adequate boundary is 

highlighted.

5.  Perform this operation 

onto several surfaces.
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6.  Right-click the continuity 

type to display the 

contextual menu: you are 

able to modify the chosen 

type.

 
Two options are available from the dialog box. May you want to use them, you need to select them before 
selecting the surfaces or curves.

●     Diffusion: the Diffusion option propagates evenly any modification performed using the control points

●     Project end points: The Project end points option allows linear projection of the smaller edge, if selected 
first, onto the smaller surface.
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7.  Click the green arrow to reverse the direction of the constraint and modify the continuity.

8.  Click the text in the geometry to modify the constraint sequentially or use the contextual menu and 

select the constraint.

The continuity constraint feature appears in the specification tree, under the Constraints node.

9.  Check the Control Points option to display the control points and mesh lines on the surface, allowing 

you to dynamically modify them. 

See Editing Surfaces Using Control Points to find more about available options.

The source surface deforms so that the neighbouring constraints are automatically updated..

●     You can create as many constraints as there are elements.

●     You can deactivate the constraints using the Deactivate contextual menu.

●     Constraints created using this command are very similar to the constraints created in the Part Design and 
the Sketcher workbenches: they are compatible and are solved using a variational approach.

1.  In Part Design, 
select a vertex 
and a point, 
click the 
Constraints 
defined in a 
dialog box 

 icon and 

set a Distance 
constraint. 
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2.  Back in 
FreeStyle, using 
the Quick 
Compass 
Orientation 
toolbar, click 
the In Model 
or on Perch 

icon  to 

switch the 
compass from 
the perch to the 
selected 
surface.

3.  Use the 
compass to 
move the 
surface.

All the constraints are updated accordingly.

If you wish to delete a constraint, you need to delete it in the specification tree, under the Constraints node.

Refer to the Constraints chapter in the Part Design documentation and to the Setting Constraints chapter in the 
Sketcher documentation to have further information.

Constraints can only be set on datum elements.
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Analyzing Curves and Surfaces
This chapter deals with curve and surface analysis. Within the FreeStyle Shaper, analyses are elements that need to be explicitly deleted if you do not wish to keep them.

The FreeStyle Dashboard tools do not affect the analyses.

Most analyses are permanent in P2 mode only, i.e. they are retained in the specification tree for later edition and on the geometry till you reset or delete them, whereas in P1 mode, 
they are present at a time, but not retained when exiting the command.

 
Check connections between surfaces: select two surfaces, specify the type of analysis (distance, tangency, curvature) and set the analysis parameters.

 Check connections between curves: select two curves, specify the type of analysis (distance, tangency, curvature) and set the analysis parameters.

 Analyze the distance between two sets of elements: select a surface and a target element, specify the analysis mode, type, and display parameters.

 Use dynamic cutting planes: select a surface, specify the cutting planes orientation, numbers, spacing, etc. 

Analyze using highlight lines: select a surface, and specify the highlight type.

Perform a curvature analysis: select a curve or surface boundary, specify the curvature comb parameters (spikes number and length, orientation, etc.). 

 Perform a surfacic curvature analysis: select a surface and specify the display parameters.

 Perform a draft analysis: select a surface and specify the display parameters.

 Map an environment on a surface: choose the mapping to be reflected onto every element.

 Analyze using isophotes: specify the isophotes number, thickness, color, and position.

 Analyze using highlights: click the ACA Highlight icon and define stripes or grid lines density, thickness and sharpness.
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Checking Connections Between Surfaces

This task shows how to analyze how two surfaces are connected, following a blend, match, or fill 
operation for example.
Three types of analyses are available.

❍     Distance: the values are expressed in millimeters

❍     Tangency: the values are expressed in degrees

❍     Curvature: the values are expressed in percentage.

Open the ConnectChecker1.CATPart document.

1.  Select both surfaces to be 

analyzed.

2.  Click the Connect Checker icon 

 in the Shape Analysis 

toolbar.

The Connect Checker dialog 
box is displayed as well as 
another dialog box showing 
the color scale and identifying 
the maximum and minimum 
values for the analysis type. 

The Auto Min Max button 
enables to automatically 
update the minimum and 
maximum values (and 
consequently all values 
between) each time they are 
modified.
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Check the Internal edges option if you want to analyze the internal connections.
By default, the check box is unchecked.

  

 

3.  Choose the analysis type to be performed: Distance, Tangency or Curvature.

4.  Set the Maximum gap above which no analysis will be performed. All elements apart from a 

greater value than specified in this field are considered as not being connected, therefore do not 

need to be analyzed.

Be careful not to set a Maximum gap greater than the size of the smallest surface present in the 

document.
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5.  Check the analysis results on 

the geometry.

Here we are analyzing the 
distance between the 
surfaces. Each color section 
indicates on the geometry the 
distance between the 
surfaces.

From the Connect Checker dialog box, you can choose a number of visualization and computation options: 
●     the comb: that is the spikes corresponding to the distance in each point

●     the envelope: that is the curve connecting all spikes together

●     Information: that is the minimum and maximum values

Finally, the scaling option lets you define the visualization of the comb. In automatic mode the 
comb size is zoom-independent and always visible on the screen, otherwise you can define a 
coefficient multiplying the comb exact value.

6.  Check the Information button:

Two texts are displayed on 
the geometry localizing the 
minimum and maximum 
values of the analysis as 
given in the Connect Checker 
dialog box.
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You can also choose the 
discretization, that is the 
numbers of spikes in the 
comb (check the Comb 
option to see the difference).
The number of spikes 
corresponds to the number of 
points used for the 
computation:

●     Light: 5 spikes are 
displayed.

This mode enables to obtain 
consistent results with the 
visualization of sharp edges.
An edge is considered as 
sharp if its tangency deviation 
is higher than 0.5 degree. To 
only detect tangency 
deviations on sharp edges, 
specify a deviation of 0.5 
degree minimum.

To visualize sharp edges, 
make sure the View -> 
Render Style -> Shading 
with Edges and Hidden 
Edges option is checked.

 
●     Coarse: 15 spikes are 

displayed

●     Medium: 30 spikes are 
displayed

●     Fine: 45 spikes are 
displayed

The Full result is only available with the Generative Shape Design 2 product. 

The number of selected elements and the number of detected connections are displayed below the color 
range.
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7.  Click the Quick... button to 

obtain a simplified analysis 

taking into account tolerances 

(either distance, tangency, or 

curvature).

The comb is no longer 
displayed.
The Connect Checker dialog 
box changes to this dialog 
box.

You can use the check button 
to switch from one analysis 
type to another.
The Maximum gap and 
information are retained from 
the full analysis.
The maximum deviation value 
is also displayed on the 
geometry.

You can check the Overlapping button to highlight  where, on the common boundary, the two 
surfaces overlap. In this case the other analysis types are deactivated.

In P1 mode, only the quick analysis is available.

8.  Use the spinners to define the 

deviation tolerances.

For example, the red area 
indicates all points that are 
distant of more than 0.1 mm.

The maximum deviation 
values on the current 
geometry are displayed to the 
right of the dialog box.
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9.  Click OK to create the analysis.

The analysis (identified as Surface Connection Analysis.x) is added to the specification tree (P2 

only).

This allows the automatic update of the analysis when you modify any of the surfaces, using the 

control points for example.

If you do not wish to create the analysis, simply click Cancel.

●     You can edit the color range in both dialog boxes by double-clicking the color range manipulators 
(Connect Checker) or color areas (Quick Violation Analysis) to display the Color chooser.

●     If you wish to edit the Connection Analysis, simply double-click it from the specification tree.

●     If you no longer need the Connection Analysis, right-click Connection Analysis in the specification 
tree, and choose Delete.

●     The curvature difference is calculated with the following formula:

(|C2 -  C1|) / ((|C1 + C2|) / 2)

The result of this formula is between 0% et 200%.

●     You can analyze internal edges of a 
surfacic element, such as a Join for 
example, by selecting only one of 
the initial elements:

●     You can create an analysis on an entire geometrical set simply by selecting it in the specification tree.
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Checking Connections Between Curves
This task shows how to analyze how two curves are connected, following a blend, or match operation for 
example.
Four types of analyses are available.

❍     Distance: the values are expressed in millimeters

❍     Tangency: the values are expressed in degrees

❍     Curvature: the values are expressed in percentage

❍     Overlapping: the system detects overlapping curves

Open the ConnectChecker2.CATPart document.

1.  Select both curves to be 

analyzed.

2.  Click the Curve Connect 

Checker icon  in the Shape 

Analysis toolbar.

The Connect Checker dialog 
box is displayed. At the same 
time a text is displayed on 
the geometry, indicating the 
value of the connection 
deviation.

You can choose the type of 
analysis to be performed 
using the combo: distance, 
tangency or curvature.

 

In P1 mode, only this mode is available (no quick mode available).
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This step is P2 only for Wireframe and 

Surface. 

3.  Press the Quick button.

The dialog box changes along 

with the text on the 

geometry.. 

With our example, the text in 

the geometry disappears 

because the distance between 

the two curves is smaller than 

the set Distance value.

4.  Check the Tangency button:

A text is displayed on a green 
background (as defined by 
default for the Tangency 
criterion) to indicate that the 
Tangency criterion is not 
respected, because the first 
text displayed is the one for 
which the set tolerance is not 
complied with. You can then 
increase the Tangency value, 
or modify the geometry to 
comply with your needs. 

5.  Similarly, if you check the 

Curvature value, the displayed 

text indicates that the curvature 

between the two analyzed 

curves is greater than the set 

value.

6.  Modify the tolerance values, or 

the geometry to comply with the 

tolerances. 
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For example, if you modify the 

Tangency value to set it to 16 

degrees, the geometry instantly 

reflects the compliance with the 

new value. 

The maximum deviation values on the current geometry are displayed to the right of the dialog box.

7.  Click OK to create the analysis.

The analysis (identified as Curve Connection Analysis.x) is added to the specification tree.

This allows the automatic update of the analysis when you modify any of the curves, using the 

control points for example (see Editing Curves Using Control Points).

If you do not wish to create the analysis, simply click Cancel.

●     Double-click the Curve Connection Analysis from the specification tree to edit it.

●     You can analyze internal edges of a 
element, such as a Join for example, 
by selecting only one of the initial 
elements:

●     Use the Overlapping mode to highlight  where, on the common boundary, the two curves overlap.
When the Overlapping button  is checked, other analysis types are deactivated.
In Full mode, a text is displayed indicating whether the curves overlap.

The Overlapping mode is not available with the Wireframe and Surface product.

●     The curve connection checking analysis is permanent in P2 mode only, i.e. it is retained in the 
specification tree for later edition and on the geometry till you reset or delete it, whereas in P1 mode, 
it is present at a time, but not retained when exiting the command.
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Performing a Curvature Analysis

This task shows how to analyze the curvature of curves, or surface boundaries.

Open the Analysis1.CATPart document.

When analyzing surface 
boundaries:  

●     if you select the surface, the 
analysis is performed on all its 
boundaries

●     if you select a specific 
boundary, the analysis is 
performed only on this 
boundary.

1.  Click the Porcupine 

Curvature Analysis icon 

.

2.  Select the curve.

Automatically the curvature comb 
is displayed on the selected curve:
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3.  Define the analysis 

parameters in the 

Curvature Analysis dialog 

box.

●     Use the Project on Plane 

checkbox  to analyze the 

projected curve in the selected 

plane referenced by the 

compass.

●     If you uncheck the Project On 

Plane option, the analysis is 

performed according to the 

curve orientation. This is the 

default option.

4.  Use the spinners to adjust the number of strikes and modify the density.

5.  You can also decide to 

halve the number of spikes 

in the comb clicking as 

many times as wished the 

/2 button.

This option is particularly useful 
when the geometry is too dense to 
be read but the resulting curve 
may not be smooth enough for 
your analysis needs.

You could just as well double the 
number of spikes using the X2 
button.
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6.  Similarly, click the /2 

button to fine-tune the 

amplitude (size) of the 

spikes, and re-compute the 

analysis curve accordingly.

 

7.  Click Curvilinear to switch 

from the Parametric 

discretization mode to the 

Curvilinear analysis. You 

will get something like this:

 
8.  Check the Automatic option optimizes the spikes length so that even when zooming in or out, the spikes are 

always visible.

 

9.  Check the Logarithm 

option to display the 

logarithmic values in the 

3D geometry.

Displaying these values does not 
modify the analysis.
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10.  Click Reverse, you will get 

something like this:

That is the analysis 
opposite to what was 
initially displayed. This is 
useful when from the 
current viewpoint, you 
do not know how the 
curve is oriented.

11.  Use the Particular 

checkbox to display at 

anytime the minimum and 

the maximum points. 

Inflection points are displayed only 
if the Project on Plane and 
Particular checkboxes are checked.

12.  The Inverse Value checkbox displays the inverse value in Radius, if Curvature option is selected, or in 

Curvature, if Radius option is selected.

 
●     You can right-click on any of 

the spikes and select Keep 
this Point to keep the current 
point at this location.
A Point.xxx appears in the 
specification tree. 
If you check the Particular 
option, you have more options: 

❍     Keep all inflection points

❍     Keep local minimum 

(corresponds to the 

absolute minimum under 

the running point)
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❍     Keep local maximum 
(corresponds to the 
absolute maximum under 
running point)

❍     Keep global minimum (in 
case there are two curves, 
the point will be found on 
one or other of the curves)

❍     Keep global maximum 
(in case there are two 
curves, the point will be 
found on one or other of 
the curves)

This option is only available in P2 mode in FreeStyle Shaper, Optimizer, and Profiler.

13.  Finally, click the  icon to display the curvature graph:

The curvature profile and amplitude of the analyzed curve is represented in this diagram.

When analyzing a surface or several curves, i.e. when there are several curvature analyses on elements that are not 
necessarily of the same size for example, you can use different options to view the analyses. 
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For example, when analyzing a 
surface, by default you obtain this 
diagram, where the curves color 
match the ones on the geometry. 

●     Same vertical length : all 

curves are displayed according 
to the same vertical length, 
regardless of the scale

●     Same origin : all curves 

are displayed according to a 
common origin point on the 
Amplitude scale
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●     Vertical logarithm scale : 

all curves are displayed 
according to a logarithm scale 
for the Amplitude, and a 
linear scale for the Curve 
parameter.

Depending on the chosen option, values displayed in the diagram are updated.

The last icon  is used to reframe the diagram within the window, as you may move and zoom it within the window.

14.  Right-click a curve and 

choose one of the following 

options from the contextual 

menu:

●     Remove: removes the curve

●     Drop marker: adds Points.xxx 

in the specification tree

●     Change color: displays the 

Color selector dialog box that 

enables you to change the 
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color of the curve.

15.  Slide the pointer over the diagram to display the amplitude at a given point of the curve.

You can slide the pointer over the diagram and the 3D analysis.

Click the x in the top right corner to close the diagram.

16.  Click OK in the Curvature Analysis dialog box once you are satisfied with the performed analysis.

The analysis (identified as Curvature Analysis.x) is added to the specification tree.

In case of clipping, you may want to temporarily modify the Depth Effects' Far and Near Limits. See Setting Depth 

Effects in CATIA Infrastructure User Guide.
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Analyzing Distances
Between Two Sets of Elements

This task shows how to analyze the distance between any two geometric elements, or between two sets of 
elements.

Open the DistanceAnalysis1.CATPart document.

1.  Select an element, or set of elements.

2.  Click the Distance Analysis icon  

in the Shape Analysis toolbar.

The Distance dialog box is displayed. 

3.  Click Second set and select a second element, or set.

The distance analysis is computed. 

Each color identifies all discretization points 
located at a distance between two values, as 
defined in the Color Scale dialog box. 
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●     When computing the distance between two curves, there is no negative values possible as opposed to 
when analyzing the distance between a surface and another element. Indeed, surfaces present an 
orientation in all three space directions whereas, in the case of planar curves for example, only two 
directions are defined. Therefore the distance is always expressed with a positive value when 
analyzing the distance between two curves. 

●     The element which dimension is the smallest (0 for points,1 for curves, 2 for surfaces for example) is 
automatically discretized, if needed.
When selecting a set of element, the system compares the greatest dimension of all elements in each 
set, and discretizes the one with the smallest dimension. 

●     Use the Invert Analysis button to invert the computation direction.

In some cases, when inverting the computation direction does not make sense, when one of the elements 
is a plane for example, the Invert Analysis button is grayed.

●     If you check the Running point option, 
you need to move the pointer over the 
discretized element to display more precise 
distance value between the point below the 
pointer and the other set of elements. 
The projection is visualized and the value is 
displayed in the geometry area.

Note that the analyzed point is not necessarily 
a discretized point in this case. This is obvious 
when a low discretization value is set, as 
shown here.
Two analysis modes are available, with corresponding color ramps, provided the Color scale checkbox is 
checked.
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a. Full (P2 only): activated by the Full color 

range  icon, it provides a complete 

analysis based on the chosen color range. This 
allows you to see exactly how the evolution of 
the distance is performed on the selected 
element.

   

b. Limited: activated by the Limited 

color range , it provides a 

simplified analysis, with only three 
values and four colors.

Whichever mode you choose the use of the color scale is identical: it lets you define colors in relation to 
distance values. 

You can define each of the values and color blocks, therefore attributing a color to all elements which 
distance falls  into to given values.

 
●     The Auto Min Max button enables to automatically update the minimum and maximum values (and 

consequently all values between) each time they are modified.
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●     You can right-click on a color in the color 
scale to display the contextual menu:

   

- Edit: it allows you to modify the 
values in the color range to highlight 
specific areas of the selected 
surface. The Color dialog box is 
displayed allowing the user to 
modify the color range. 

- Unfreeze: it allows you to perform a linear interpolation between non defined colors. 
The unfreezed values are no longer highlighted in green. 

- No Color: it can be used to simplify the analysis, because it limits the number of displayed 
colors in the color scale. In this case, the selected color is hidden, and the section of the 
analysis on which that color was applied takes on the neighboring color. 

●     You can also right-click on the value to 
display the contextual menu:

   
 - Edit: it allows you to modify the 
edition values. The Value Edition 
dialog box is displayed: enter a new 
value (negative values are allowed) 
to redefine the color scale, or use 
the slider to position the distance 
value within the allowed range, and 
click OK.
The value is then frozen, and 
displayed in a green rectangle.
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- Use Max/Use Min : it allows you to evenly distribute the color/value interpolation between 
the current limit values, on the top/bottom values respectively, rather than keeping it within 
default values that may not correspond to the scale of the geometry being analyzed. Therefore, 
these limit values are set at a given time, and when the geometry is modified after setting 
them, these limit values are not dynamically updated. 

For now only the linear interpolation is allowed, meaning that between two set (or frozen) 
colors/values, the distribution is done progressively and evenly.

The color scale settings (colors and values) are saved when exiting the command, meaning the same 
values will be set next time you edit a given distance analysis capability.
However, new settings are available with each new distance analysis.

5.  Set the distance analysis type (we checked the Auto Scale button and unchecked the Min/Max 

values button):

 Projection Space

 

 The Projection Space area helps you define the preprocessing of the input elements used for the 
computation. 

This frame is only available when analyzing 
distances between curves.

 

 

●     3D : elements are not modified and 

the computation is done between the initial 
elements.

 
●     Projection according to the X , Y , or Z  axis: the computation is done between the 

projection of selected elements.

 
●     Projection according to the compass current orientation : the computation is done between the 

projection of selected elements.
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●     Planar distance : the distance is 

computed between a curve and the 
intersection of the  plane containing that 
curve.

 Measurement Direction  

 

 The Measurement Direction area provides options to define how set the direction used for the distance 
computation.

●     Normal distance : the distance is 

computed according to the normal to the 
other set of elements.

 
●     Direction according to the X , Y , 

or Z  axis.

 

 
●     Direction according to the compass 

current orientation .

 

6.  Click the  icon to display the 2D diagram distance analysis window. The latter allows to 

visualize the distance evolution.
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 Drawing modes:

●     Vertical Inverse Scale  : to draw the curves in a linear horizontal scale and and inverse vertical 

scale.

●     Reframe  : to reframe the frame

7.  Click More>> in the Distance dialog 

box to see, and choose further display 

and discretization options:
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●     Color scale: to display the Color Scale dialog box whether the full or the limited color range.

 

●     Statistical distribution: to display the 
percentage of points between two values.

This option is only available if the Color Scale 

checkbox is checked.
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●     Min/Max values: to display the minimum 
and maximum distance values and 
locations on the geometry.

●     Points: to see the distance analysis in the 
shape of points only on the geometry (The 
Spikes button is unchecked)

 
●     Spikes: to see the distance analysis in the shape of spikes on the geometry.

You can further choose to: 
❍     set a ratio for the spike size

❍     choose an automatic optimized spike size (Auto scale)

❍     invert the spike visualization on the geometry

❍     display the envelope, that is the curve connecting all spikes together

   
●     Use the Texture option to check the 

analysis using color distribution.
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●     This option is only available with surfacic 
elements in at least one set, providing this 
set is discretized. 
The distance is computed from this 
discretized set to the other set. The texture 
mapping is computed on the discretized 
surface.
It is not advised to use it with planar 
surfaces or ruled surfaces.

●     Statistical distribution, Min/Max 
values, and Points cannot be visualized 
when using the Texture option.

●     The visualization mode should be set to 
Shading with Texture and Edges, and 
the discretization option should be set to a 
maximum (in CATIA Infrastructure User 
Guide, see Improving Performances, the 
3D Accuracy -> Fixed option should be 
set to 0.01).
Check the Materials  option in  the View -
> Render Style -> Customize View 
command to be able to see the analysis 
results on the selected element. Otherwise 
a warning is issued.

●     Use the Max Distance option to relimit the 
distance: for example, set the value to 
150mm. The maximum value is displayed 
accordingly on the geometry.

 
●     Use the Discretization option to reduce or increase the number of points of the second set of 

elements taken into account when computing the distance.

●     Automatic trap: to delimit the second set of points to be taken into account for the computation, in 
the case of a large cloud of points,  thus improving the performances.
Be careful when using the Automatic trap option with certain cloud configurations, such as spiralling 
clouds of points for example, as the automatic trap may remove too many points to generate 
consistent results.
In this case, it is best to deactivate the check button.
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8.  Click OK to exit the analysis while retaining it.

The analysis (identified as Distance Analysis.x) is added to the specification tree.

●     Even though you exit the analysis, the color scale is retained till you explicitly close is. This is like a 
shortcut allowing you to modify one of the analyzed elements, which leads to a dynamic update of the 
distance analysis, while viewing the set values/colors at all times and without having to edit the 
distance analysis.

●     When analyzing clouds of points, in normal projection type, the distances are computed as the normal 
projection of each point of the first cloud onto the triangle made by the three points closest to that 
projection onto the second cloud.
As it is a projection, using the Invert Analysis button does not necessarily gives symmetrical results.

●     When you select the geometrical set as an input in the specification tree, all the elements included in 
this geometrical set are automatically selected too. 

The auto detection capability is available from the FreeStyle Dashboard.
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Using Dynamic Cutting Planes

This task shows how to analyze a surface using parallel cutting planes. The intersection of the planes with 
the surface is represented by curves on the surface. From these curves, you can visualize the porcupine 
analysis. This analysis is dynamic, meaning that you can interactively modified a number or parameters to 
fine-tune the analysis.

Open the CuttingPlane1.CATPart document.

1.  Select the surfaces to be analyzed.

2.  Click the Cutting Planes icon  in 

the Shape Analysis toolbar.

A reference plane is displayed along 
with the default number of cutting 
planes, and the corresponding 
projected lines onto the selected 
surface.

The Cutting Plane dialog box is displayed.

You can define analysis parameters from this 
dialog box, that is:

●     The plane in which the analysis is to be 
performed, using the three icons (Parallel 
Planes, Planes perpendicular to 
curves, Independent planes)

●     The boundaries of the set of planes 
(available in Parallel Planes mode only): 

❍     Automatic: the analysis is performed 
based on all selected surfaces bounding 
boxes. The cutting planes are evenly 
distributed within this area, one being 
necessarily located on the reference 
plane if the Step option is active.
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❍     Manual: the analyzed area is defined 
by the Start and End values.

●     Number/Step: choose whether you have a set number of planes or a distance (step) between two 
planes. In the latter case, the number of planes depends on the size of the analyzed area. This option 
is only available in Parallel Planes and Planes perpendicular to curves mode.

●     Start/End: in manual mode, defines the distance at which the first (start) and last (end) cutting 
planes are located on the reference plane axis.

●     Options facilitating the analysis 
reading:

222Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



1.  Activates/hides the 
representation of the cutting 
planes

2.  Activates the display of the 
curvature comb (Curvature 
option)

If you click the Settings button, the 
Curvature Analysis dialog box is 
displayed.

The result is similar to using the 
Porcupine curvature analysis, except 
that it displays spikes for each 
intersection curve. See Performing a 
Curvature Analysis. 

3.  Click the Parallel planes icon .

The compass moves to the reference 

plane center, and from then you can 

manipulate the reference plane. 
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If you want to perform an analysis in 
planes perpendicular to curves, 
select a curve and click the Planes 

perpendicular to curves  

icon.

 

 Using the Planes perpendicular to 
curves type, you can check the On 
curve option in the Number/Step 
area to create perpendicular planes.

1.  Select a reference curve
2.  Check the On curve option

You can create several planes: right-click the 
reference plane and select Keep this plane 
from the contextual menu. 
Planes are added to the specification tree.

 
This option is only available with the Planes 
perpendicular to curves type.
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If you want to perform an analysis in 
independent planes, click the 

Independent planes  icon.

 

 You can use the contextual menu on 
the Independent planes icon to 
create the a plane.
Each created plane is added to the 
current list of planes used for the 
analysis.

See Stacking Commands.

4.  Activate the Manual mode, set the 

Step value to 30, and the Start value 

to -150 and End value to 150.

The planes are automatically relocated.
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5.  Click OK in the Cutting Plane dialog box, when you have finished the analysis.

The analysis (identified as Cutting Plane Analysis.x) is added to the specification tree.

●     Click OK to interrupt the function while keeping the analysis on the surface, so that it is dynamically 
updated when deforming the surface.

●     Click Cancel to interrupt the function and remove the analysis.

●     Right-click the intersection curves to actually create the curve on the analyzed surface. You can 
choose to create only the curve over which the pointer is (Keep this intersection curve option) or to 
"drop" all curves onto the element (Keep all intersection curves option).

The Keep this point option is also available from the contextual menu.

 

 

226Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Analyzing Using Highlight Lines

This task shows you how to create and visualize curves on surfaces in order to analyze the surface shape 
and curvature variations.

Open the HighlightLines1.CATPart document.

1.  Click the Highlight Lines Analysis icon .

The Highlight Lines dialog box displays.

 

 
2.  Select one or more surfaces to be analyzed.

 

 
3.  Select the highlight type:

●     Tangent: the compass plane intersects 

the surface at a given point. Then the 

tangent to this intersection is calculated.

Therefore, the angle should be computed 

between the first direction of the compass 

and the tangent to the intersection.

The tangent in each point of the created 

line is defined through rotations of the 

angle pitch.
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●     Normal: the angle should be computed 

between the Z compass direction and the 

normal to the surface.

The normal to the surface in each point of 

the created line has the same angle pitch 

in a specified direction.

You can right-click a line to convert it into a curve. Two 
options are available from the contextual menu:

●     Keep this highlight line

●     Keep all highlight lines

The created curve(s) appears in the specification tree as 

a datum element.

4.  Key in an angle, representing the value between the selected direction and the normal or tangent 

to the surface.

5.  Click OK when you have finished the analysis.

The analysis (identified as Highlight Lines Analysis.x) is added to the specification tree.
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Performing a Surfacic Curvature Analysis

●     This command is not available with the Generative Shape Design 1 product.

●     Used in Part Design workbench, this command requires the configuration mode.

This task shows how to analyze the mapping curvature of a surface.

Open the SurfacicAnalysis1.CATPart document.

 
●     The visualization mode should be set to Shading With Edges in the View -> Render Style command

●     The discretization option should be set to a maximum: in Tools -> Options -> Display -> Performances, set the 3D Accuracy -> Fixed option to 
0.01.

●     Check the Materials option in the View -> Render Style -> Customize View command to be able to see the analysis results on the selected 
element. Otherwise a warning is issued.

●     Uncheck the Highlight faces and edges option in Tools -> Options -> Display -> Navigation to disable the highlight of the geometry selection.

1.  Select a surface.

2.  Click the Surfacic Curvature Analysis icon  in the Shape Analysis toolbar.

The Surfacic curvature dialog box is displayed, and the analysis is visible on the selected element. It gives information on the display (color 

scale), the draft direction and the direction values.

The Surfacic Curvature.1 dialog box showing the color scale and identifying the maximum and minimum values for the analysis is displayed 

too. 

●     You can right-click on a color in the color scale 

to display the contextual menu:
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- Edit: it allows you to modify the values 
in the color range to highlight specific 
areas of the selected surface. The Color 
dialog box is displayed allowing the user 
to modify the color range.

- Unfreeze: it allows you to perform a linear interpolation between non defined colors. 
The unfreezed values are no longer highlighted in green. 

- No Color: it can be used to simplify the analysis, because it limits the number of displayed colors in the color scale. In this case, the 
selected color is hidden, and the section of the analysis on which that color was applied takes on the neighboring color. 

●     You can also right-click on the value to display 
the contextual menu:

 - Edit: it allows you to modify the 
edition values. The Value Edition dialog 
box is displayed: enter a new value 
(negative values are allowed) to redefine 
the color scale, or use the slider to 
position the distance value within the 
allowed range, and click OK.
The value is then frozen, and displayed in 
a green rectangle. 

- Use Max/Use Min: it allows you to evenly distribute the color/value interpolation between the current limit values, on the top/bottom values 
respectively, rather than keeping it within default values that may not correspond to the scale of the geometry being analyzed. Therefore, 
these limit values are set at a given time, and when the geometry is modified after setting them, these limit values are not dynamically 
updated. 

- Interpolation: by default the interpolation is linear

Type

3.  Select the type analysis:

In the following examples, we defined minimum and maximum values and used the on the fly option.

●     Gaussian
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●     Minimum: to display the minimum curvature 

value

   

●     Maximum: to display the maximum curvature 

value
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●     Limited: the quick mode is displayed and the 

Limited Radius type is selected.

In the Surfacic curvature dialog box, you are 

able to modify the radius value using the up 

and down arrows. The value is automatically 

updated in the color scale.

This value is expressed in the same unit as set in the Tools -> Options -> General ->Parameters -> Units tab, Length parameter.

●     Inflection Area: enables to identify the 

curvature orientation: 

❍     In green:  the areas where the minimum and 

maximum curvatures present the same 

orientation

❍     In blue: the areas where the minimum and 

maximum curvatures present opposite 

orientation

See also Creating Inflection Lines. Note that these 

inflection lines are always created within the green 

area, i.e. when the curvature orientation is 

changing.

Display options

●     Uncheck the Color Scale checkbox to remove the Surfacic Curvature Analysis.1 dialog box.

●     Activate the On the fly checkbox and move the 

pointer over the surface.

This option enables to perform a local analysis.

The Curvature and Radius values are displayed 

under the pointer. As you move the pointer 

over the surface, the display is dynamically 

updated.

The values are expressed in the units set in 

using the Tools -> Options -> General -> 

Parameters -> Units tab.

The displayed values may vary from the 
information displayed as the Use Max / 
Use Min values, as it is the precise value 
at a given point (where the pointer is) 
and does not depend on the set 
discretization. 

The On the fly analysis can only be performed on 
the elements of the current part.
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Right-click a point to display the 
contextual menu. It allows you to :

- keep the point at this 
location (under the pointer)
- keep the point corresponding 
to the minimum value
- keep the point corresponding 
to the maximum value

A Point.xxx appears in the 
specification tree. 

In P1 mode, this contextual menu is not 
available. 

●     Activate the 3D MinMax checkbox to locate the 

minimum and maximum values for the selected 

analysis type.

Analysis options

●     The radius mode is only available for the Limited type analysis.

4.  Once you have finished analyzing the surface, click OK in the Surfacic Curvature Analysis dialog box.

The analysis (identified as Surfacic Curvature Analysis.x) is added to the specification tree.

This capability is not available in P1 mode.

●     You can display the control points by clicking the  icon, still viewing the surfacic curvature analysis. This allows you to check the impact of any 

modification on the surface.
Here are examples using the 3D MinMax capability.
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If you double-click the Surfacic Curvature 
Analysis.xxx in the specification tree, the Minimum 
and Maximum values are updated in the Surfacic 
Curvature.1 analysis but not in the color scale. 

   

To update the values in the color scale, right-click 
the minimum value and the maximum value and 
select respectively Use Min / Use max from the 
contextual menu.
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●     Surfacic curvature analyses can be performed on a set of surfaces.

●     If an element belongs to an analysis, it cannot be selected simultaneously for another analysis, you need to remove the current analysis by 
deselecting the element to be able to use it again.

●     In some cases, even though the rendering style is properly set, it may happen that the analysis results are not visible. Check that the geometry is up-
to-date, or perform an update on the involved geometric element(s).

●     The analysis results depend of the current object. May you want to change the scope of analysis, use the Define in Work object contextual command.
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Performing a Draft Analysis

●     This command is not available with the Generative Shape Design 1 product.

●     Used in Part Design workbench, this command requires the  configuration mode.

This task shows how to analyze the draft angle on a surface.
The Draft Analysis command enables you to detect if the part you drafted will be easily removed. 

This type of analysis is performed based on color ranges identifying zones on the analyzed element where the deviation from the draft 
direction at any point, corresponds to specified values.
These values are expressed in the unit as specified in Tools -> Options -> General -> Parameters -> Unit tab. 
You can modify them by clicking on their corresponding arrow or by entering a value directly in the field.
Open the DraftAnalysis1.CATPart document.

●     The visualization mode should be set to Shading With Edges in the View -> Render Style command

●     The discretization option should be set to a maximum: in Tools -> Options -> Display -> Performances, set the 3D Accuracy -> 
Fixed option to 0.01.

●     Check the Materials option in the View -> Render Style -> Customize View command to be able to see the analysis results on 
the selected element. Otherwise a warning is issued.

●     Uncheck the Highlight faces and edges option in Tools -> Options -> Display -> Navigation to disable the highlight of the 
geometry selection.

1.  Select a surface.

It is highlighted. 

2.  Click the Draft Analysis icon  in the 

Shape Analysis toolbar.

The Draft Analysis dialog box is displayed. It gives 
information on the display (color scale), the draft 
direction and the direction values.
The Draft Analysis.1 dialog box showing the color 
scale and identifying the maximum and minimum 
values for the analysis is displayed too. 
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Mode option

The mode option lets you choose between a quick and a full analysis mode. These two modes are completely independent.
The default mode is the quick mode. It simplifies the analysis in that it displays only three color ranges.

Quick mode Full mode

In P1 mode, only the quick mode is available is available.

●     You can double-click a color and modify the values 
in the color range to highlight specific areas of the 
selected surface. The Color dialog box is displayed 
allowing the user to modify the color range.

   
●     You can also double-click a value and modify the 

edition values.  The Value Edition dialog box is 
displayed: enter a new value (negative values are 
allowed) to redefine the color scale, or use the 
slider to position the distance value within the 
allowed range, and click OK.
The value is then frozen, and displayed in a green 
rectangle.

Display option

●     Uncheck the Color Scale checkbox to remove the Draft Analysis.1 dialog box.

This dialog box only appears in edition mode.
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●     Activate the On the fly checkbox and move the 

pointer over the surface.

This option enables you to perform a local 

analysis.

Arrows are displayed under the pointer, 

identifying the normal to the surface at the 

pointer location (green arrow), the draft direction 

(red arrow), and the tangent (blue arrow). As you 

move the pointer over the surface, the display is 

dynamically updated.

Furthermore, circles are displayed indicating the plane 
tangent to the surface at this point.
The displayed value indicates the angle between the 
draft direction and the tangent to the surface at the 
current point.
It is expressed in the units set in using the Tools -> 
Options -> General -> Parameters -> Units tab.

The On the fly analysis can only be performed on the elements of the current part.

Note that you can activate the On the fly option even when not visualizing the materials. It gives you the tangent plane and the 
deviation value.

●     Click the Inverse button to automatically reverse 

the draft direction:

When several elements are selected for 

analysis, the draft direction is inverted for 

each element when the button is clicked. 

In case of an obviously inconsistent result, do not 
forget to invert locally the normal direction via the 
Inverse button.

The manipulator on the draft direction allows you to materialize the cone showing the angle around the direction.

238Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Direction in the cone Direction out of the cone
●     Right-click the cone angle to display the Angle 

Tuner dialog box.
When you modify the angle using the up and 
down arrows, the value is automatically updated 
in the color scale and in the geometry.

Please note that you cannot modify the angle below the minimum value or beyond the maximum value.

Full mode

Quick mode

    

●     Right-click the Direction vector to display the 

contextual menu.

It allows you to:

●     hide / show the cone

●     hide / show the angle

●     hide / show the tangent

●     lock / unlock the analysis position

●     keep the point at this location

A Point.xxx appears in the specification 

tree.
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In P1 mode, the Keep Point option is not available.

Direction

By default the analysis is locked, meaning it is done according to a specified direction: the compass w axis.
In P1 mode, the default analysis direction is the general document axis-system's z axis.

●     Click the Locked direction icon , and select a direction (a line, a plane or planar face which normal is used), or use the 

compass manipulators, when available.

Using the compass manipulators Selecting a specific direction 

●     Click the Compass icon  to define the new current draft direction.

The compass lets you define the pulling direction that will be used from removing the part.

You can display the control points by clicking the Control Points  icon, yet the draft analysis is still visible, then allowing you to 

check the impact of any modification to the surface on the draft analysis.
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3.  Once you have finished analyzing the surface, click OK in the Draft Analysis dialog box.

The analysis (identified as Draft Analysis.x) is added to the specification tree. 

This capability is not available in P1 mode.

●     Note that settings are saved when exiting the command, and redisplayed when you select the Draft Analysis icon again.

●     Be careful, when selecting the direction, not to deselect the analyzed element.

●     A draft analysis can be performed just as well on a set of surfaces.

●     If an element belongs to an analysis, it cannot be selected simultaneously for another analysis, you need to remove the current 
analysis by deselecting the element to be able to use it again.

●     In some cases, even though the rendering style is properly set, it may happen that the analysis results are not visible. Check that the 
geometry is up-to-date, or perform an update on the involved geometric element(s).

●     The analysis results depend of the current object. May you want to change the scope of analysis, use the Define in Work object 
contextual command.
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Mapping an Environment on a Surface

This task explains how to map a sample environment onto a surface generated using the FreeStyle 
Shaper.

Open the Analysis1.CATPart document.

1.  Click the Environment Mapping icon  in the 

Shape Analysis toolbar.

The Environment Mapping dialog box is displayed:

 
2.  Define the type of mapping to be applied using the drop-down list.

You can also import an image file (of type .jpg, .bmp, .rgb) using the Browse icon .

 
3.  Select one or more surfaces and apply different image definitions.

 
4.  Set the reflectivity coefficient which defines the transparency of the texture using the slider.

The preview area lets you fine-tune these parameters.

5.  Click OK.

You can click the  icon to perform a global analysis.

 The analysis (identified as Environment Mapping Analysis.x) is added to the specification tree.
 The surfaces automatically reflect your mapping definition. It could look like this:

242Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



 

 

243Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Analyzing Using Isophotes
This task explains how to apply isophotes on a surface.
Isophotes are variable black stripes applied to the surface and used for analysis purposes. It is a tool for 
the analysis of the element state.

Open the IsophotesMapping1.CATPart document.

The discretization option should be set to a maximum (in CATIA Infrastructure User Guide, see 

Performance: the 3D Accuracy -> Fixed option should be set to 0.01).

Check the Materials option in the View -> Render Style -> Customize View command to be able to 

see the analysis results on the selected element. Otherwise a warning is issued.

1.  Click the Isophotes Analysis icon  in the 

Shape Analysis toolbar.

The Isophote Analysis dialog box is displayed.

 
2.  Select one or more surfaces to be analyzed.

 

The analysis results depend of the current object. May you want to change the scope of analysis, use the 
Define in Work object contextual command.

3.  Define the mapping type:
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 ●     Cylindrical mode 

●     Spherical mode 

 4.  Define the options:

 

●     Global : lets you analyse the whole part. 

Uncheck this icon to perform the analysis element by 

element.

It is advised to use the Global mode for a global 

selection rather than using a trap.
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●     Compass : flips the compass to the model and 

lets you move the compass in the 3D geometry to 

define the orientation.

 

●     View : lets you use the screen definition to 

define the orientation. Stripes are recalculated each 

time you move the mouse.

 5.  Define the analysis parameters using sliders:  

 

●     number of 

stripes 

 Few stripes Many stripes
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●     width

 Black thick stripes Black thin stripes
 

●     color 

transition

  Sharp color transition Smooth color transition
  
 The preview area is directly applied on the 3D screen and  lets you fine-tune these parameters. 
 

6.  Click OK when you have finished the analysis.

The analysis (identified as Isophotes Mapping Analysis.x) is added to the specification tree.

The surface automatically reflects your mapping definition. It could look like this:
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Analyzing Using Highlights
This task shows how to perform an analysis of the surfaces quality of shaded highlights.
It analyses the angle between surface normals and a predefined direction. Dependent on the angle, it sets the color at this surface 
position. All positions with the same angle between surface normal and predefined direction get the same shading color. If the angle is 
90 degrees, the resulting stripe is the silhouette line related to the predefined direction.

Open the Highlights1.CATPart document.

Make sure the Shading and Material visualization options are active by selecting the Customize View icon   in  the View mode 

toolbar. 

1.  Click the Highlight icon .

The Highlights dialog box displays.

You do not need to select the part in the specification tree as the analysis works globally on the part.

2.  Define the display options:

●     Grid: two predefined directions define a grid of stripes (not necessarily perpendicular) on the surface. The plane tool u and v 

direction, are used as predefined directions in grid mode. If you uncheck the Grid options, it switches to the Stripes mode: the 

plane tool normal is the predefined direction.

●     Global: the whole part is highlighted.

●     Angle: highlights are distributed per angle.

●     Density: defines the number of stripes or grid lines.

●     Thickness: defines the thickness of stripes or grid lines. 

●     Sharpness: defines the sharpness of stripes or grid lines (soft or hard color transition). 
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Here is an example the following values
Grid and Global

Density=50
Thickness=0.30
Sharpness=0.80

Here is an example the following values
Grid and Global

Density=80
Thickness=0.70
Sharpness=0.30

Here is an example the following values
Grid, Global, and Angle

Density=80
Thickness=0.70
Sharpness=0.30

Here is an example the following values
Global and Angle

Density=80
Thickness=0.70
Sharpness=0.30

3.  Right-click the plane tool to display the Highlights 

Properties.

●     Define the snap mode to snap tool position and optionally 

orientation on geometry

❍     Off: no snap mode

❍     Vertex: the plane tool snaps on a vertex. Dependent on the 

vertex (surface corner, 3D curve endpoint), the direction is 

adapted to the surface normal or curve tangent 

❍     Curve: the plane tool snaps on a curve or surface edge. As a 

result in stripes mode the silhouette line of the plane tool 

normal crosses the edge at the plane tool origin

❍     Surface: the plane tool snaps on a surface and adapts the 

surface normal. As a result in grid mode the silhouette line 

of the plane tool u direction and the silhouette line of the 

plane tool v direction are crossing at the plane tool origin 

●     Define the rotation mode of the 3D tool: 

❍     Dynamic: normal dynamic rotation mode

❍     Discrete: the rotation of the tool snaps to certain relative 

grid angles.

❍     Grid: the rotation of the tool snaps to certain absolute grid 

angles.
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❍     Static: the rotation is activated by a mouse click on the 

corresponding rotation handle of the tool. The grid value 

defines the specific rotation angle

●     Define the rotation value by entering a value or using the 

spinners

●     Define the numerical feedback of the 3D tool: 

❍     Distance 3D: direct distance between the start position of 

the translation and the current position

❍     Distance XYZ: distance shown in x, y and z components of 

the current coordinate system

❍     Coordinates: absolute position of the tool in the model 

coordinate system

 
 

4.  Click OK to create the analysis.

For further information, please refer to the CATIA Automotive Class A documentation.
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Generic Tools
This chapter deals with generic tools available in FreeStyle Shaper. These tools are available from the FreeStyle 
Dashboard, the Generic Tools, and the Tools toolbars:

 
Display dress-up options: set the display options then apply or remove 
the visualization options on selected elements.

Display information on elements: click the icon and select any element.

 Display a part symmetrically: select a part, and a mirror plane.

Analyze using parameterization: select the Tools -> Parameterization 
Analysis... command and define a filter for your query.

 
Manage the compass: click the adequate icon in the displayed toolbar to 
define the compass orientation.

Use Manipulators: select a manipulator, move it close to geometry to 
detect another point to be used for projection or snap onto it, using auto-
detection capabilities.

Create an axis system: click the icon, and enter coordinates or select 
geometry to define the three axes.

Stretch view analysis tool: set the stretching ratio.

 Manipulate views: click the adequate icon to freeze viewpoint 
manipulations.

 Define views: drag and drop the compass and click the icon to define the 
viewpoint.

 Create datums: click the icon to deactivate the History mode.

Perform symmetry on geometry: select an element, then a point, line, or 
plane as reference element.

 
Keep the initial element: click the icon and use another command do 
create/modify an element. The operation is performed on a copy of the 
original element.

Insert in a new geometrical set: select this mode once you enter a 
command to create the result of the operation in a new geometrical set.

 Create a temporary analysis: select this mode once you enter a 
command in order to get a feedback on the connection quality.
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Auto-detection: specify the search type and set the auto-detection 
parameters. 

 

  

Attenuate displacement: choose the attenuation value for the 
manipulators' step.

Display continuities on an element: select the element and click the icon 
to display a text indicating the continuity type on the element. 

 
Display contact points on an element: select the element and click the 
icon to display the contact points and their manipulators on the 
element. 

 Display the tension on an element: select the element and click the icon 
to display the tension vector and value on the element. 

 Display orders along U or V: select the element and click the icon to 
display the order number along U and/or V

 Display control points temporarily: click the icon to display control points 
on selected elements while another command is running.

 
Insert geometrical sets: select the branch where the new geometrical set 
should be inserted and choose the Insert -> Geometrical Set menu 
command.
Manage ordered geometrical sets: select the branch where the new 
linear geometrical set should be inserted and choose the Insert -> 
Ordered Geometrical Set menu command.

Select using a filter: select an object, and use the Selection Filter toolbar 
to manage element types and modes.

 
Select a Support: select a point, a curve, or a surface and right-click the 
pictographic tag to choose the support.

 
Select Using multi-output: select several elements, click OK. The Multi 
Output feature appears in the specification tree, grouping elements

Edit and keep a point: right-click a point, select Edit and/or Keep this 
point from the contextual menu.
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Setting FreeStyle Visualization Options

This task shows you how to display or hide permanent control points and curve/surface segments on 
FreeStyle Shaper elements for analyses purposes.

Open the VisuOptions1.CATPart document, or any .CATPart document containing FreeStyle elements.

1.  Click the Apply Dress-Up icon .

The Dress-Up Options dialog box is 

displayed.

2.  Set the type of visualization you want to 

apply to geometric elements.

You can choose: 

●     to display, or not, control points

●     the control points type

●     to display, or not, segments.

The Isoparametrics by patch is inactive but provides information on the number of 
isoparametric curves (dotted lines) per surface patch (delimited by solid lines).

3.  Select the element on which you wish to 

display the control points.
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4.  Click Apply.

The control points and mesh lines are 
displayed on the selected element.

5.  Activate the Segmentation option, 

uncheck the Control Points, then click 

Apply.

 
Contextual options

 

 a.  When selecting an arc limit of a curve:
It enables you to either keep the arc limit 
you right-clicked or all the arc's limits. 

●     Keep this arc limit: a 3D point 
appears in datum mode in the 
specification tree

●     Keep all arc's limits: all the 3D 
points used to create the 3D curve 
appear in datum mode in the 
specification tree
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b.  When selecting the patches limits of a 
surface:

●     Keep all patches limits: all the 3D 
curves used to create the patch limit 
appear in datum mode in the 
specification tree.

Note: only patches limits are created. 
Therefore patches limits do not 
necessarily correspond to surfaces limits 
(in the case of trimmed surfaces for 
instance).

If you wish to create the 3D points or curves in a new geometrical set instead of the current geometrical 

set, click the Insert In a New Geometrical Set  icon from the FreeStyle Dashboard. As the 3D 

points and curves are created in a private body, its content cannot be modified: you cannot delete or add 
elements.
As long as the icon is active, a new geometrical set is created each time you run the Dress-Up command.

6.  Click OK. 

The visualization options are as defined by the user and remain on the selected elements till you 

click the Remove Visualization Options icon , or till you modify them using the Dress-Up 

Options dialog box again.

The visualization options are applied globally to the document, meaning that you can apply different 
options to several elements, but if you save, close then open the document again, the options defined 
last will be applied to all the elements on which visualization options have been set.

●     No modification is possible on the control points, as opposed to using the Control Points icon  as 

described in Editing Surfaces Using Control Points or Editing Curves Using Control Points.

●     Multi-selection applies with these display capabilities:
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Capabilities available from the FreeStyle Dashboard are datum creation and insert in a new geometrical 
set.
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Displaying Geometric Information
On Elements

This task shows you how to display or hide geometric information on geometrical elements, such as any 
curve, or surface, either as a stand-alone element, or taking part in the composition of another element 
(intersection curve, cylinder axis, face of a pad, and so forth). 

Only geometry of topological cells is analyzed, therefore elements such as Cloud of points, for example, 
are not analyzed.

Open the GeometricInformation1.CATPart document, or any .CATPart document containing geometrical 
elements.

1.  Click the Geometric Information icon .

2.  Select the element for which you want to display information either in the geometric area or in the 

specification tree.

The Geometric Analysis dialog box is displayed.

Information, such as:

●     the element type (Nurbs surface or curve, Pline, planes, etc.)

●     whether the element has been trimmed, or not

●     the number of segments (components) in both U & V direction (where applicable)

●     the order of the element in both U & V direction (where applicable)

is displayed in the dialog box.

Moreover, a vector representing the element's orientation 

(U for a curve, and U & V for a surface) is displayed on the 

geometrical element itself. 
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In the case of a 3D curve created using the Control Points type, the maximum order is 6.

●     Uncheck the Geometric Information icon  to exit the command, or simply click another icon.

●     You cannot select an element from the specification tree as the selected element might be too 
complex (i.e. be composed of more than one cell) and the system cannot determine which element is 
to be analyzed.

●     You can stack this command on top of the current 
command, i.e. that you editing an element using its 
control points, you can activate the Geometric 
Information icon. The current command is frozen, and 
when you exit the information command, you are back 
into the initial command.

The geometry type is categorized as follows:
  

Displayed Type What is it ?

NupbsCurve Non Rational NURBS Curve

NupbsSurface Non Rational NURBS Surface

NurbsCurve Rational NURBS Curve

NurbsSurface Rational NURBS Surface

PNupbs Parametric non rational curve on a 
surface

PNurbs Rational parametric curve

PSpline Parametric curve on a surface

PLine Isoparametric curve on a surface

Line Line or line segment

Plane Plane or planar face

Cylinder Cylinder

Helix Helix

FilletSurface Procedural Fillet surface

SweepSurface Procedural Sweep surface

Tabulated Cylinder Procedural Extrude surface

IntCurve Intersection curve, that is resulting from 
the intersection of two surfaces

MergedCurve The aggregate of two curves with 
different limits or parameterizations
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Displaying a Part Symmetrically

This task shows you how to visualize a part symmetrically in relation to a plane, in a product context. 
This allows you to work on half of the geometry only, therefore with a smaller document size-wise, but to 
view the final element as a whole.

Open the Product_to_symmetrize.CATProduct document.

1.  Expand the tree down to the Part5, then double-click it.

The Part5.CATPart now can be edited within the FreeStyle Shaper workbench.

2.  Click the Visual Symmetry  icon.

3.  Select the Part to be 

mirrored from the 

specification tree.

4.  Select the mirror plane.

It can be a plane or any 

planar face that the system 

recognizes as a plane (a 

planar face of a pad, for 

example, and so forth).

260Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



A part, symmetrical  in relation to 
the selected plane, is displayed.

The part is also duplicated in the 
specification tree. However, even 
though it will be saved within the 
document, this part cannot be 
edited as geometry. It is modified 
only as the result of modifications 
performed on the initial part: 

Indeed you are not even allowed to 
select the mirrored elements in the 
geometry.
If you select a mirrored element in 
the specification tree, you will note 
that the highlighted geometry 
belongs to the initial part. 
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5.  Click the Control Points 

icon . 

The Control Points dialog 

box is displayed.

6.  Choose the adequate 

options and modify the 

initial part as needed.

The mirrored part 

reflects exactly the 

modifications imposed on 

the initial part. 

7.  Click OK in the Control Points dialog box.

You can then save and close the .CATPart and .CATProduct documents. The mirrored part is retained, and 
is present when you open these documents again.
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Analyzing Using Parameterization
This task enables to analyze the CATPart structure and shows how to isolate specific features within a 
part. This is particularly useful when managing power copies, for example.

Open the Parameterization1.CATPart document.

1.  Select Tools -> Parameterization Analysis...

The Parameterization Analysis dialog 
box displays. 

 

      

2.  Use the Filter combo and choose to 

display Root Features. 

The query is launched and the viewer 

automatically updates. 

 Deactivated features as well as datum 
features are displayed.
However, if you want to display 
deactivated features only, select the 
Inactivated Features filter. Similarly, 
select the Isolated Features filter to 
display both deactivated and datum 
features.
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3.  Click the Display Body Structure icon 

 to display the graph keeping the 

tree structure.

Each feature is displayed within its 

own body.

●     Features displayed in the viewer can be used in the same way as in the specification tree: double-click 
a feature to edit it, or use the contextual menu to reframe on or display its properties, for example.

●     The viewer can still be open while performing other operations.
Available filters are:

❍     All Sketches

❍     Over-constrained sketches

❍     Fully-constrained sketches

❍     Under-constrained sketches

❍     Inconsistent sketches

❍     External references

❍     Inactivated features

❍     Root features

❍     Leaf features

❍     Isolated features

❍     Feature in error

❍     Waiting for update features

❍     Features with stop update

❍     Features with active stop update

❍     Knowledge formulas, Rules, and Checks
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Managing the Compass

This task shows you how to quickly manage the compass orientation.

Create a planar surface.

Press F5 or click the Quick Compass Orientation icon  .

The Quick compass orientation toolbar is displayed.

Here are summarized the main features of its eight 
icons:

●     Click the Flip to UV or XY , Flip to VW or YZ  or Flip to WU or XZ  icon to switch the 

compass base to the three planes of its trihedron.

If the compass is "in" the main axes of the model, the icons indicate X, Y and Z otherwise U, V 
and W.

●     Click the Most Seen Plane icon  to activate and deactivate the Most Seen Plane mode.

●     Click the Set Compass Orientation icon  or press F6 to orientate the compass by selecting 

either an existing plane or three points (via the Autodetection command).
The point selection is based on Autodetection parameters.

Please refer to the chapter called Editing Curves Using Control Points documentation to orientate the 
compass using control points.

●     Click the Reset Compass to XYZ icon  or press F7 to reset the compass parallel to the main 

axes (X, Y and Z) of the model.
This option is not active when the compass is already set according to the axes.

●     Click the In Model or on Perch icon  to switch the compass from the perch to the model or vice 

versa.
The origin is kept in the model until the toolbar remains open.

●     Click the Create Compass Plane icon  or press F8 to drop the compass plane, that is to create a 

plane corresponding to the compass basis.
This icon is activated only when the compass is in the model.
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These four shortcuts (F5, F6, F7 and F8) are effective only when the Quick compass orientation toolbar is 
displayed. Therefore when you first hit one of the keys, the toolbar is displayed and the shortcuts are 
effective from then on.

The Quick compass orientation toolbar remains active until you close it by clicking the cross in the upper-
right corner or, if you have activated it with the icon, by clicking the icon again.

By default, elements are created in the current active plane as defined using the Current plane 

orientation toolbar containing the Flip to UV or XY , Flip to VW or YZ   or Flip to WU or XZ 

 icons.
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Using Manipulators
When working with the FreeStyle workbench a number of manipulators are displayed, allowing you to modify the shape of curves and 
surfaces. These manipulators are displayed as green dots with two to four arrows, depending on whether they are constrained in a given 
plane or allowed to move freely in space, respectively. 

When using the Control Points capability (  icon) the points are constrained according to the chosen Support and Law options (see 

Editing Curves Using Control Points and Editing Surfaces Using Control Points).

Open the Manipulate2.CATPart document.

1.  Select both surfaces.

2.  Click the Control Points icon .

3.  Click the Snap on Ctrl points in the Dashboard.

4.  On the blue surface select only one control point.

All other points turn to green and the selected point is highlighted.

5.  Move this point close to the other surface. 

As the pointer nears a control point onto the other surface, the Use this point text is displayed, and the point on the second 
surface is identified by a dotted circle.

If you release the mouse button then,  the selected point on the blue surface is located at the orthogonal projection to the point 
detected on the second surface, onto the support as defined in the dialog box. This projected location is identified by a red circle 
connected to the detected  point on the second surface by a dotted line.

Using a point for a projection Resulting deformed surface
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An alternative method consists in selecting the first (yellow) surface 
first, clicking the Control points icon, then selecting the second  
(blue) surface. In this case, the first surface's control points turn 
gray and remain frozen. This is especially useful when using the 
Move selected points identically option from the Control Points 
dialog box, and in P1 mode.

6.  Press the Control key: the text changes to Snap on this point.

In this case, the selected point is moved exactly to the location of the point on the second surface identified as the point to be 

snapped to, as if they were merged.

Snapping onto a point Resulting deformed surface

The snap onto a point is possible only when the selected point is not constrained onto a specific element. For example, when matching the 

two surfaces,  the manipulators are only allowed to move, and snap on points, along the other surface's edges. Using a point or snapping 

onto it is identical, as the manipulators are constrained on the surface's edge:

Using the Shift key to use a point Using the Shift + Ctrl keys to snap onto a point

Resulting matched surface
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Capabilities are also available from the contextual menu when right-
clicking a control point, and depending on the geometry, with the 
following capabilities:

       
a.  Edit: the Tuner dialog box is displayed, letting you

-specify the exact position of the control point in space

- define a step value by which a control point/mesh line 
moves (Step field).

Once the value has been defined in the Tuner dialog box,  
press and hold the Shift key then click one of the 
manipulator's arrow to move the selected control point by 
the defined step value.

b.  Keep this point: allows you to keep the current point at its 
location.
A Point.xxx appears in the specification tree

c.  Keep all points: allows you to keep all the control points
All the points appear in the specification tree

d.  Freeze: enables to set control points inactive according to the defined constraint.
e.  Project on the plane
f.  Project on the normal
g.  Harmonize
h.  Select All: enables to select all control points
i.  De-Select All: enables to de-select all control points

Note that using the contextual menu on an element,  when several element have been selected, applies the chosen capability 
on this element only, and not on the whole selection. However, if you apply the same capability from the Control Points dialog 
box,  a given all the selected elements will be affected.

●     Use the F5 key to move the manipulators into a different plane of the compass, when they are not constrained within a given direction. 
See Managing the Compass.

●     Use the Shift key to activate/deactivate temporarily the auto-detection capability on the point you are currently trying to snap, or not, 
to another element.
When no auto-detection mode is active, manipulators will be snapped onto corners or onto another manipulator.

Snapping is available in P2 mode only.
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Defining an Axis System
This task explains how to define a new three-axis system locally. There are two ways of defining it: either 
by selecting geometry or by entering coordinates.

Open the PowerCopyStart1.CATPart document.

1.  Select the Insert -> Axis System  command or 

click the Axis System icon .

The Axis System Definition dialog box is 
displayed.

An axis system is composed of an origin point and three orthogonal axes.
It can be right or left-handed. This information is displayed within the Axis System Definition dialog box.
You can choose from different types of axis system: 

●     Standard: defined by a point of origin and 
three orthogonal directions (by default the 
current directions of the compass)

Here only the point was selected and nothing 
specified for the axes.
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●     Axis rotation: defined as a standard axis 
system and a angle computed from a 
selected reference

Here the Y axis was set to the standard axis 
system Y axis, and a 15 degrees angle was set 
in relation to an edge parallel to the X axis.

●     Euler angles: defined by three angle values 
computed from the initial X, Y, and Z 
directions

Here, the Angle 2 and Angle 3 were set to 30 
degrees. 

2.  Select the point as shown to position the origin of the axis system you wish to create. The 

application then computes the remaining coordinates. Both computed axes are then parallel to 

those of the current system. The axis system looks like this:
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3.  If you are not satisfied with x axis, for instance click the X axis field and select a line to define a 

new direction for x axis.

The x axis becomes colinear with this line.

●     It can be a line created along the surface edge, for 
example, using the Create Line contextual menu on 
the selection field, and selecting two surface vertices.
Similarly you can create Points, and Planes.

●     You can also select the Rotation contextual menu, and 
enter an angle value in the X Axis Rotation dialog box.
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4.  Click the y axis in the geometry to reverse it.

Checking the Reverse button next to the Y Axis field reverses its direction too.

5.  You can also define axes through coordinates. 

Right-click the Z Axis field and select the 

Coordinates contextual command. The Z Axis 

dialog box appears.

6.  Key in X = -1, retain the Y and Z coordinates, and 

click Close.

The axis system is modified accordingly, and is 
now left-handed.
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7.  Click More to display the More... dialog box.

The first rows contains the coordinates of the origin point. The coordinates of X axis are 

displayed in the second row. The coordinates of Y and Z axis are displayed in the third and 

fourth row respectively.

As you are defining your axis system, the application detects if its axes are orthogonal or not. 
Inconsistencies are revealed via the Update diagnosis dialog box.

8.  Uncheck the Current option if you do not want to set your axis as the reference. The absolute axis 

at the bottom right of the document then becomes the current axis system.

9.  Click OK.

The axis system is created. It is displayed in the 
specification tree. 
When it is set as current, it is highlighted as shown aside.
Local axes are fixed. If you wish to constrain them, you need to isolate them (using Isolate contextual 
command) before setting constraints otherwise you would obtain over-constrained systems.
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The display mode of the axes is different depending on whether the three-axis system is  right-handed or 

left-handed and current or not. 

THREE-AXIS SYSTEM CURRENT AXIS DISPLAY MODE

right-handed yes solid

right-handed no dashed

left-handed yes dotted

left-handed no dot-dashed

 

Right-click Axis System.1 from the specification tree and select the Axis System.1 object -> Set as 
current contextual command. Axis System.1 is now current. You can then select one of its plane, to 
define a sketch plane for example.

Editing an Axis System 

You can edit your axis system by double-clicking it and entering new values in the dialog box that 
appears. You can also use the compass to edit your axis system. 

Note also that editing the geometrical elements selected for defining the axes or the origin point affects 
the definition of the axis system accordingly.

Right-clicking Axis System.X object in the specification tree lets you access the following contextual 
commands:

●     Definition...:redefines the axis system

●     Isolate: sets the axis system apart from the geometry

●     Set as Current/Set as not Current: defines whether the axis system is the reference or not.
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Using the Stretch View Analysis Tool

This command is only available with the FreeStyle Optimizer.

This task shows how to use the stretch view tool prior while analyzing a FreeStyle element.

Stretching means distorting the space view, without affecting the element itself. It is especially useful to examine precisely the curvature of an 
element from different viewpoints and with specific angles.
This stretching is done according to a ratio between the Y and X axes (Y/X) taking the screen as a reference into the active window.

Open the Stretch1.CATPart document. 

To make it more explicit, we choose to open two windows (Window -> New Window) and to display them horizontally (Window -> Tile 

Horizontally).

1.  Select a surface and click   to display the control points on the surface in 

both windows.

The Control Points dialog box is displayed.

2.  Click the Stretch View icon .

The control points are grayed out, meaning you cannot use them for 
geometry modifications, and the Stretch View dialog box is displayed:

3.  Modify the value in the Stretch View dialog box.

With a value of 0.5, the geometry looks like this: With a value of 1.5, the geometry looks like this:
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4.  Click Reset.

The default value is taken into account (1.00). The view no longer is stretched.

You could also stretch a specific area of the screen, using a trap.

The center of the trap (cross) becomes the center of the screen.
Using the Ctrl-key, the trap center will be located where you click first. 

277Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



The resulting stretch looks like this:

5.  Click Close, the views remains, and you can continue to deform the surface as you wish, using the control points.

●     Whatever the stretch options you choose, you can continue to use any other FreeStyle Shaper or Optimizer capability.
For example, you could apply the Curvature analysis. 
To the left the curvature analysis with no stretch, and to the right, the stretched curvature analysis.
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●     Even though the stretch is performed in reference to your screen (X is the horizontal axis and Y the vertical one), you can still manipulate 
the geometric elements as usual. You can rotate, move elements and so forth.
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Manipulating Views
This command is only available with the FreeStyle Optimizer.

By default, the Standard View Manipulation 
 is active. In this mode, the four main manipulations, used to define the 3D viewpoint, are 

available. 

1.  translation
2.  zoom (in or out)
3.  rotation
4.  focusing on a specific point (double-click on mouse key 2).

This task shows you how to constrain views, in order to set a specific viewpoint.

Open the ManipulateViews1.CATPart document.
When opening the document, you should see something like this:

1.  Press and hold key 2 then 1 of the mouse, and drag to rotate freely in space.
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2.  Display the whole Manipulating Mode toolbar (under the   icon). 

3.  Click the Rotation About Z Screen Axis   icon.

Still holding both mouse keys, you can now only rotate about the Z screen axis.

If you release key 1, but still hold key 2, you are able to zoom as usual. 

4.  To redefine the tuning, refer to the FreeStyle settings and the Setting the Manipulators Attenuation Factor chapters.

The tuning defines the movement amplitude, i.e. if you decrease the value, movement will seem slower.

This is especially useful when working in Stretch view mode.

This attenuation step definition is also affected by the Tuning value defined in the general 

5.  Similarly you can click the Rotation About X Screen Axis  or Rotation About Y Screen Axis   icon to rotate around 

the screen X or Y axis respectively.

6.  If you click the Zoom And Translate  icon.

No rotation whatsoever is allowed.  

●     Simply click the Standard View Manipulation   icon to reset the default options.

●     Still holding down mouse keys 1 and 2,  use keyboard shortcuts  to manipulate views according to pre-set steps: 
❍     90° around the Z screen axis, using the Up/Down keys

❍     90° around the X screen axis, using the up and down arrows

❍     90° around the Y screen axis, using the right and left arrows

●     Similarly, using the right and left arrows, you can zoom in and out.

●     When changing viewpoints, you may wish to come back to a preceding viewpoint. To do this, simply click  to move 

backward or  to move forward in the viewpoints. 
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Defining Views

This command is only available with the FreeStyle Optimizer

This task shows you how to rapidly define a viewpoint, using the compass on the geometry.

Open the ManipulateViews1.CATPart document. 

1.  Drag the compass onto the exact point of geometry, 

that you want to see. 

This also defines the viewing direction. 

2.  Click the Interactive Viewpoint Definition  icon.

The viewpoint changes immediately. You now 

watch the geometry from above the compass, at 

the point where you dropped that compass.
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3.  Click the Reverse Viewpoint  icon.

The viewpoint changes immediately. You now can 

see the geometry from under the compass, at the 

point where you dropped that compass.

4.  Click again if you want to reverse it again.

When changing viewpoints, you may wish to come back to a preceding viewpoint. To do 
this, simply click  to move backward or  to move forward in the viewpoints.
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Creating Datums

 

This task shows how to create geometry with the History mode deactivated.
 In this case, when you create an element, there are no links to the other entities that were used to 
create that element.

1.  Click the Create Datum icon  to deactivate the History mode.

It will remain deactivated until you click on the icon again. 

If you double-click this icon, the Datum mode is permanent. You only have to click again the 
icon to deactivate the mode. 

A click on the icon activates the Datum mode for the current or the next command. 

 
The History mode (active or inactive) will remain fixed from one session to another: it is in fact a setting.
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Performing a Symmetry on Geometry 

 
This functionality is P2 for FreeStyle Shaper, Optimizer, and Profiler.

 
This task shows you how to transform geometry by means of a symmetry operation.

Open the Transform1.CATPart document.

 
1.  Click the Symmetry icon .

 

The Symmetry Definition dialog box 
appears as well as the Tools Palette.

2.  Select the Element to be transformed by symmetry.

3.  Select a point, line or plane as Reference element.

The figure below illustrates the resulting 

symmetry when the line is used as reference 

element.

The figure below illustrates the resulting 

symmetry when the point is used as reference element. 
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4.  Click OK to create the symmetrical element.

The element (identified as Symmetry.xxx) is added to the specification tree.

●     Use the Hide/Show initial element button to hide or show the original element for the translation.

●     Choose whether you want the result of the transformation to be a surface or a volume by switching to 
either Surface or Volume option. This switch only concerns volumes since the transformation of a 
surface can only be a surface. Thus in case of multi-selection of volumes and surfaces, the switch only 
affect volumes.
To have further information about volumes, please refer to the corresponding chapter.

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.
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Keeping the Initial Element

This task shows you how to retain an element on which you are performing an operation. When this 
command is active, as soon as you perform an action in which you create or modify geometry, in fact, you 
are working on a copy of the initial element.

Open the Offset1.CATPart document, or any .CATPart document containing FreeStyle elements.

1.  Select a surface and 

click the Offset icon 

 for example.

The Offset dialog 

box is displayed. 

The offset surface 

is automatically 

visualized as a 

meshed surface. 

2.  Click the Keep Original icon  from the FreeStyle Dashboard.

3.  Click OK in the 

current command.

The initial element 
remains 
unchanged and a 
new element is 
created.
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Had you not 
clicked on the 
Keep Original 

icon , the 

initial element 
would have been 
replaced by the 
newly created 
element.

The Keep original icon remains active once you click OK, providing it was active while performing the 
command (and vice-versa).
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Inserting in a New Geometrical Set

This task shows how to insert the result of an operation in a new geometrical set.

It is  only available with the Break (Curve and Surface), Disassemble, Copy Geometric Parameters, and 
Dress-Up commands.

 Let's take an example with the Break Surface command.

Open the Break1.CATPart document.

1.  Click the Break icon .

The FreeStyle Break dialog box 

displays.

2.  Choose the Surfaces by curves 

break type.

 

 

3.  Click the Insert in a new 

geometrical set icon  in the 

FreeStyle Dashboard.

4.  Select the surface to be cut. 

5.  Select the cutting curve(s).

6.  Click OK.
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All the created surfaces resulting from 
the break are displayed in a new 
geometrical set in the specification tree.

For further information about the Break command, please refer to the following chapters: Redefining 
Surfaces Limits and Trimming Curves.
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Creating a Temporary Analysis

This task shows how to create a temporary analysis during the creation process of a feature.

This command is only available with the 3D curve, Fill, Net and Sweep commands.

Let's take an example with the 3D curve command.

Open a  new .CATPart document.

1.  Click the 3D 

Curve icon 

.

The 3D curve 

dialog box is 

displayed.

2.  Choose the 

Through 

points type.

 

3.  Select the 

points.

4.  Click the 

Temporary 

Analysis 

mode icon 

 in the 

FreeStyle 

Dashboard.

5.  Select the 

analysis of 

your choice in 

the Shape 

Analysis 

toolbar. In our 

example, we 

chose the 

Porcupine 

Curvature 

Analysis.
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6.  Click OK in the 

Curvature 

Analysis dialog 

box.

7.  Select another 

point in the 3D 

curve 

command.

The temporary 

analysis is 

updated 

accordingly.

 
You must activate the temporary analysis mode before running any analysis. Otherwise, a persistent FreeStyle analysis will be 
performed.

The Temporary 
Analysis node is 
displayed in the 
specification tree and 
the associated analysis 
(here Curvature 
Analysis.1) appears 
below.

   

The analysis is not 
persistent. Thus when 
you click OK in the 3D 
curve dialog box to 
create the curve, the 
Temporary Analysis 
node disappears from 
the specification tree.

You can perform several analyses while in the Temporary Analysis command: all of them will appear in the specification tree under 
the Free Form Analysis node.
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Auto-detection

The Auto-detection tool enable you to perform a remote point selection which is especially useful for 
selecting on the fly point on geometry.
This is also useful to position the compass at a specific location on an element, to define the local axis-
system.

1.  Choose one of the four detection types from the FreeStyle Dashboard:

●     Click the Snap On Vertex icon  to detect the closest corner of the selected element.

●     Click the Snap On Edge icon   to detect the closest border (edge) of the selected 

element.

●     Click the Snap On Cpt icon  to detect the closest control point on the selected 

element.

●     Click the Snap On Segment icon  to detect the the closest segment of the selected 

element

2.  Move the pointer close to the geometric element you wish to snap to.

The specified element (corner, border, control point or segment) is automatically detected and 

selected.

●     When checking  the Search Dressing option from the Tools -> 
Options -> Shape -> FreeStyle tab, and the Snap On Cpt icon 

 the system automatically displays the control points on the 

geometry detected below the pointer, provided a command is 
running.
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If this Search Dressing option has not been checked, yet 
the Snap On Cpt option is active, the auto-detection still is 
available, but the control points are not displayed. 

●     Use the Shift key to activate/deactivate temporarily the auto-detection capability on the point you are 

currently trying to snap, or not, to another element.
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Setting the Manipulators Attenuation Factor

This task shows you how to set the attenuation value for the manipulator's displacement.
The attenuation lets you define the ratio between the mouse displacement and the actual displacement of 
the manipulator in the geometry. This attenuation factor is saved in the application's settings, and is 
defined in the FreeStyle Settings.

Open any .CATPart document containing FreeStyle elements.

1.  Choose one of the four attenuation ratio from the FreeStyle Dashboard:

●     Click the No Attenuation icon  to use the attenuation value as set in the FreeStyle 

General Settings (default value)

●     Click the Slow icon   to use the square default attenuation value 

●     Click the Medium icon  to use the cubic default attenuation value 

●     Click the High icon  to use the 104 default attenuation value 

Each attenuation value equals the previous value (in the dashboard) multiplied by the default value.
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Displaying Manipulators On Elements

This task shows you how to display manipulators on elements and how to modify their values.
Three types of manipulators can be displayed on a given element, whether the selected or the resulting 
element: 

1.  continuity 
2.  contact points 
3.  tension (P2 only)
4.  U and V orders 

These manipulators are displayed either by using the Dashboard (P2 only) as illustrated in this task, or 
by checking the adequate option in Tools -> Options -> Shape -> FreeStyle. Once they are displayed, 
their behavior is identical regardless of the chosen interface style.

Displaying Continuity

Open the MatchSurface1.CATPart document.

1.  Click the Match Surface icon  and select the two edges to be matched (see Matching 

Surfaces).

2.  Click the Continuity icon 

 from the Dashboard.

Texts indicating the 

continuity type 

wherever available are 

displayed. 

3.  Right-click on a text to 

display the contextual 

menu, and choose the 

Curvature continuity 

item.
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You can also simply click the text. 
It will automatically change to the 
next type. 
Click as many times as needed to 
go down to the desired continuity 
type.
Shift-clicking goes up in the list.

The text changes to 
Curvature and the 
elements are updated 
in accordance.

In some cases the chosen type of continuity is not compatible with the geometry or the modification. In 
that case, a warning is displayed directly onto the geometry at the location where the inconsistency 
arises. You can then change the continuity, or modify the geometry itself.

A forbidden sign  may even be displayed and the system will prevent you from modifying the element 
in a specific direction, if it does not make sense geometrically speaking.

 
Displaying Contact Points

Open the BlendSurface1.CATPart document.

1.  Click the Blend Surface 

icon , and select an 

edge on each surface.

The blend surface is 

computed. 
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2.  Click the Contact Points 

icon  from the 

dashboard.

Manipulators are 

displayed on the 

connection, allowing 

you to interactively 

define the blend limits 

by simply sliding them 

along the boundaries.

You can edit the 
contact points by right-
clicking any of them to 
display the contextual 
menu and choosing the 
Edit item.
The Tuner dialog box 
opens to let you key in 
a new value, in 
percentage of the total 
boundary.

Displaying Tensions (P2 
only)

Open the BlendCurve1.CATPart document.

1.  Select two curves and click the Blend Curve icon .

The blend curve is previewed. 
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2.  Click the Tensions icon 

 from the Dashboard.

Green segments 

representing the 

direction and limits 

tension are displayed.

You can modify the 

tension by sliding the 

displayed value along 

the green segment.

 

You can also edit the 

value, or invert the 

tension direction, using 

the contextual menu on 

the value. 

 

 

 
Displaying U, V Orders

Open the MatchSurface1.CATPart document.

1.  Click the Match Surface icon  and select the two edges to be matched (see Matching 

Surfaces).

299Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



2.  Click the U, V Orders icon 

 from the Dashboard.

Numbers are displayed 

on the geometry, 

indicating the order 

number of the element 

along the U and V 

directions.

3.  Right-click on a text to 

choose another order 

value

You can also simply click the text. 
It will automatically change to the 
next digit down the list. 
Shift-clicking goes up in the list.

 The Automatic option enables you 
to modify the order and the 
segmentation of the matching 
surface so that the continuity is 
respected.
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The surface order is 

instantly modified, but 

you will see it only 

when using the Control 

Points icon for 

example:

For curves, only the order along U is displayed.
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Displaying Control Points Temporarily

This task shows you how to temporarily display control points geometry while in a FreeStyle command.
Once you exit this command, the control points are removed as opposed to those displayed using the 
permanent visualization options (see Setting FreeStyle Visualization Options).

Open the MatchCurve1.CATPart document, or any .CATPart document containing FreeStyle elements.

1.  Check the Control Points option in the Display area of the Tools -> Options -> Shape -> 

FreeStyle -> General tab or click the Furtive Display icon  from the Dashboard (P2 only).

2.  Click the Match Curve icon .

3.  Successively select two curves.

The first curve is automatically modified so as to be connected 

to the second curve.

Control points are displayed in blue on the matched curve. 

4.  Click OK in the current command. 

Multi-selection is available, meaning that if several elements are involved in the current command, if 

there were two curves to be projected for example when using the Project Curve icon  the control 

points are displayed on all the resulting elements. 
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Inserting Geometrical Sets

This task shows how to insert a new geometrical set entity in the specification tree.

Open the ConnectChecker2.CATPart document, or any .CATPart document already containing at least one 
geometrical set and geometric elements.

1.  In the specification tree, using the Define in Work 

Object contextual command, select the element at which 

level you want the new geometrical set to be inserted.

This element defines the father location for the insertion of 

the new geometrical set.

 
2.  Select the Insert -> Geometrical Set menu command.

The Insert Geometrical Set dialog box is displayed.

The Features list displays the elements to be contained 

in the new geometrical set.

3.  Enter the name of the new geometrical set.

4.  Select additional entities that are to be included in the new 

geometrical set.

If all selected entities belong to the same geometrical set, the 
father of the new geometrical set is automatically set to the father 
of these entities.
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5.  Click OK to create the geometrical set at the desired 

location.

The result is immediate. CATIA displays this new 

Geometrical_Set.x, incrementing its name in relation to 

the pre-existing bodies, in the specification tree. It is 

created after the last current geometrical set and is 

underlined, indicating that it is the active geometrical 

set. 

6.  Use the Geometrical_Set2.object -> Change 

Geometrical Set... contextual command on the newly 

created geometrical set.

7.  Select the Geometrical_Set.1 in the specification tree, 

then click OK in the Change Body dialog box.  

The selected geometrical set has been moved last in 
the initial Geometrical_Set.1 and is still active.
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Selecting a Support 

This task shows you how to select a support in the case several supports are detected; for example the internal 
edge of a join, or a curve resulting from an intersection.
If a cell of the selected element relies on more than one support, you can choose the support you need.

 It is available with the following functionalities:
●     Blend surfaces

●     Match curves

●     Fill Surfaces

●     Net Surface

●     Styling Sweep

    

 Let's take two examples using the Blend functionality:
●     Creating a blend between a surface and a join

●     Creating a blend between two joined entities

 In both cases, the number of generated faces will be equal to the number of joined edges.

Open the Multi-Supports1.CATPart document.

Creating a blend between a surface and a join

 
1.  Click the FreeStyle Blend Surface icon .

 

The blend surface is previewed, and 
the Blend Surface dialog box is 
displayed.
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2.  Move the pointer over the 

edge of a surface and click on 

it.

 

 

3.  Move the pointer over the 

edge of the second surface 

and click on it.

 

 

The information tag is displayed to inform you that only one surface can be selected for the blend operation.

 

The blend surface is 
previewed.

 

4.  Click Cancel in the Blend 

Surface dialog box.

 

 
5.  Hide the Boundary.1 curve: right-click it in the specification tree and choose Hide/Show from the contextual 

menu.

 
6.  Perform steps 1 and 2 again.
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7.  Move the pointer over the 

edge of the second surface.

An information tag  is 

displayed informing you 

that two or more surfaces 

can be selected. 

 

 

8.  Right-click the tag to display 

the number of solutions and 

choose which support to keep 

for the blend operation. 

 

 The blend surface is 
previewed.

 
9.  Click OK in the Blend Surface 

dialog box to create the blend 

surface.

 

Creating a blend between two joined entities

 
1.  Click the FreeStyle Blend Surface icon .
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The blend surface is previewed, and 
the Blend Surface dialog box is 
displayed.

 

2.  Move the pointer over a curve 

and click on it.

 
3.  Move the pointer over the 

edge of a surface and click on 

it.

An information tag  is 

displayed informing you 

that only the selected 

surface only relies on one 

support. 

 The blend surface is 
previewed.
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4.  Click OK in the Blend Surface 

dialog box to create the blend 

surface.

 

The User Selection Filter toolbar is 
available with this functionality.

In the above example, had you 
deselected the Feature Element Filter 
mode, the Blend Surface would have 
been created between a surface and 
a 3D curve (and not between Join.1 
and Join.2) 
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Editing and Keeping a Point

This task shows you how to edit a point and keep it at its location.

1.  Move the pointer to a point (control point, contact point or limit point 

for example), right-click to display the contextual menu. 

   

 
2.  Choose the Edit item.  

The Tuner dialog box is displayed, letting you specify the exact 

position of the point in space and define a step value by which a 

control point/mesh line moves (Step field).

Once the value has been defined in the Tuner dialog box, press 

and hold the Shift key then click one of the manipulator's arrow to 

move the selected point by the defined step value.

Checking the Relative option enables you to display the relative 

mode and specify the relative position of the point depending on 

its origin as shown in the model.

This option is not available for all functionalities.

 
3.  Choose the Keep this point item to create a point at this location.

A Point.xxx appears in the specification tree.

You can create a Point.xxx either on each control point or on the 

selected control points. 

●     Negative values are allowed.

●     This contextual menu is available each time manipulators are displayed in the geometry.
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Advanced Tasks
Using FreeStyle Optimizer

Interoperability Between the FreeStyle Shaper & Optimizer
Using FreeStyle Profiler

Interoperability with Part Design
Interoperability with Wireframe
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Using the FreeStyle Optimizer

The FreeStyle Optimizer offers complementary capabilities to the FreeStyle Shaper. It is used on the same type 
of elements yet taking the design capabilities one step further.

Fit a curve to a cloud of points: select the curve to be deformed and the target element, specify the 
fitting parameters and, if needed, the continuity constraints using the contextual menu, click Fit then 
OK.

Fit a surface to a cloud of points: Select the surface to be deformed and the target element, specify 
the fitting parameters and, if needed, the edge constraints using the contextual menu, click Fit then 
OK.

Globally deform a surface: Select a set of surfaces, if needed select the guiding curve, click Run, 
specify the deformation type and use the control points and mesh lines to deform the surface. 

Analyze reflect curves: Select a surface, specify the neons grid parameters (number, spacing, position, 
viewpoint.), manipulate the grid to analyze its reflection on the selected surface.

Analyze inflection lines: select a surface, set the compass orientation and click the icon to visualize 
inflection lines
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Fitting a Curve to a Cloud of Points

This command is only available with the FreeStyle Optimizer.

This task explains how to fit a curve to a cloud of points.

Open the FitCurve1.CATPart document.

1.  Select the curve you wish to deform by fitting it 

to the geometry.

2.  Click the Fit to Geometry icon .

The Fit To Geometry dialog box is displayed. 

3.  Select the target element, that is the element to which the curve should fit. 

Here, select the cloud of points.

4.  Define the fitting parameters in the Fitting area 

of the Fit to Geometry dialog box.

You need to specify the Curve tension , and 

Allowed smoothing  that have to be taken into 
account when modifying the curve to fit the existing 
geometry.
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5.  Use the contextual menu on the Free text to 

impose boundary continuity constraints: Free, 

Point, Tangent or Curvature.

This can be set for each end-point of the initial curve.

6.  Click Fit to accept the definition, once all parameters have been defined.

The curve is modified so as to fit as best the selected geometry, while taking the fitting parameters into 
account.

7.  Click OK in the Fit to Geometry dialog box to accept the new curve as fitted to the cloud of points.

●     Use the Ctrl key to select several curves to be fitted at a time.

●     You can iterate and click Fit several times. This lets you fine-tune the fit.

●     Use the Automatic trap option to reduce the number of points to be taken into account when the 
target element is a Cloud of Points containing many points.

Available capabilities from the dashboard are: datum creation, continuities and orders.
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Fitting a Surface to a Cloud of Points 

This command is only available with the FreeStyle Optimizer.

This task explains how to fit a surface to a cloud of points.

Open the FitSurface1.CATPart document.

1.  Click the Fit to Geometry icon .

The Fit To Geometry dialog box is displayed. 

2.  Select the surface, or set of surfaces, you wish to 

deform by fitting them to the cloud of points.

 

3.  Right-click the Free text on which you want to impose edge constraints.

You can choose from four constraint types:

 
●     Free: no constraint is imposed on this boundary

●     Point: the resulting surface will still pass through the 
boundary of the initial surface

●     Tangent: the edge of the resulting surface will be 
tangent to the initial surface at the selected boundary

●     Curvature: the resulting surface will be continuous in 
curvature with the initial surface at the selected 
boundary.
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4.  Define the deformation parameters from the Fit to 

Geometry dialog box:

●     Tension: indicates which tension 

coefficient is applied

●     Smoothing: defines the smoothing 

coefficient to be applied.

5.  Click Targets and select the target element in the geometry.

6.  Click Fit, the surface is projected onto the target geometry.

You can repeat the operation and deform the surface step-by-step. 

7.  When the results are satisfying, click OK in the Fit to Geometry dialog box.

The new surface fits the pre-existing cloud of points.

Using this item you can fit a surface to a cloud of points just as well as you can fit it to any other type of 
pre-existing geometry.

●     You can also choose to impose a direction when fitting the surface to the cloud of points meaning that 
the surface will be projected according to cloud of points, as shown to the left below, and no longer 
according to the normals to the initial surface, as shown to the right.
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 ●     You can iterate and click Fit several times. This lets you fine-tune the fit.

●     Use the Automatic trap option to reduce the number of points to be taken into account when the 
target element is a Cloud of Points containing many points.

Available capabilities from the dashboard are: datum creation, continuities and orders.

 

 

317Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Globally Deforming Surfaces

This command is only available with the FreeStyle Optimizer.

This task explains how to deform a set of surfaces in one operation.

Open the GlobalDeformation1.CATPart document.

1.  Select the surfaces to be deformed, using the Control key for multi-selection.

2.  Click the Global Deformation icon .

The Global Deformation dialog box 

appears, into which you can specify 

deformation options: using an 

intermediate patch or a user-defined 

axis.

In this case, use the default option: 

intermediate patch ( Intermediate 

surface use icon). 

 

3.  Click Run in the Global Deformation 

dialog box.

A transparent patch with control points 

and mesh lines is displayed. It 

represents the intermediate surface 

bounding box.

The Control Points dialog box is 

displayed.  

318Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Use it to define the type of operation to be 
performed on the control points. 

●     Support defines the type of translation to be 
applied

●     Law defines the type of deformation that is 
to be applied when several control points 
have been selected.

4.  Use the control points and the mesh lines 

of the planar patch to deform it. The 

space transformation is defined between 

the initial patch and the deformed patch.

All surfaces are automatically and 
dynamically deformed according to 
this intermediate patch deformation.

 
The final deformed surface looks like this.
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Open the GlobalDeformation2.CATPart 
document, select the surfaces to be deformed, 

and click the Global Deformation icon .

●     If you choose the 1 guide option, you then 
need to:

1.  Click Run in the Global Deformation 

dialog box.

2.  Select a guiding surface (here the blue 

surface).

The Control Points dialog box is 

displayed. Use the control points and 

mesh lines to deform the surface.

3.  Click OK in the Control Points dialog box.

The deformation is performed along the selected 
guide.

●     If you choose the 2 guides option:

1.  Click Run in the Global Deformation 

dialog box.

2.  Select two guiding surfaces.

The Control Points dialog box is 

displayed. Use the control points and 

mesh lines to deform the surface.

3.  Click OK in the Control Points dialog box.

The deformation is performed along both 
selected guides.
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●     If you check the Continuities on guide 
option, the system globally deforms the 
surfaces while retaining the continuities on 
the selected guide.
In our example, the top surface is selected as 
guide, and the Continuities on guide is 
checked.

●     When globally deforming re-limited surfaces, i.e. surfaces which limits have been redefined, make 
sure that you check the continuities between faces. Indeed, depending on the geometrical 
configuration, it may happen that the set continuities are lost when deforming.
 

●     Available capabilities from the dashboard are: datum creation, auto detection, attenuation,  continuity, 
orders, and

keep original.
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Analyzing Reflect Curves

This command is only available with the FreeStyle Optimizer.

This task explains how to apply reflect curves onto a surface for analysis purposes.

Open the Manipulate1.CATPart document.

1.  Select one or more surface(s).

2.  Click the Reflection Lines icon .

The compass automatically is positioned above 
the surface and a grid of neons is displayed. Each 
neon is represented by a red line. It is an endless 
neon, and reflect lines are displayed in red over 
the surfaces.

The Reflection Lines dialog box is displayed from which you can define a number of parameters:
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●     The number of Neons and the spacing between any two 

neons.

●     The position: this option automatically calculates the 
position of the neon grid (according to the surfaces).

●     The viewpoint: 
❍     according to the current 3D viewer: reflect lines are 

re-computed according to the new viewpoint when 
you are using standard viewing manipulators.

❍     according to the user-defined viewpoint reflect lines 
do not move, when you are using standard viewing 
manipulators,  but you can move the eye.

3.  Move the grid using either the standard compass 

manipulators, or the grid manipulators to display a 

rotation direction and an axis.

4.  Click the dot and still holding the mouse-key down, 

slide the pointer about the rotation axis.

Reflect lines on the surface evolve as you modify 
the position of the grid of neons, allowing you to 
analyze the reflection onto the surface.

Use the Edit angle step contextual menu on the grid manipulators to allow the rotation of the grid by a 
value defined within the Step dialog box.
In this case, clicking one of the grid manipulators rotates the grid by the set value.
Press and hold the Shift key to rotate in the opposite direction.

5.  Once you are satisfied with your analysis, simply click OK in the Reflection dialog box.
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●     You can select and deselect the analyzed surfaces, while applying the analysis. The reflect lines will 
appear or disappear respectively.

●     When you select the geometrical set as an input in the specification tree, all the elements included in 
this geometrical set are automatically selected too. 

●     When you click the User-defined  Eye icon ,  a dot is displayed (you need to zoom out to locate 

it) defining the eye and its position.
The reflect lines are frozen according to that direction, meaning that you can move the geometry 
around while keeping the reflect lines static according to that viewpoint.
You can moved the eye using manipulators, or using the Edit contextual menu to precisely define its 
location.

●     You can drop reflect lines onto the analyzed element. To do this, simply choose the  Keep this 
reflection line or Keep all reflection lines from the contextual menu displayed when right-clicking 
either a reflection line itself or one of the grid neons.
A curve corresponding to the reflection line is created.

●     A Reflect Lines Analysis is created in the specification tree. You can therefore create several such 
analyses on different set of surfaces or on the same set of surfaces but using a different viewpoint.

●     As reflect line analyses are objects as such, they can be edited using the contextual menu in the 
specification tree.
You can transfer a reflect line analysis from an element to another, for example. To do this: 

❍     Double-click the reflect line analysis from the specification tree

❍     Select the surface on which you wish to apply the analysis. Reflect lines are displayed on that 
surface provided the grid orientation is adequate.

❍     Select the surface on which the analysis existed, to remove it.

❍     Click OK in the Reflection dialog box

   

Available capabilities from the dashboard are: datum creation, auto detection, and attenuation.
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Creating Inflection Lines

This task shows how to create inflection lines on a surface for analysis purposes.
Inflection lines are curves which curvature value necessarily is 0.
The system detects, within the planes parallel to the one defined by the compass, all points of the surface 
at which the curvature value is null, meaning that in these points, the curvature orientation is changing, 
and links them together into curves.
Open the InflectionLine1.CATPart document. 
It contains a surface on which a cutting plane Analysis has been performed.

1.  Drag and Drop the compass onto the zx plane.

2.  Select the surface to be analyzed.

3.  Click the Inflection Line icon  in the Shape Analysis toolbar.
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The compass is automatically positioned on the selected element, 
and the Inflection lines dialog box is displayed.

4.  Define the plane used to compute the inflection lines on the surface: 

●     the compass base plane (Compass Plane)

●     the surface parametric directions (Parametric)

Once the local plane is defined, inflection lines are automatically displayed on the surface.

 

5.  Hide the Cutting Plane analysis, using the Hide/Show icon  for example, to see the inflection 

lines better.

6.  Grab the compass by its tip (w) and drag it along.

The compass base plane's orientation being modified, the inflection lines are updated 

accordingly:
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7.  Click OK in the Inflection Line dialog box to create the analysis as an element in the specification 

tree.
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●     Creating and retaining inflection lines on a surface is especially useful to determine at which points the 
curvature of the intersection between the cutting planes and the surface is null.

●     Used in conjunction with the Inflection area option of the Surfacic Curvature Analysis command, you 
can notice that these lines always are created within the blue.

●     When you select the geometrical set as an input in the specification tree, all the elements included in 
this geometrical set are automatically selected too.
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Interoperability Between the FreeStyle Shaper 
and Optimizer

The following scenario illustrates, in an industrial environment, how to work with the FreeStyle Shaper and 
Optimizer specific commands. This scenario is performed in P2 mode, because some of the capabilities used 
throughout the scenario are available with the P2 configuration only (all FreeStyle Optimizer capabilities for 
example)

 

Creating Four-Points Patches
Deforming the Surface Limits

Fitting the Surface to a Cloud of Points
Analyzing the Surface
Smoothing the Surface
Extracting the Surface 

 
This scenario is accomplished in ten minutes. It consists in creating the surface corresponding to the roof 
of a car.
The resulting roof surface will look like this:
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Creating Four-Points Patches

 
This task explains how to create a pad from a sketch in the Part Design Workbench.

 

Open the  RoofStart.CATPart document. It contains windshields of the car, style curves limiting these 
(windshield boundaries) style curves, onto which the roof should be mapped, and curvature analyses 
applied onto each of these styling curves.
You can hide the Reflect Line Analysis for the moment.

 
1.  Check the Snap On Vertex  icon from the FreeStyle Dashboard to snap onto the closest 

corner when moving the pointer close to the geometry

2.  Click the Four-Point Patch icon  .

3.  Click the four style curve end-points (yellow  styling D curves) as limits to the roof patch.

Because the auto detection capability has been activated, the end point are easily detected.

The patch is created.
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Deforming The Surface Limits

 
This task explains how to modify the surface limits within a given plane (in 2D)  to get them to coincide 
with the already existing geometry.

 
The  RoofStart.CATPart document still is open from the previous task.

 
1.  Hide the three Curvature Analyses, using the Show/Hide contextual menu from the specification 

tree.

2.  Drag the compass by its base and drop it to position it, normal to the ZX reference plane.

3.  Choose the Top View icon  from the View toolbar.

This will allow you to position the symmetry plane according to the current plane.

4.  Select  the surface you just created and click the Control Points icon . 

The Control Points dialog box is displayed.
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5.  Click the Symmetry icon  from the Control Points dialog box.

A message is issued asking whether you want to use the current plane, that is the one you 

defined above, as the symmetry plane

.  

6.  Click OK.

7.  Choose the following deformation 

options from the dialog box:

●     Support: Translation along 

mesh lines 

●     Law: Move selected points 

using a convex law 

8.  Click the top front control point, then 

press and hold the Shift key then click 

the bottom front control point. 

The whole front mesh line is selected.

9.  Use the manipulators on one of the 

corner control points to bring it closer to 

the orange reference curve.
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The mesh line takes the global shape 

of the reference curve, even though 

it does not match it perfectly yet. 

10.  Repeat this operation with the rear mesh line and reference curve.

11.  From the Control Points dialog box, select new options:

●     Support: Translation along local tangents 

●     Law: Move selected points identically 

12.  Select the front mesh line and drag it towards the reference curve so that it is superimposed.

Repeat this step with the rear mesh line and reference curve.
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13.  Select one of the side mesh lines and bring it closer to the orange reference curve till the patch 

corner reaches the curve's end points.

You need to iterate on the front and rear mesh lines, using the same options to reach a 

satisfying level of superimposition.
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For further tuning you need to zoom in and move single control points. 

14.  Select each patch corner point and move it exactly onto the reference corner point. 

You need to move them along both X and Y.

15.  Move each side control points to superimpose the patch boundaries and reference curves.

You need to move them along the Y direction only.

16.  Move the inner control points 2 by 2, using the Shift key, to move them closer to the patch 

center.

The patch now has the shape given by the reference curves.
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Fitting The Surface To a Cloud of Points

 
This task explains how to fit the deformed surface to an existing cloud of points.

 
The RoofStart.CATPart document still is open from the previous task.

 
1.  Reset the compass to the default position using the  and  icons.

2.  Select the roof patch as the source element.

3.  Click the Fit to Geometry icon  .

The Fit To Geometry dialog box is displayed 

and texts indicating the fitting constraints are 

displayed on the surface boundaries provided 

the Continuity icon  is active in the 

Dashboard.
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4.  Set the following parameters in the dialog box: 

❍     set the fitting tension to 0.5 and smoothing to 0.3

❍     make sure the Impose direction option is unchecked

❍     and from the Dashboard, click the U, V Orders icon  and make sure they are Nu=4 and 

Nv=4

5.  Select the Cloud of points as the target element.

It may be easier to select it from the specification tree than from the geometry itself.

6.  Click Fit in the dialog box.

7.  Click OK in the dialog box.
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Analyzing The Surface

 

This task explains how to analyze the surface, once it has been fitted onto the cloud of points. This is done 
via two different analyses: 

1.  a distance analysis 
2.  a reflect line analysis

 
The RoofStart.CATPart document still is open from the previous task.

 
1.  Click the Distance Analysis icon .

The Distance dialog box is displayed. 

2.  Select the fitted surface as the first element.

3.  Set the following parameters in the dialog box:

●     Check the Normal distance direction

●     Check the Limited Color Range mode

4.  Click the More button to display further options:

●     Check the Color scale button to display the color 

range

●     Check the Min/Max values to display these values on 

the geometry
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●     Check the Points button

●     Uncheck the Spikes button and all its options
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●     From the displayed color range, set the colors to:
❍     blue for all points located over 0.15mm above the surface

❍     green for all points between 0.15 and -0.15mm away from 
the surface

❍     red for all points located beyond  -0.15mm below the surface

5.  Check the Second set button then select the cloud of points.

Points are dynamically displayed and the minimum and maximum deviations are identified on 

the surface. 
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6.  Click OK.

The parts of the surface that lie above the cloud are identified by blue dots, and red for parts 

lying below the cloud. This means that the surface needs to be smoothed further, so that all 

points turn green indicating a perfect matching with the cloud of points. 

7.  From the specification tree, choose the Show/Hide contextual menu on the distance analysis to 

hide it for the moment.

8.  Choose the Top View icon  from the View toolbar.

9.  From the specification tree, double-click the Reflect Line Analysis.1.

The Reflection Lines dialog box is displayed and a grid of neons appears in the geometry. 

10.  Click the front and rear windshields to remove the current reflect lines, then select the roof patch 

to apply the reflect line analysis.
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11.  Set the neons parameters to N=21 (number of neons in grid) and D=150 (distance between two 

neons).

12.  Zoom out till you locate the green dot symbolizing the analysis eye.

13.  Right-click on this eye and choose the Edit contextual menu. 

The Tuner dialog box is displayed.

14.  Key in the eye's coordinates: 1850, 0, 3000 and click OK.

This moves the eye directly above the roof patch.

15.  Click Close in the Tuner dialog box, then OK in the Reflection 

Lines dialog box.

The analysis is visible on the roof patch:
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Smoothing The Surface

 
This task explains how to further smooth the surface onto the cloud of points following the distance and 
reflect line analyses.

 

The RoofStart.CATPart document still is open from the previous task, and you need to display the 
distance analysis again, using the Show/Hide contextual menu.

 
1.  Choose the Tools -> Options menu item, Shape -> FreeStyle tab, set the attenuation value to 

0.01 and click OK.

2.  Drag the compass by its base and drop it to position it, normal to the ZX reference plane. This to 

set it within the symmetry plane.

3.  Select  the roof surface and click the Control Points icon .

The Control Points dialog box is displayed. 

4.  Choose the following options:

●     Support: Translation along local normals 

●     Law: Move points identically 

●     Symmetry: use the current plane

5.  From the Dashboard, click the U, V Orders icon .

Set the order numbers to Nu=5 and Nv=7 using the contextual menu, to increase the number of 

mesh lines in U and V respectively. This brings more flexibility in terms of modifications.

6.  Select the central U mesh line.
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7.  Right-click the arrow to display the contextual menu and choose Edit, 

then decrease the deformation step to 0.75.

8.  You can also choose the Freeze contextual menu, to avoid selecting 

points from the cloud.

9.  Press and hold the Shift key, and click the arrow up or down till you display green points all over 

the surface. You may also need to decrease the step and attenuation values and the number in U 

and V to reach a smoothed surface, i.e. displaying mostly green dots, that is lying between -

0.15mm and 0.15 mm from the cloud of points.
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.
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Extracting The Final Surface

 
This task explains how to extract a shorter surface from the smoothed surface in order to remove the 
rugged ends of the surface.

 
The  RoofStart.CATPart document still is open from the previous task.

 
1.  Click the Geometry Extraction icon .

2.  Select the roof surface, move the pointer to the limit of the green area, towards the rear of the 

surface, and click to define a corner of the new surface.

3.  Drag the pointer over the side of the surface to the green area limit and click to define the second 

corner definition.
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The new surface is created.

4.  Double-click the Reflect Line Analysis from the specification tree, and transfer it by successively 

clicking the initial surface then the new one.

5.  Hide the initial surface using the Hide/Show contextual menu.

You can also modify the final surface color using the Properties contextual menu, Graphic tab.

The final roof surface looks like this: 

.
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Using the FreeStyle Profiler

The FreeStyle Profiler offers complementary capabilities to the FreeStyle Shaper. It is used on the same type of 
elements yet taking the design capabilities one step further.

Create a  net surface : select the guide and profile curves, choose the dominant curves

Create a styling sweep: choose the sweep type, select the profile, spine, guide and reference profiles if 
needed, display and manipulate the parameters.
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Creating a Net Surface

This command is only available with the FreeStyle Profiler.

 
This task explains how to create a surface, based on an existing set of curves (the net).

 
Open the NetSurface1.CATPart document.

 
1.  Click the Net Surface 

icon .

The Net Surface 

dialog box is 

displayed.

The guides (0) 

text is highlighted.

2.  Successively select 

one or more guide 

curves in the 

geometry (using the 

Ctlr key for multi-

selection).

       

3.  Click the profiles text 

in the dialog box and 

select all the profile 

curves in the 

geometry, one after 

the other.

The dialog box is 

updated with the 

number of guides 

and profiles 

selected. 
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You noticed that the first guide and profile you selected is identified by a (d) standing for "dominant".  This means that 
the surface segmentation is based on these specific curves segmentation. 

If you click on a curve text, guide or profile, the curve then becomes the dominant curve.
     

 

4.  Click the <<Settings 
text to access 
advanced settings.

 

5.  Click the Copy (d) 
mesh on surface (it 
highlights) to copy the 
geometry of the 
dominant guide curve 
and the dominant 
profile onto the net 
surface.

The selected curve must be 
isoparametric. Without option highlighted With option highlighted

      

6.  Click the Display>> 
text to display the 
maximum 
information.

 

 
The information option enables you to display or not the tags.
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7.  Activate the moving 

frame.

The moving frame 
is used to define 
how the profile's 
position along the 
guiding curve.

In the geometry, 
you can click the 
moving frame to 
change its type, 
press and hold 
Shift while clicking 
to move back, or 
right-click to 
display the 
contextual menu. 
Four types of 
moving frames are 
available: 

●     Perpendicular 
to the dominant 
guiding curve

●     Pseudo-
Perpendicular 
to the dominant 
guiding curve
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●     Two guiding 
curves and 
perpendicular 
to the dominant 
guiding curve

●     Two guiding 
curves and 
pseudo-
perpendicular 
to the dominant 
guiding curve

●     Parallel to plane
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8.  Click Apply to create 
the surface.
If you are not 
satisfied with the 
results, you can click 
another guide or 
curve to modify the 
surface.

9.  Click OK to confirm 

the net surface 

creation.

You can create a net surface by selecting two or more profiles and no guide or two or more guides and no profile.

 In case the selected guide or profile lies on more than one support, the  appears.

Please refer to Selecting a Support for further information.

Available capabilities from the dashboard are: datum creation, temporary analysis, continuities, and furtive display.
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Creating a Styling Sweep

This command is only available with the FreeStyle Profiler.

 
This task explains how to create a swept surface, based on a profile swept along a spine.

 
Open the StylingSweep1.CATPart document.

 
1.  Click the Sweep icon .

The Styling Sweep dialog box is displayed.

2.  Choose the sweep type by clicking on the icons on the left.

Four types are available:

1.  Simple: creates a surface based on two curves (profile and spine).

 

 
Example of Simple Sweep Resulting Sweep
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2.  Sweep & 

snap: creates 

a surface 

based on three 

curves (profile, 

spine and 

guide).

The swept 

surface is 

relimited onto 

the guiding 

curve. There is 

no deformation 

of the swept 

profile 

according to 

the guiding 

curve.

 

If the profile is extrapolated half 
its length, and is no longer in 
contact with the guide, then the 
calculation of the sweep stops.

3.  Sweep & fit: 

creates a 

surface based 

on three 

curves (profile, 

spine and 

guide).

The swept 

profile is 

deformed onto 

the guiding 

curve. There is 

no relimitation 

of the swept 

surface onto 

the guiding 

curve.
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4.  Sweep near profiles: creates a surface based on at least 
four curves (profile, spine, guide, and one or more 
reference profiles).
The swept profile is deformed onto the guiding curve. 
Moreover, tangency conditions are taken into account at 
the contact points between the reference profile(s) and 
spine and guiding curve.

3.  Click the <<Settings text in the dialog box to view and select the 

settings: 

You can define the following parameters that will affect the quality of the 

resulting swept surface:

●     the maximum V order allowed for the resulting swept surface, ranging 

between two and sixteen, the U order being defined by the profile 

curve's order. This value is the maximum allowed, but not necessarily 

the resulting surface's order if the system finds a better solution.

●     the maximum deviation between the exact surface and the resulting 

surface, in order to decrease the number of control points and segments 

on the resulting swept surface.

Click the values in the dialog box to edit them.

Be careful not to over-constrain the surface by setting low values for both deviation and V order. This would result in an increase 

of segments for the generated swept surface.

4.  Click Selection>> then Display in the dialog box to view and select the display parameters: limits points, moving frame, 

and information.
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When the texts are displayed in white, the corresponding 
parameter is visible in the 3D geometry.

5.  Activate the moving frame.

The moving frame is used to define how the profile is swept along 
the spine.

In the geometry, you can click the moving frame to change its 
type, press and hold Shift while clicking to move back, or right-
click to display the contextual menu. 
Four types of moving frames are available: 

1.  Translation: the profile is translated along the spine

2.  On contour: the profile translation is recomputed at 
every point of the spine, meaning the profile follows the 
spine contour.
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3.  Fixed direction: the profile is translated according to the 
compass orientation.

4.  Tangent to contour: the profile translated according to the 
compass orientation, while constantly remaining tangent to the 
spine. In the moving frame representation:

●     T is the tangent to the spine at the current point

●     B is the vectorial product between T and the compass 
direction

●     N is the vectorial product between T and B.

In the last two cases, you need to drag and drop the compass onto the geometry, or use the quick compass orientation capability, 
to set the direction according to the compass orientation definition.

The current type is displayed when passing the pointer over the moving frame. You can move the frame along the spine using the 
manipulator at the moving frame's origin. 

 
The moving frame is not available with the sweep near profile.

6.  Activate the limit points.

They allow you to redefine the surface limits on the spine/guide. 
These points show up only when the surface extends beyond the 
reference profile, when selected, and are limited by the spine or 
guide's length. 

 

Capabilities are available from the contextual menu when right-clicking a 
limit point.

 
The Information option displays the role of the selected elements in the geometry: profile, spine, and guide.

7.  Click OK to create the styling sweep.
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●     You can select surface edges as the spine and guide. In that case, 

provided the Continuity icon  is active from the dashboard, you 

can set the type of continuity to be taken into account (point, tangency, 
or curvature continuity) using the contextual menu on the displayed 
information.

Note that all continuities are not always available, depending on the chosen 
sweep type, and the geometry itself.

●     Similarly, you can use the Contact Points icon  to display the 

manipulator on the surface and modify its limits.

 In case the selected guide or profile lies on more than one support, the  appears.

Please refer to Selecting a Support for further information.

 
Styling sweeps cannot be created using canonical profiles.

Available capabilities from the dashboard are: datum creation, temporary analysis, auto detection, attenuation,  continuity, 
contact points, and  furtive display.
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Interoperability with the Part Design Workbench
You can work in the FreeStyle Shaper/FreeStyle Optimizer workbench only, creating forms and modifying them.
However in an industrial environment, it is always useful to have integrated design tools at one's disposal. The 
integration between the FreeStyle Shaper workbench and the Part Design workbench is described in the 
chapter, based on a step-by-step scenario composed of several tasks illustrating how to work with both surface 
and body type elements, that is elements created using the Part Design workbench.

Creating a Sketch and a Pad
Creating a Surface
Splitting the Pad

Modifying the Splitting Surface 

 
This scenario is accomplished in ten minutes.

The resulting body will look like this:
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Creating a Sketch and a Pad

 
This task explains how to create a pad from a sketch in the Part Design Workbench.

 
Open a new .CATPart document (see Opening a new CATPart Document) and activate the Part Design 
Workbench.

 
1.  Click the Sketcher icon .

2.  Select xy plane to define the sketch plane.

3.  Click the Circle icon .

4.  Click where you wish the center of the circle to appear.

5.  Drag the pointer to see the circle being created.

A rubberbanding circle follows the pointer as you drag 
it.

6.  Click once you are satisfied with the size of the circle.
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7.  Click the Exit Sketcher icon  then the Pad icon 

.

A default cylindrical pad is previewed.

8.  Key in 150 in the power input entry area, and click OK to 

create the pad.

A cylindrical pad has been created using the Part Design workshop.
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Creating a Surface

This task will show you how to enter the FreeStyle Shaper workbench.

1.  From the View toolbar, select the Top View icon  to see the cylinder from the top.

2.  Now, choose FreeStyle from the Start -> Shape menu. 

The FreeStyle Shaper workbench is displayed. 

3.  Select the Planar patch icon .

4.  Click at the center of the cylinder (where 

you clicked to create the circle sketch) 

press the Ctrl-key and drag the pointer 

so as to cover the cylinder face by the 

outline.

5.  When you have reached the adequate 

size, click again.

The corresponding surface has been 
created in a plane parallel to that 
defined by the 3D compass.

See Creating Planar Patches for 
further details on the 3D compass 
capabilities and on creating planar 
surfaces.
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6.  Click the Isometric view icon .

7.  In P2 mode, drag and drop the compass 

onto the surface and drag the surface 

halfway of the cylinder length pulling on 

the z axis.

8.  Reset the compass by clicking the Quick 

Compass Orientation  then the In 

Model or On Perch  icons in the 

Current plane orientation toolbar.

9.  In P1 mode, click the Control Points 

icon , click the Move selected 

points identically option, and pull the 

manipulator to drag the surface halfway 

of the cylinder length.

10.  Click OK in the Control Points dialog 

box.
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The body now looks like this:
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Splitting the Pad

 
This task will show you how to split the cylinder by the surface.

 
1.  Now, choose Part Design from the Start -> Mechanical Design menu. The Part Design 

workbench is displayed again.

2.  Select the cylinder and click the Split  icon.

3.  Select the created surface as the splitting plane.

An arrow appears indicating the portion of 
body that will be kept, make sure that it points 
in the right direction.

4.  Click OK in the Split Definition dialog box.

The cylinder has been split by the surface.
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Modifying the Splitting Surface

This task will show you how to modify the splitting surface.

1.  Return to the FreeStyle Shaper workbench.

2.  Set the current plane to Flip to VW or YZ  

using the Current Plane Orientation or Quick 

Compass Orientation toolbar, depending on the 

mode you are working in.

3.  Select the surface and click the Control points icon 

.

Control points and mesh lines are displayed along 
with the Control Points dialog box. 

4.  From the dialog box, choose the Stretch selected 

points .

Note that the Translation in the plane  icon 

is the current support.

5.  Move the pointer over an edge mesh line and pull 

down so as to manually deform the surface.

The cylinder is automatically updated.

If needed, refer to Editing Surfaces Using Control 
Points for further details on surface modification.
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6.  Click OK in the Control Points dialog box to validate 

both surface and cylinder deformation.
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Interoperability with the Wireframe Workbench
You can work in the FreeStyle Shaper/FreeStyle Optimizer workbench only, creating forms and modifying them.
However in an industrial environment, it is always useful to have integrated design tools at one's disposal. The 
integration between the FreeStyle Shaper workbench and the Wireframe workbench is described in the chapter, 
based on four tasks illustrating how to create wireframe geometry using the Wireframe workbench.

Creating Points 
Creating Lines 
Creating Planes 
Creating Circles 

 When using these commands, elements are created with their history. If you need to deactivate the history, 
refer to Creating Datums.
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Creating Points

 

This task shows the various methods for creating points: 
●     by coordinates

●     on a curve

●     on a plane

●     on a surface

●     at a circle center

●     tangent point on a curve

●     between

 
Open the Points3D-1.CATPart document.

 
1.  Click the Point icon  .

The Point Definition dialog box appears.

2.  Use the combo to choose the desired point type.

Coordinates 
●     Enter the X, Y, Z coordinates in the 

current axis-system.

●     Optionally, select a reference point.

The corresponding point is 
displayed.

 

 

When creating a point within a user-defined axis-system, note that the Coordinates in absolute axis-
system check button is added to the dialog box, allowing you to be define, or simply find out, the point's 
coordinates within the document's default axis-system.
If you create a point using the coordinates method and an axis system is already defined and set as 
current, the point's coordinates are defined according to current the axis system. As a consequence, the 
point's coordinates are not displayed in the specification tree.

The axis system must be different from the 
absolute axis.  
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On curve 
●     Select a curve

●     Optionally, select a reference point.

If this point is not on the curve, it 
is projected onto the curve.
If no point is selected, the curve's 
extremity is used as reference.

 

●     Select an option point to determine 
whether the new point is to be created: 

❍     at a given distance along the curve 
from the reference point

❍     a given ratio between the reference 
point and the curve's extremity.

      
●     Enter the distance or ratio value.

If a distance is specified, it can be: 
❍     a geodesic distance: the distance is 

measured along the curve

❍     an Euclidean distance: the distance is 
measured in relation to the reference 
point (absolute value).

The corresponding point is displayed.

If the reference point is located at the curve's extremity, even if a ratio value is defined, the created point 
is always located at the end point of the curve.
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You can also: 
●     click the Nearest extremity button to display the point at the nearest extremity of the curve.

●     click the Middle Point button to display the mid-point of the curve.

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not closed) 
when using the Middle Point option.

●     use the Reverse Direction button to display: 
❍     the point on the other side of the reference point (if a point was selected originally)

❍     the point from the other extremity  (if no point was selected originally).

●     click the Repeat object after OK if you wish to create equidistant points on the curve, using the 
currently created point as the reference, as described in Creating Multiple Points in the Wireframe and 
Surface User's Guide. 

You will also be able to create 
planes normal to the curve at 
these points, by checking the 
Create normal planes also 
button, and to create all instances 
in a new geometrical set  by 
checking the Create in a new 
geometrical set button.
If the button is not checked the 
instances are created in the 
current geometrical set .

 

●     If the curve is infinite and no reference point is explicitly given, by default, the reference point is the 
projection of the model's origin

●     If the curve is a closed curve, either the system detects a vertex on the curve that can be used as a 
reference point, or it creates an extremum point, and highlights it (you can then select another one if 
you wish) or the system prompts you to manually select a reference point.

 

Extremum points created on a closed curve 
are now aggregated under their parent 
command and put in no show in the 
specification tree.
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On plane 
●     Select a plane.

●     Optionally, select a point to define a 
reference for computing coordinates in 
the plane.

If no point is selected, the 
projection of the model's origin on 
the plane is taken as reference. 

 

 

 
●     Optionally, select a surface on which the 

point is projected normally to the plane.

If no surface is selected, the 
behavior is the same.

Furthermore, the reference 
direction (H and V vectors) is 
computed as follows: 
With N the normal to the selected 
plane (reference plane), H results 
from the vectorial product of Z and 
N (H = Z^N). 
If the norm of H is strictly positive 
then V results from the vectorial 
product of N and H (V = N^H).
Otherwise, V = N^X and H = V^N.

Would the plane move, during an 
update for example, the reference 
direction would then be projected 
on the plane. 

●     Click in the plane to display a point.
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On surface 
●     Select the surface where the point is to 

be created.

 

●     Optionally, select a reference point. By 
default, the surface's middle point is 
taken as reference. 

●     You can select an element to take its 
orientation as reference direction or a 
plane to take its normal as reference 
direction.
You can also use the contextual menu to 
specify the X, Y, Z components of the 
reference direction.

●     Enter a distance along the reference 
direction to display a point.

 
      

Circle center 
●     Select a circle, circular arc, or ellipse.

A point is displayed at the center 
of the selected element. 
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Tangent on curve 
●     Select a planar curve and a direction line.

A point is displayed at each 
tangent. 

      
The Multi-Result Management 
dialog box is displayed because 
several points are generated. 

●     Click YES: you can then select a 
reference element, to which only the 
closest point is created.

●     Click NO: all the points are created.

Between
●     Select any two points.

●     Enter the ratio, that is the percentage of 
the distance from the first selected point, 
at which the new point is to be.
You can also click Middle Point button 
to create a point at the exact midpoint 
(ratio = 0.5).

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not closed) 
when using the Middle Point option.

●     Use the Reverse direction button to 
measure the ratio from the second 
selected point.
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If the ratio value is greater than 1, the point is located on the virtual line beyond the selected points.

3.  Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.
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Creating Lines
This task shows the various methods for creating lines: 

●     point to point

●     point and direction

●     angle or normal to curve

●     tangent to curve

●     normal to surface

●     bisecting

 It also shows you how to automatically reselect the second point.

 
Open the Lines1.CATPart document.

1.  Click the Line icon  .

The Line Definition dialog box appears.

2.  Use the drop-down list to choose the desired line type.

 
A line type will be proposed automatically in some cases depending on your first element selection.

Point - Point 

 
This command is only available with the Generative 
Shape Design 2 product.

●     Select two points.
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A line is displayed between the two 
points.
Proposed Start and End points of the 
new line are shown.

●     If needed, select a support surface.
In this case a geodesic line is created, i.e. going 
from one point to the other according to the 
shortest distance along the surface geometry 
(blue line in the illustration below).
If no surface is selected, the line is created 
between the two points based on the shortest 
distance.

If you select two points on closed surface (a 
cylinder for example), the result may be unstable. 
Therefore, it is advised to split the surface and only 
keep the part on which the geodesic line will lie. 

 
The geodesic line is not available with the Wireframe and Surface workbench.
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●     Specify the Start and End points of the new line, that is the line endpoint location in relation to the 

points initially selected. These Start and End points are necessarily beyond the selected points, 
meaning the line cannot be shorter than the distance between the initial points.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start and 
End points.

 
The projections of the 3D point(s) must already exist on the selected support. 

Point - Direction 
 

●     Select a reference Point and a Direction line.
A vector parallel to the direction line is displayed 
at the reference point. 
Proposed Start and End points of the new line 
are shown.
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●     Specify the Start and End points of the new 
line.
The corresponding line is displayed.

 
The projections of the 3D point(s) must already exist on the selected support. 

  

Angle or Normal to curve
 

●     Select a reference Curve and a Support surface 
containing that curve.
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- If the selected curve is planar, then the 
Support is set to Default (Plane).

- If an explicit Support has been defined, 
a contextual menu is available to clear 
the selection.

 
●     Select a Point on the curve.

●     Enter an Angle value.

A line is displayed at the given angle with 
respect to the tangent to the reference 
curve at the selected point. These 
elements are displayed in the plane 
tangent to the surface at the selected 
point. 
You can click on the Normal to Curve 
button to specify an angle of 90 degrees. 
Proposed Start and End points of the line 
are shown. 

●     Specify the Start and End points of the new line.
The corresponding line is displayed.
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●     Click the Repeat object after OK if you wish to 
create more lines with the same definition as the 
currently created line. 
In this case, the Object Repetition dialog box is 
displayed, and you key in the number of 
instances to be created before pressing OK.

As many lines as indicated in the dialog box are 
created, each separated from the initial line by a 
multiple of the angle value.

 

You can select the Geometry on Support check box if you want to create a geodesic line onto a support 

surface. 

The figure below illustrates this case.

 

Geometry on support option not checked Geometry on support option checked

 
This line type enables to edit the line's parameters. Refer to Editing Parameters to find out how to display 
these parameters in the 3D geometry.
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Tangent to curve
 

●     Select a reference Curve and a point or 
another Curve to define the tangency. 

❍     if a point is selected (mono-tangent mode): 
a vector tangent to the curve is displayed at 
the selected point.

❍     If a second curve is selected (or a point in bi-
tangent mode), you need to select a support 
plane. The line will be tangent to both 
curves.

 - If the selected curve is a line, then the 
Support is set to Default (Plane).

- If an explicit Support has been defined, 
a contextual menu is available to clear 
the selection.

 When several solutions are possible, you 
can choose one (displayed in red) directly 
in the geometry, or using the Next 
Solution button.

     

 

 

Line tangent to curve at a given point Line tangent to two curves
●     Specify Start and End points to define the new line.

The corresponding line is displayed.
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Normal to surface 
 

●     Select a reference Surface and a Point.
A vector normal to the surface is displayed at 
the reference point. 
Proposed Start and End points of the new line 
are shown.

●     Specify Start and End points to define the new 
line.
The corresponding line is displayed.
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Bisecting 
 

●     Select two lines. Their bisecting line is the line 
splitting in two equals parts the angle between 
these two lines. 

●     Select a point as the starting point for the line. 
By default it is the intersection of the bisecting 
line and the first selected line.
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●     Select the support surface onto which the 
bisecting line is to be projected, if needed.

●     Specify the line's length in relation to its starting 
point (Start and End values for each side of the 
line in relation to the default end points).
The corresponding bisecting line, is displayed.

●     You can choose between two solutions, using 
the Next Solution button, or directly clicking 
the numbered arrows in the geometry.

3.  Click OK to create the line.

The line (identified as Line.xxx) is added to the specification tree.

  
●     Regardless of the line type, Start and End values are specified by entering distance values or by 

using the graphic manipulators.

●     Start and End values should not be the same.

  
 

●     Select the Length Type: 
❍     Length: the line will be defined according to the Start and End points values

❍     Infinite: the line will be infinite

❍     Infinite Start Point: the line will be infinite from the Start point

❍     Infinite End Point: the line will be infinite from the End point

By default, the Length type is selected.
The Start and/or the End points values will be greyed out when one of the Infinite options is chosen.

     
●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start 

point.

●     In most cases, you can select a support on which the line is to be created. In this case, the selected 
point(s) is projected onto this support.

●     You can reverse the direction of the line by either clicking the displayed vector or selecting the 
Reverse Direction button (not available with the point-point line type).

     

Automatic Reselection
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This capability is only available with the Point-Point line method.

1.  Double-click the Line icon .

The Line dialog box is displayed.

2.  Create the first point.

 

The Reselect Second Point at next 
start option appears in the Line dialog 
box.

3.  Check it to be able to later reuse 

the second point.

4.  Create the second point.

5.  Click OK to create the first line.

  
 The Line dialog box opens again with the 

first point initialized with the second point 
of the first line.

6.  Click OK to create the second point.

7.  Click OK to create the second line, and so 

on.

 

 To stop the repeat action, simply uncheck the option or click Cancel in the Line dialog box.
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CreatingPlanes

 
This task shows the various methods for creating planes:

 

●     offset from a plane

●     parallel through point

●     angle/normal to a plane

●     through three points

●     through two lines

●     through a point and a line

●     through a planar 
curve

●     normal to a curve

●     tangent to a surface

●     from its equation

●     mean through points

 

 
Open the Planes1.CATPart document.

 
1.  Click the Plane icon  .

The Plane Definition dialog box appears.

2.  Use the combo to choose the desired Plane type.

 
Once you have defined the plane, it is represented by a red square symbol, which you can move using the 
graphic manipulator.

Offset from plane

●     Select a reference Plane then enter an 
Offset value.

A plane is displayed offset from the reference 
plane.
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Use the Reverse Direction button to  reverse 
the change the offset direction, or simply click on 
the arrow in the geometry.

      
●     Click the Repeat object after OK if you wish to create 

more offset planes . 
In this case, the Object Repetition dialog box is 
displayed, and you key in the number of instances to be 
created before pressing OK.

As many planes as indicated in the dialog box are 
created (including the one you were currently 
creating), each separated from the initial plane 
by a multiple of the Offset value. 

 

Parallel through point 

●     Select a reference Plane and a Point.
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A plane is displayed parallel to the reference 
plane and passing through the selected point.

Angle or normal to plane 

●     Select a reference Plane and a Rotation 
axis.
This axis can be any line or an implicit 
element, such as a cylinder axis for example. 
To select the latter press and hold the Shift 
key while moving the pointer over the 
element, then click it.

●     Enter an Angle value.
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A plane is displayed passing through the rotation 
axis. It is oriented at the specified angle to the 
reference plane. 

●     Click the Repeat object after OK if you wish to create more planes at an angle from the initial 
plane. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of instances 
to be created before pressing OK.

As many planes as indicated in the dialog box are 
created (including the one you were currently 
creating), each separated from the initial plane 
by a multiple of the Angle value.

Here we created five planes at an angle of 20 
degrees.

 This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find out how to 
display these parameters in the 3D geometry.

Through three points 

●     Select three points.
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The plane passing through the three points is 
displayed. You can move it simply by dragging it 
to the desired location.

Through two lines 

●     Select two lines.

The plane passing through the two line directions 
is displayed.
When these two lines are not coplanar, the 
vector of the second line is moved to the first line 
location to define the plane's second direction. 
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Check the Forbid non coplanar lines button to specify that both lines be in the same plane.

Through point and line 

●     Select a Point and a Line.

The plane passing through the point and the line 
is displayed. 
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Through planar curve 

●     Select a planar Curve.

The plane containing the curve is displayed.

Tangent to surface 

●     Select a reference Surface and a Point.
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A plane is displayed tangent to the surface at the 
specified point.

Normal to curve 

●     Select a reference Curve.

●     You can select a Point. By default, the 
curve's middle point is selecte.
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A plane is displayed normal to the curve at the 
specified point. 

Mean through points 

●     Select three or more points to display the 
mean plane through these points.

It is possible to edit the plane by first selecting a 
point in the dialog box list then choosing an 
option to either:

●     Remove the selected point

●     Replace the selected point by another point.
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Equation 

●     Enter the A, B, C, D components of the Ax + 
By + Cz = D plane equation.

 

Select a point to position the plane through this 
point, you are able to modify A, B, and C 
components, the D component becomes grayed.

 

Use the Normal to compass button to position 
the plane perpendicular to the compass direction.

Use the Parallel to screen button to parallel to 
the screen current view.

3.  Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.
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Creating Circles

 

This task shows the various methods for creating circles and circular arcs: 

●     center and radius

●     center and point

●     two points and radius

●     three points

●     bitangent and radius

●     bitangent and point

●     tritangent

●     center and tangent

 

Open the Circles1.CATPart document.
Please note that you need to put the desired geometrical set in show to be able to perform the corresponding scenario. 

 
1.  Click the Circle icon .

The Circle Definition dialog box appears. 

2.  Use the combo to choose the desired circle type.

Center and radius 
 

●     Select a point as circle Center.

●     Select the Support plane or surface where the circle 
is to be created.

●     Enter a Radius value.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.
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If a support surface is selected, the circle lies on the plane tangent to the surface at the selected point.

Start and End angles can be specified by entering values or by using the graphic manipulators.
     

Center and point 
 

●     Select a point as Circle center.

●     Select a Point where the circle is to be created.

●     Select the Support plane or surface where the circle 
is to be created.

The circle, which center is the first selected point and 
passing through the second point or the projection of 
this second point on the plane tangent to the surface at 
the first point, is previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.

 

 

You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

      

Two points and radius 
 

●     Select two points on a surface or in the same plane.

●     Select the Support plane or surface.

●     Enter a Radius value.

The circle, passing through the first selected point and 
the second point or the projection of this second point 
on the plane tangent to the surface at the first point, is 
previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two selected points as end 
points. 

You can use the Second Solution button, to display 
the alternative arc.

402Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



  

You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

     

Three points 
 

●     Select three points where the circle is to be created.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two of the selected points 
as end points.

 

You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.
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Bi-tangent and radius 
 

●     Select two Elements (point or curve) to which the 
circle is to be tangent.

●     Select a Support surface.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 
●     Enter a Radius value.

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points. 

 

You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with Element 1 trimmed.

These options are only available with the Trimmed 
Circle limitation.
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Bi-tangent and point 
 

●     Select a point or a curve to which the circle is to be 
tangent.

●     Select a Curve and a Point on this curve.

●     Select a Support plane or planar surface.

The point will be projected onto the curve.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 

Complete circle
For a circular arc, you can choose the trimmed or complementary arc using the two tangent points as end points.

Trimmed circle Complementary trimmed circle

You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with both elements trimmed.
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These options are only available with the Trimmed 
Circle limitation.

     

Tritangent 
 

●     Select three Elements to which the circle is to be 
tangent.

●     Select a Support planar surface.

 If one of the selected inputs is a planar curve, then the 
Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual 
menu is available to clear the selection in order to select 
the desired support.

This automatic support definition saves you from 
performing useless selections.

 
●     Several solutions may be possible, so select the arc 

of circle that you wish to create.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. The first 
and third elements define where the relimitation ends. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two tangent points as end 
points.

  

You can select the Trim Element 1 and Trim Element 
3 check boxes to trim the first element or the third 
element, or both elements.
Here is an example with Element 3 trimmed.

These options are only available with the Trimmed 
Circle limitation.

     
 Center and tangent

 

There are two ways to create a center and tangent 
circle:
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1.  Center curve and radius

●     Select a curve as the Center Element.

●     Select a Tangent Curve.

●     Enter a Radius value.

  

 2.  Line tangent to curve definition

●     Select a point as the Center Element.

●     Select a Tangent Curve.

 

 

●     If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

●     The circle center will be located either on the center curve or point and will be tangent to tangent curve.

●     Please note that only full circles can be created.
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4.  Click OK to create the circle or circular arc.

The circle (identified as Circle.xxx) is added to the specification tree.
When several solutions are possible, click the Next Solution button to move to another arc of circle, or directly select the arc you 
want in the 3D geometry.

A circle may have several points as center if the selected element is made of various circle arcs with different centers.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters chapter.
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 FreeStyle Interoperability
Optimal CATIA PLM Usability for FreeStyle
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 Optimal CATIA PLM Usability for FreeStyle 
When working with ENOVIA V5, the safe save mode ensures that you only create data in CATIA that can 
be correctly saved in ENOVIA. Therefore, in interoperability mode, some CATIA V5 commands are grayed 
out / hidden in the FreeStyle workbench.

ENOVIA V5 offers two different storage modes: Workpackage (Document kept - Publications Exposed) and 
Explode (Document not kept). 

 In FreeStyle workbench, when saving data into ENOVIA V5, the global transaction is guaranteed but only 
if the target is in Workpackage mode. All FreeStyle commands are thus available at all times in this mode.

To ensure seamless integration, you must have both a CATIA and ENOVIA session running.
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Workbench Description
In this chapter we will describe the various menus, submenus, items and toolbars of the FreeStyle Shaper and FreeStyle 
Optimizer workbench.

 

Menu Bar
Creation Toolbars

Modification Toolbars
Analysis Toolbar

Generic Tools Toolbar
FreeStyle Dashboard

FreeStyle Constraints Toolbar
Views Toolbar

Wireframe Toolbar
Specification Tree
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Menu Bar
This section presents the tools and commands which are available in the FreeStyle Shaper, Optimizer and Profiler workbenches. 
Many other operations are documented in the Infrastructure User's Guide.

Start File Edit View Insert Tools Windows Help

File 

The File menu lets you perform file creation, opening saving, printing operations. Refer to the Infrastructure User's Guide 

Edit 

The Edit menu lets you manipulate selected objects. Refer to the Infrastructure User's Guide and Part Design User's Guide. 

View 

The View menu lets you view document contents  Refer to the Infrastructure User's Guide.

Insert 

The Insert menu lets you insert FreeStyle Shaper, Optimizer and Profiler elements.

For... See...

   

Geometrical set... Managing Geometrical Sets

Ordered geometrical set... Managing Ordered Geometrical Sets

Axis System Defining an Axis System

Shape Modification Insert -> Shape Modification

Surface Creation Insert -> Surface Creation

Curve Creation Insert -> Curve Creation

Operations Insert -> Operations

Shape Analysis Insert -> Shape Analysis

FreeStyle Constraints Insert -> FreeStyle Constraints
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Shape Modification
For... See...

Symmetry... Performing a Symmetry on Geometry

Control Points
Editing Curves Using Control Points, Editing a Surface Boundary, and Editing Surfaces Using Control Points, 
Performing a Draft Analysis, Performing a Surfacic Curvature Analysis

Match Surface Matching Surfaces

Multi-Side Match Surface Multi-side Matching

Fit to Geometry Fitting a Curve to a Cloud of Points and Fitting a Surface to a Cloud of Points (Freestyle Optimizer)

Global Deformation Globally Deforming a Surface (Freestyle Optimizer)

Extend Extending Curves and Extrapolating Surfaces

Surface Creation
For... See...

 

Planar Patch Creating Planar Patches

3-Point Patch Creating a Surface from Three Points

4-Point Patch Creating a Surface from Four Points

Geometry Extraction Creating a Surface on an Existing Surface

Extrude Surface Extruding a Surface

Revolve... Creating Revolution Surfaces

Offset Offsetting Surfaces

Styling Extrapolate Extrapolating Curves

Blend Surface Creating Blend Surfaces

ACA Fillet Creating an ACA Fillet

Fill Creating Filling Surfaces

FreeStyle Fill Creating Associative Filling Surfaces

Net Surface Creating Net Surfaces (Freestyle Profiler)

Styling Sweep Creating Swept Surfaces (Freestyle Profiler)

Curve Creation
For... See...
3D Curve Creating Associative Curves

Curve on Surface Creating Free Form Curves on Surfaces

Project Curve Projecting Curve

Blend Curve Creating Blend Curves

413Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



 

Styling Corner Creating Styling Corners

Match Curve Matching Curves

Operations
For... See...

Break Redefining Surface Limits

Untrim Restoring a Surface

Concatenate Concatenating Curves

Fragmentation Fragmenting Curves and Fragmenting Surfaces

Disassemble Disassembling Surfaces

Converter Wizard Approximating/Segmenting Procedural Curves and Approximating/Segmenting Procedural Surfaces

Copy Geometric Parameters Copying Geometric Parameters

Shape Analysis
For... See...
Connect Checker Checking Connections Between Surfaces

Curve Connect Checker Checking Connections Between Curves

Porcupine Analysis Performing a Curvature Analysis

Cutting Planes Using Dynamic Cutting Planes

Reflection Lines Analyzing Reflect Curves (Freestyle Optimizer)

Inflection Lines Creating Inflection Lines (Freestyle Optimizer)

Highlight Lines Analyzing Using Highlight Lines

Distance Analysis Analyzing Distance Between Two Sets of Elements

Draft Analysis Performing a Draft Analysis

Curvature Mapping Performing a Surfacic Curvature Analysis

Environment Mapping Mapping an Environment on a Surface

Isophotes Analysis Analysis Using Isophotes

ACA Highlight Analyzing Using Highlights

FreeStyle Constraints
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For... See...

Continuity Constraint Creating a Continuity Constraint

Tools 

The Tools menu lets you perform image capture and album management, set user preferences and manage macros. Refer to the Infrastructure User's Guide. 

It also allows you to define visualization options, viewpoints, and manage the compass specifically for the FreeStyle Shaper, Optimizer and Profiler elements. 

Please note that most of the Tools commands available here are common facilities offered with the Infrastructure.

Specific Generative Shape Design commands are described in the present document. 

For... See...
  

Formula Allows editing parameters and formula

Image Allows capturing images

Macro Allows recording, running and editing macros

Utility... Using the Batch Monitor

Show Allows to show a set of elements according to their type, or whether they are currently selected or not

Hide Allows to hide a set of elements according to their type, or whether they are currently selected or not

In Work Object See Scanning a Part and Defining In Work Objects

Parameterization Analysis... Analysing Using Parameterization

Visualisation Options Visualization Options

Compass Orientation Compass Orientation

View Manipulation View Manipulation

Customize... Allows customizing the workbench.

Visualization Filters... Allows layer filters management

Options... Allows customizing settings

Standards... Managing Standards in the Interactive Drafting documentation

Conferencing Allows setting up of communication tools

Visualization Options 
For... See...

Apply Dress-Up
Setting Visualization Options

Remove Visualization Options
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Geometric Information Displaying Geometric Information on Elements

Visual Symmetry Displaying a Part Symmetrically

Compass Orientation 
For... See...

Flip compass base

Managing the Compass
Set Compass Orientation

Reset compass to XYZ

Drop compass plane

View Manipulation 
For... See...

Stretch View Stretch View Analysis Tool

Standard View Manipulations

Manipulating Views

Rotation About Y Screen Axis 

Rotation About X Screen Axis 

Rotation About Z Screen Axis 

Zoom And Translate

Viewpoint Definition 
Defining Views

Reverse Viewpoint 

Previous View
Manipulating Views

Next View

  

Window 

The Window  menu lets you arrange document windows in relation one to the other. Refer to the Infrastructure User's Guide. 

Help 

The Help menu lets you get help on the currently active command, and the product in general. Refer to the Infrastructure User's Guide. 
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Creation Toolbars

The creation toolbars contain the following tools:

 

 
See Creating Planar Patches

See Creating a Surface from Three Points

 
See Creating a Surface from Four Points

See Creating a Surface on a Existing Surface

 
See Extruding a Surface

See Creating Revolution Surfaces

 
See Offsetting a Surface

 
See Extrapolating Curves

 
See Creating Blend Surfaces

 
See Creating an ACA Fillet

 
See Creating Filling Surfaces

 See Creating Associative Filling Surfaces

See Creating a Net Surface (Freestyle Profiler)

 
See Creating Swept Surfaces (Freestyle Profiler)
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See Creating Associative 3D Curves

See Creating Associative 3D Curves on a Scan of Cloud

See Creating Free Form Curves on Surfaces

See Projecting Curves

 
See Creating Blend Curves

See Creating Styling Curve Fillets

See Matching Curves
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Modification Toolbars
The modification toolbar contains the following tools:

 

See Manipulating Surfaces and Rotating a Surface

 

See Selecting Using Multi-Selection

 

 

 

 

 

See Performing a Symmetry on Geometry

See Editing Curves Using Control Points, Smoothing Curves, Editing Surfaces Using Control Points and Smoothing 
Surfaces

See Matching Surfaces

See Multi-side Matching

See Fitting a Curve to a Cloud of Points and Fitting a Surface to a Cloud of Points (Freestyle Optimizer)

See Globally Deforming Surfaces (Freestyle Optimizer)

See Extending a Curve and Extrapolating a Surface

See Redefining Surface Limits

See Restoring a Surface
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See Fragmenting Curves and Fragmenting Surfaces

See Concatenating Curves

See Disassembling

See Approximating/Segmenting Curves or Approximating/Segmenting Surfaces

 See Copying Geometric Parameters
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Analysis Toolbar
The analysis toolbar contains the following tools:

 

See Checking Connections Between Elements

See Checking Connections Between Curves

See Analyzing Distance Between Two Sets of Elements

See Performing a Curvature Analysis

See Using Dynamic Cutting Planes

See Analyzing Reflect Curves (Freestyle Optimizer)

 See Creating Inflection Lines (Freestyle Optimizer)

 See Analyzing Using Highlight Lines

See Performing a Surfacic Curvature Analysis

See Performing a Draft Analysis

See Mapping an Environment on a Surface

See Analyzing Using Isophotes

See Analyzing Using Highlights
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Generic Tools Toolbar
The generic tools toolbar contains the following tools:

 

See Setting FreeStyle Visualization Options

See Setting FreeStyle Visualization Options

 See Displaying a Part Symmetrically

See Displaying Geometric Information on Elements

See Managing the Compass

See Defining an Axis System
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FreeStyle Dashboard

The FreeStyle Dashboard contains the following tools:

 

 See Creating Datums

 See Keeping the Initial Element

See Inserting in a New Geometrical Set

See Creating a Temporary Analysis

 

  
See Auto detection

  

  
See Attenuation

  

  

See Displaying Manipulators on Elements

 See Displaying Control Points Temporarily
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FreeStyle Constraints Toolbar

 

See Creating a Continuity Contraint
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Views Toolbar
The views  toolbar contains the following tools:

 

See Stretch View Analysis Tool

See Manipulating Views

 See Manipulating Views

See Manipulating Views

See Manipulating Views

See Manipulating Views

 See Defining Views

 See Defining Views

See Manipulating Views

See Manipulating Views
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Wireframe Toolbar
By default, the WireFrame toolbar is hidden. 

 

See Creating Points

See Creating Lines

See Creating Planes

See Creating Circles
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Specification Tree
Within the FreeStyle Shaper and FreeStyle Optimizer workbench, you can generate a number of elements that 
are identified in the specification tree by the following icons.

Further information on general symbols in the specification tree are available in Symbols Used in the 
Specification Tree.

Sketch  Symmetry

3D Curve  Untrim

Curve on Surface  Point

Curve Projection  Line

Blend Curve  Plane

Styling Corner  Circle

Match Curve  Axis System

Break  
Surface 
Connect 
Checker

Disassembling Curves  
Curve 
Connect 
Checker

Curve 
Approximation/Segmentation  

Distance 
Analysis

     
Curvature 
Analysis

Planar Surface  
Cutting 
Plane 
Analysis

3-Point Surface  Reflect Lines

4-Point Surfaces  
Inflection 
Lines

Geometry Extraction  
Highlight 
Lines

Extrusion Surface  
Surfacic 
Curvature 
Analysis
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Offset Surface  
Draft 
Analysis

Extrapolation Surface  
Environment 
Mapping

Blend Surface  
Isophotes 
Mapping

ACA Fillet  
Geometrical 
Set

Fill Surface  
Ordered 
Geometrical 
Set

Surface Fragmentation  Multi-Output

Disassembling Surfaces    

Surface 
Approximation/Segmention    

FreeStyle Fill Surface    

Revolution Surface    

Net Surface    

Styling Sweep    
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Customizing For FreeStyle Shaper,
Optimizer, and Profiler

This task explains how to customize settings for FreeStyle workbenches.

1.  Select the Tools -> Options menu item. 

The Options dialog box is displayed.

2.  Select the Shape category then select the FreeStyle subcategory. 

The options for FreeStyle settings appear, organized in separate areas depending on the type of 

setting. 

●     Geometry

●     Auto-detection

●     Display

●     Tuning

3.  In the Geometry area, check:

 
 

●     Tolerances: to impose user-defined tolerances to every elements to be created and modified within a 
FreeStyle workbench.
You can define: 

❍     the constraint tolerance value used to define the continuity variation. In this case if the 
continuity is over the set value the element is not created/modified.
In P1 mode, the constraint tolerance value is set and cannot be modified.

❍     the deviation tolerance value, used when converting elements using the Converter Wizard for 
example (see tasks "Approximating/Segmenting Procedural Curves" and 
"Approximating/Segmenting Procedural Surfaces" within the FreeStyle Shaper, Optimizer, and  
Profiler User's Guide). In this case you accept the conversion up to the set tolerance value.

●     Order: to set the maximum allowed order along the U (and V) directions for each curve segment and 
surface patch.
This maximum order value ranges from 5 to 16 included, in a given direction.
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In P1 mode, the Max order is set to 16 and cannot be modified.

4.  In the Auto-Detection area, you can 

choose to display: 

●     the point coordinates as the pointer moves 

along the geometry by selecting the 

Coordinates checkbox

●     the dressing mode by selecting the Search 

dressing checkbox. This option allows the 

display of control points on geometry 

detected with the pointer when using the 

Snap on Cpt (snap on control points) option 

from the Dashboard.

5.  In the Display area, you set the 

information to be displayed on the 

geometry as you manipulate it, that is:

●     the Control Points on the geometry. See 

"Displaying Control Points Temporarily" in 

the FreeStyle Shaper, Optimizer, and  

Profiler User's Guide).

●     the Continuity at every connection between 
elements (such as blend and match curves 
and surfaces, fill surfaces, and so forth)
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●     the Curvature texts on an element (such as 
blend and match curves and surfaces, and 
so forth)

●     the Order number along the U (for curves) 
or U and V directions (for surfaces).

●     the Contact Point at every connection 
between connected elements (such as blend 
and match curves and surfaces, and so 
forth)

 
●     the Tension manipulators at every 

connection between connecting elements 
(such as blend and match curves and 
surfaces, and so forth)
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6.  In the Tuning area, you set the values 

used when manipulating views or 

geometry (P2 only).

See "Editing Surfaces Using Control 

Points", and "Manipulating Views" in 

the FreeStyle Shaper, Optimizer, and  

Profiler User's Guide for example. 

7.  Click OK to confirm setting these permanent options.

For further information on the Performance tab, refer to the chapter called Performance in the 
Infrastructure User's Guide.

 

432Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



Glossary 

            

Special Characters
2D-Curve A 2D-Curve is defined in the u-v-Parameterspace of the surface. A 2D-Curve yields information of 

the surface, for example the curvature of the surface. A 2-D Curve does not follow the 
modification of the surface. If you modify the surface there will be a gap between the 2-D Curve 
and the surface.

 

3D compass The 3D compass is a three-axis system used to define the plane into which any action is 
performed. It is displayed whenever you are creating an element or applying modifications to this 
element. 

 

3D-Curve Normally a curve is a 3D-Curve. A 3D-Curve placed on a surface does not yield any information 
about the surface.

A
approximation A surface or a curve is converted into a NUPBS surface or a NUPBS curve. 

attenuation Factor to attenuate the speed with of the mouse displacement.

B
basic surface If a surface is trimmed at an arbitrary curve, it is sometimes wanted that the trimmed surface 

yields the information about the input surface. This input surface is called Basic Surface (if it is 
not trimmed).
A trimmed surface is called a face and the underlying untrimmed surface is called the Basic 
surface.

blend curve A curve created to connect two pre-existing curves. 

blend surface A surface created to connect two pre-existing surfaces

C
chain of 
curves

A chain of curves contains at least one curve. If there are more than one curve, the endpoint of 
the first curve has to meet the start point of the second curve and so on. Gaps and overlapping 
are not allowed.

cloud of 
points

A set of points in space. A cloud of points may consist of a single point or several million points.

F
face A face is a trimmed surface. A face has an underlying Basic Surface.  

feature 
modeling

Some Commands, e.g. Fillet, have the Option Feature Modeling. The term Feature Modeling is 
explained with the Command ACA Fillet.

 

G
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G0 If the endpoint of curve K1 meets the endpoint of curve K2 then we say: At this point both curves 
are connected with order of continuity G0.
If one edge of surface S1 meets an edge of the surface S2 then we say along this edge both 
surfaces are connected with the order of continuity G0.
If the G0-continuity is missed then we have a so called G0-error. This error is an absolute error, 
a distance, and it is measured in mm or inches. 

 

G1 The curve K1 and the curve K2 are connected with the order of continuity G0 in the point P. If 
both curves in the point P run into the same direction, this means the angle between the 
tangents of both curves is 0, then we say the order of continuity is G1.
The surface S1 and the surface S2 are connected with the order of continuity G0 along the curve 
C. We take the normal of S1 in a point near the curve C and run with this normal over the border 
to S2. If the normal does not change its angle from one point of the border of S1 to the nearest 
point of S2 then we say the order of continuity is G1.
If the G1-continuity is missed then we have a so called G1-error. This error is an absolute error, 
an angle, and it is measured in deg of rad. 

 

G2 The curve K1 and the curve K2 are connected with the order of continuity G1 in the point P. We 
look at the curvature vector of K1 in point P and the curvature vector of K2 in point P. If both 
vectors have the same direction and the same absolute value, then we say the order of continuity 
is G2.
The surface S1 and the surface S2 are connected with the order of continuity G1 along the curve 
K. If each curve on S1 which runs over the border to S2 can be continued with another curve on 
S2 and their order of continuity is G2 then we say both surfaces are connected with the order of 
continuity G2.
If the G2-continuity is missed then we have a so called G2-error. This error is a relative error and 
it is calculated with the following formula. K1 may have the radius R and K2 may have the radius 
r at the common point, with r<R, then yields:

error= 2*(R-r)/(R+r)

The maximum of this error is 2. Sometimes this error is measured in percent % then its 
maximum is 200%. 

 

 

G3 The curve K1 and the curve K2 are connected with the order of continuity G2 in the point P. For 
the definition of the G3-continuity we look at the curvature hedgehog, as it can be created with 
the command Porcupine Curvature Analysis. We look at the envelope of the curvature hedgehog. 
If this envelope has at the desired point G1-continuity then we say the order of continuity 
between both curves is G3.
If the G3-continuity between both curves is missed, the G1-continuity of the envelope is missed, 
then we have a so called G3-error between both curves. This error is an absolute error, an angle, 
and it is measured in deg of rad and it is the G1-error of the envelope. G3-continuity between 
surfaces is defined on the curves between both surfaces on the same way. 

 

Gaussian 
curvature

The Gaussian curvature is calculated from the Max Principal and the Min Principal curvature with 
the following formula:

Gauss = 
sig(MaxPrincCurvature)*sig(MinPrincCurvature)*sqrt(abs(MaxPrincCurvature*MinPrincCurvature))

Sig is the sign (of MaxPrincCurvature and MinPrincCurvature) and can only have the value +1 or -
1. 

 

global 
deformation

A deformation that is applied globally to a set of elements, as opposed to a deformation 
successively applied to different elements. 

 

I
inflection line Curve, lying on a surface, which curvature value is 0 at each point. 

isophote A line or surface on a chart forming the locus of points of equal illumination or light intensity from 
a given source. 
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M
match curve A curve deformed so as to connect another curve, while taking the continuity type into account.  

match surface A surface deformed so as to connect another surface, while taking the continuity type into 
account.

mesh line A line on a surface used to deform this surface according to various laws, and types of 
deformation. 

N
NUPBS A NUBS, Non Uniform B-Spline is also called NUPBS, to make it more clear that it is a polynomial 

curve and not a rational curve. See NURBS.

NURBS A NURBS, Non Uniform Rational B-Spline, is a NUBS with a rational component. Rational means 
that the weight of the Control Points must not have the value 1. With a Rational Curve a Circle 
and a Hyperbola can be described exact.

R
reflection line A curve visualized on a surface, that reflects the light emanating from a grid of neon located 

above the surface. 

S
  

surface In CATIA, surfaces are parameterized with the u- and v-Parameters running from 0 to 1.
A surface has an order in u- and an order in v-Direction, 2<=order<=16. 
The simplest surface is a 4-Point-Patch of order 2 in u-Direction and order 2 in v-Direction.
A surface can have only one patch or several patches.
The command Geometric Information shows you in the panel Geometric Analysis the available 
information.
A surface can be trimmed for example by the command Break. It can be untrimmed by the 
command Untrim.
A trimmed surface is called Face and contains all the information of the untrimmed surface. 
Because of this a command can work on the Face or on the (untrimmed) Basic Surface.

T
topological Concerned with relations between objects abstracted from exact quantitative measurements.

topological 
operation

An operation retaining the topological properties of the element undergoing the specified 
transformation.

 

trimmed 
surface

See Surface.  

U
untrimmed 
surface

See Surface.  
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Numerics
3D Curve 

Command    
3-Point Patch 

command  
4-Point Patch 

command  

A
analysis           

analyzing           
Apply Dress-Up 

command  

applying  

approximating   
associative curve 

creating  
Axis System 

command  

B
bisecting 

lines  
bi-tangent and point 

circles  
bi-tangent and radius 

circles  
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Blend Curve 

command  
Blend Surface 

command  

blending   
Break 

command   

breaking   

C
checking connections   
Circle 

command  

circles        

color scale  

Command    

command                   

                    

                    

                    

                 

compass  

compass plane  
Concatenate 

command   

concatenating   
Connect Checker 

command  
Contact Points 

command  
continuities on guides 

global deformation  
Continuity 

command  
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continuity     
Control Points 

command      
Converter Wizard 

command   

converting  

copy  
copy geometric parameters 

command  
corners 

creating  

creating                    

circles  

circular arcs  
Current Plane Orientation 

command  

curvature     

analyzing     
Curve Connect Checker 

command  
curve connection 

analyzing  
Curve On Surface 

command  
curves 

approximating  

blending  

breaking  

checking connections  

concatenating  

converting  

creating  

extending  

extrapolating  
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fit  

fragmenting  

managing  

matching  

modifying  

projecting  

segmenting  

smoothing  

trimming  
curves on surface 

creating  
Cutting Planes 

command  
cutting planes 

analysis  

D
datum 

creating  

defining   

compass plane  

deforming  
Disassemble 

command  

disassembling  

displaying  
distance 

analysis  
Distance Analysis 

command  
distance between elements 

analyzing  
draft 
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analyzing  
Draft Analysis 

command  

duplicating elements  

E
elements 

disassembling  

symmetric  
elements by symmetry 

creating  
Environment Mapping 

command  
environment mapping 

analysis  

exporting  
Extend 

command   

extending   
Extrapolate 

command  

extrapolating   
Extrude Surface 

command  

extruding  

F
files 

exporting  

importing  
Fill 

command   
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filling   

fit   
Fit To Geometry 

command   
Flip to VW or YZ 

command  
Fragmentation 

command   

fragmenting   

FreeStyle Optimizer  

FreeStyle Profiler  

FreeStyle Shaper  
Furtive Display 

command  

G
G0 

continuity  

curvature  

order of continuity  
G1 

continuity  

curvature  

order of continuity  
G2 

continuity  

curvature  

order of continuity  
G3 

continuity  

curvature  

order of continuity  
Geometric Information 
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command  
geometric information 

analysis  

displaying  
geometric parameters 

copy  
Geometry Extraction 

command  
Global Deformation 

command  

global deformation    

H
High 

command  
Highlight Lines 

command  
highlight lines 

analysis  

analyzing  
highlights 

analysis  

I
importing  
Inflection Lines 

command  
inflection lines 

analysis  

inserting  
integration 

Part Design workbench  
Interactive Viewpoint Definition 

442Page FreeStyle Shaper, Optimizer & Profiler Version 5 Release 13



command  

inverting  
isophotes 

analysis  

mapping  
Isophotes Analysis 

command  

K
Keep Original 

command  

L
line 

command  

creating  

lines  
local axis-system 

defining  
local visualization options 

applying  

removing  

M
managing  

manipulating  

manipulating views      

manipulators  

mapping  
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Match Curve 

command  
Match Surface 

command  

matching     
Medium 

command  

modifying    
mono-segment surfaces 

creating  

moving  
Multi-Side Match Surface 

command  
multi-sides 

matching  

N
Net Surface 

command  
net surfaces 

creating  
Next View 

command   
No Attenuation 

command  

O
Offset 

command  

offsetting  
one guide 

global deformation  
Open Body 
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command  

inserting  

order of continuity     
orientation 

compass  

P
parameterization 

analyzing  

Part Design workbench  
planar mono-patch surfaces 

creating  
Planar Patch 

command  
plane 

command  

creating  
point 

command  

creating  
point center and radius 

circles  
porcupine curvature 

analysis  
Porcupine Curvature Analysis 

command  
Previous View 

command   
Project Curve 

command  

projecting  
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Q
Quick Compass Orientation 

command  

R
reflect curves  
Reflection Lines 

command  
reflection lines 

analysis  
Remove Visualization Options 

command  

removing  

restoring  
Reverse Viewpoint 

command  

revolution surfaces  
Revolve 

command  

RI315904_V5R7SP4  

rotating     
rotation 

manipulating views    
Rotation About X Screen Axis 

command  
Rotation About Y Screen Axis 

command  
Rotation About Z Screen Axis 

command  

S
segmenting   
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Select 

command   

selecting  
Slow 

command  

smoothing   
Snap on Cpt 

command  
Snap On Edge 

command  
Snap On Segment 

command  
Snap On Vertex 

command  
Standard View Manipulation 

command  
Stretch View 

command  

stretching  
Styling Corner 

command  
Styling Extrapolate 

command  
Styling Sweep 

command  
support 

selecting  
surface boundaries 

modifying  
surface connection 

analyzing  
surface limits 

restoring  
surfaces 

approximating  

blending  

breaking  
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checking connections  

concatenating  

creating       

deforming  

extending  

extrapolating  

extruding  

filling   

fit  

fragmenting  

matching   

modifying  

offsetting  

segmenting  

smoothing  

swept  
surfaces by extrusion 

creating  
surfaces from 3 points 

creating  
surfaces from 4 points 

creating  
surfaces on surface 

creating  
Surfacic Curvature Analysis 

command  

swept  
Symmetric 

command  

symmetric  

symmetry  
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T
Tensions 

command  
three points 

circles  

translating   

manipulating views  

trimming  
tri-tangent 

circles  
two guides 

global deformation  
two points 

circles  
two points and radius 

circles  

U
U,V Orders 

command  
Untrim 

command  
using 

manipulators  

V
view 

stretching  
viewpoint 

defining  

inverting  
views 
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manipulating  

rotating    

translating  

zooming  

W
workbench 

FreeStyle Optimizer  

FreeStyle Profiler  

FreeStyle Shaper  

Z
Zoom And Translate 

command  

zooming  

manipulating views  
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